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Chapter 1:  Table Maintenance Procedures 
  

Topics Discussed In This Chapter: 

 

 Organizational Structure 

 Location 

 Negotiating Units 

 Titles 

 Cost Centers 

 Object Codes 

 Work Locations 

 Tips 

 Announcements 

 Time Clock Card 

 Password Rules 

 Configuration Settings 

 

Table maintenance procedures allow persons with the proper authorization to view, edit, and 

create entries in tables LATS uses to organize information about your organization.  Each section 

in this chapter will describe the procedures to be followed for table maintenance. 

 

Organizational Structure 
  

The organizational structure in LATS consists of a four-level hierarchy of Agencies, Divisions, 

Bureaus and Sections. After you are established on LATS and basic table information has been 

entered for your organization, maintenance for these tables should be minimal. If you become 

responsible for a new agency, or reorganization occurs within your agency, it may become 

necessary to add or revise these tables. These tables may also be changed and updated through 

HRIS or some other HR system your organization uses to keep information current. Information 

established on these tables is used in reports, security and mass assignments that include or is 

grouped by individual areas within your organization. 

 

Agencies 

  

Viewing Agency Information 

     

Step #         Active Window Action  

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the appropriate 

agency link in the “tree” on 

the left hand side of the 

page. 
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Creating a New Agency 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #          Active Window Action  

1 Home Page  

2 Table Maintenance  

3 Organizational Structure TABLE MAINTENANCE > 

ORGANIZATIONAL 

STRUCTURE. Click NEW 

AGENCY BUTTON. LATS 

will display the Edit Agency 

Screen. 

4 Edit Agency Enter the information about the 

agency. 

5  Agency Code: A five-digit code 

which uniquely identifies the 

agency. 

6  Title: The full name of the 

agency. 

7  Short title: A four-digit 

abbreviation which uniquely 

identifies the agency. 

8  Default Agency: Select Y or N 

from the drop-down list to 

indicate whether this agency is 

to be used when you open a 

LATS administrative session. 

 

9  Default Hrs. Per Day: Options 

are 7.00, 7.50 or 8.00 

10  Transfer Payments: Select Yes 

or No from the drop down list to 

indicate if payments are to be 

transferred from LATS. A value 

of Yes means that payments will 

transmit out of LATS. 

11  Auto-Generate TDS Task Code: 

Select Y or No from the drop 

down list to indicate whether or 

not the TDS Task Code will be 

automatically created for you or 

if you will be required to enter 

one manually. 

12  TDS Agency:  Select the 

Agency from the drop down list 

to indicate the appropriate TDS 

Agency. 
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13  Fiscal Year Begin:  select the 

Month and the day that the 

agency fiscal year begins. 

14  Default Present/Absent: Setting 

this to YES will provide 

Present/Absent timesheets to the 

employee.  Default is set to No. 

15  External Hourly Payments: 

Setting this to YES will include 

the regular hourly payments in 

the miscellaneous payment 

interface file.  Default is set to 

No. 

16  Click SAVE 

 

Modifying the information associated with an existing Agency 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #          Active Window Action 

1 

 

Home Page  

2 Table Maintenance  

3 Organizational Structure Locate the desired agency on the 

left side of the screen (the 

“tree”). 

4  Click on the agency name to be 

modified. 

5 Edit Agency LATS will display the Edit 

Agency screen.  Make desired 

changes. 

6  Agency code: You may not make 

changes to this field. 

7  Title: The full name of the 

agency. 

8  Short title: A four-digit 

abbreviation which uniquely 

identifies the agency. 

9  Default Agency: Select Y or N 

from the drop-down list to 

indicate whether this agency is to 

be used when you open a LATS 

administrative session. 

10  Default Hrs. Per Day: Options 

are 7.00, 7.50 or 8.00 

11  Transfer Payments: Select Y or 

No from the drop down list to 

indicate if payments are to be 

transferred from LATS. 
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12  Auto-Generate TDS Task Code: 

Select Y or No from the drop 

down list to indicate whether or 

not the TDS Task Code will be 

automatically created for you or 

if you will be required to enter 

one manually. 

13  TDS Agency:  Select the Agency 

from the drop down list to 

indicate the appropriate TDS 

Agency. 

13  Fiscal Year Begin:  select the 

Month and the day that the 

agency fiscal year begins. 

14  Default Present/Absent: Yes 

forces all employees in this 

agency to use a Present Absent 

timesheet regardless of Neg Unit, 

Salary Grade, Overtime status 

etc.… 

15  Click SAVE. 

 

Designating a Default Agency 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #          Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Locate the desired agency on the 

left side of the screen (the  

“tree”). 

Click on the agency name to be 

modified. LATS will display the 

Edit Agency screen.  

4 Edit Agency Default Agency: Select Y from 

the drop-down list to indicate this 

agency is to be used when you 

open a LATS administrative 

session. You will be able to view 

and edit employees for all of 

your agencies even if you do not 

set an agency to default Y. 

5  Click SAVE. 

Divisions 
 

Viewing Division Information 
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TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #         Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on the Division Name 

5   

  

 

 

Creating a New Division 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #         Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to 

the desired agency.  LATS 

will display the Edit Agency 

screen. 

4 Edit Agency Click on the New Division 

button.  LATS will display 

the Edit Division screen. 

5 Edit Division Enter the information about 

the division: 

6  Agency: Read only.  

Defaulted from the original 

agency selected. 

7  Division Code: Enter a three-

digit code which uniquely 

identifies the division within 

the selected agency. 

8  Title: The full title of the 

division. 

9  Short Title: A four-digit code 

used as a short name for the 

division. 

10  Inactive: Select Y if the 

division is inactive; select N 

if the division is active. 

11  Click SAVE. 

 

Note:  If a Division is designated as inactive, it will not be available for selection or appear on 

current reports or on employee information. Information for an inactive division will be available 

for reports run on historical data. 
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Changing Division Information 
 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #         Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on the Division.  LATS 

will display the Edit Division 

screen. 

5 Edit Division Make any necessary changes. 

6  Agency: You may not make 

changes to this field 

7  Division Code: You may not 

make changes to this field. 

8  Title: The full title of the 

Division. 

9  Short Title: A four-digit code 

used as a short name for the 

division. 

10  Inactive: Select Y if the 

division is inactive; select N 

if the division is active. 

11  Click SAVE. 

 

Note:  Changing the description for a Division will change the description system-wide, including 

the description on previous timesheets. 

  

Bureaus 

  

Viewing Bureau Information 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #         Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on the plus sign next to 

the appropriate division. 
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5  Click on the appropriate 

bureau name. 

 

 

Creating a New Bureau 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

   

Step #          Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on appropriate division 

name.  LATS will display the 

Edit Division screen. 

5 Edit Division Click on the New Bureau 

button.  LATS will display 

the Edit Bureau screen. 

6 Edit Bureau Enter information about the 

bureau. 

7  Agency: Read only.  

Defaulted from the agency 

selected. 

8  Division: Read only.  

Defaulted from the division 

selected. 

9  Bureau Code: A three-digit 

code which uniquely 

identifies the bureau within 

the division. 

10  Title: The full title of the 

bureau. 

11  Short Title: A four-character 

abbreviation of the bureau's 

title. 

12  Inactive: Select Y if the 

division is inactive; select N 

if the bureau is active. An 

Inactive Bureau will not be 

available for selection or use. 

13  Click SAVE. 

 

 

Changing Bureau Information 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 
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Step #     Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on t the plus sign next 

to  the appropriate division 

and expand the “tree ” 

5  Click on the appropriate 

bureau name.  LATS will 

display the Edit Bureau 

screen. 

6 Edit Bureau Make any necessary changes 

to fields. 

7  Agency: You may not make 

changes to this field 

8  Division Code: You may not 

make changes to this field. 

9  Bureau Code: You may not 

make changes to this field. 

10  Title: The full title of the 

Division. 

11  Short Title: A four-digit code 

used as a short name for the 

division. 

12  Inactive: Select Y if the 

division is inactive; select N 

if the division is active. 

13  Click SAVE. 

       

Note:  Changing the description for a Bureau will change the description system-wide, including 

the description on previous timesheets. 

  

Sections 

  

Viewing Section Information 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #         Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 
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4  Click on the plus sign next to  

the appropriate division and 

expand the “tree” 

 

5  Click on the plus sign next to  

the appropriate bureau and 

expand the “tree” 

6  Click on the appropriate 

section name 

 

 

Creating a New Section 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #          Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on the plus sign next to  

the appropriate division and 

expand the “tree” 

5  Click on the appropriate 

bureau name.  LATS will 

display the Edit Bureau 

screen. 

6 Edit Bureau Click on the New Section 

button.  LATS will display 

the Edit Section screen. 

7 Edit Section Enter information about the 

section. 

8  Agency: Read only.  

Defaulted from the agency 

selected. 

9  Division: Read only.  

Defaulted from the division 

selected. 

10  Bureau: Read only.  

Defaulted from the bureau 

selected. 

11  Section Code: A three-digit 

code which uniquely 

identifies the section within 

the bureau. 

12  Title: The full title of the 

section. 
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13  Short Title: A four-character 

abbreviation of the section's 

title. 

14  Inactive: Select Y if the 

section is inactive; select N if 

the section in inactive. An 

Inactive Section will not be 

available for selection or use. 

15  Click SAVE. 

 

 

Changing Section Information 

 

TABLE MAINTENANCE > ORGANIZATIONAL STRUCTURE 

 

Step #          Active Window Action 

1 Home Page  

2 Table Maintenance  

3 Organizational Structure Click on the plus sign next to  

the appropriate agency and 

expand the “tree” 

4  Click on the plus sign next to  

the appropriate division and 

expand the “tree” 

5  Click on the plus sign next to  

the appropriate bureau and 

expand the “tree” 

6  Click on the appropriate 

section name.  LATS will 

display the Edit Section 

screen. 

7  Make any necessary changes 

in fields.  

 

8  Agency: You may not make 

changes to this field 

9  Division Code: You may not 

make changes to this field. 

10  Bureau Code: You may not 

make changes to this field. 

11  Section Code: You may not 

make changes to this field. 

12  Title: The full title of the 

Division. 

13  Short Title: A four-digit code 

used as a short name for the 

division. 
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14  Inactive: Select Y if the 

division is inactive; select N 

if the division is active. 

15  Click SAVE. 

 

 

Note:  Changing the description for a Section will change the description system-wide, including 

the description on previous timesheets. 

 

Location 
  

A location is a locale to which an employee has been assigned. A location can include several 

buildings or an entire city; by contrast, a work location may be a single room, floor or building. 

  

Viewing Locations 

 

TABLE MAINTENANCE > LOCATIONS 

 

Step #  Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Locations Enter search criteria, select the 

Search button.  LATS will 

search all of the Location fields 

for a match on the entered 

criteria. 

4  Search results are displayed.  

Click on the appropriate row to 

display Location Details. 

 

Creating a new Location 

 

TABLE MAINTENANCE > LOCATIONS 

 

Step #          Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Locations Click on the Add tab 

4  Enter information for the new 

location. 

5  Location Code: Enter a four-

character code which 

uniquely defines the location. 

6  Title: Enter the name of the 

location. 

 

7  Short Title: Enter a one- to 

four-character abbreviation 
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which will be used to 

represent the location. 

8  Inactive: From the drop-down 

list, select NO if the location 

will be active or YES if the 

location will be inactive. 

9  Click SAVE. 

 

Changing a Location 

 

TABLE MAINTENANCE > LOCATIONS 

 

Step #          Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Locations Enter search criteria, select 

the Search button. LATS will 

search all of the Location 

fields for a match on the 

entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Location Details.  

LATS will display the 

Modify Tab 

5 Modify tab  Make any necessary changes.  

Note the Location Code may 

not be changed. 

6  SAVE. 

 

 

Negotiating Units 
 

The most common Negotiating Units have been established on LATS and table information will 

be available before you begin to use LATS. Negotiating Units are attached to employees and are 

used to define specific rules in LATS, according to a Union contract or Department policy. There 

are some specific fields that may be modified within your agency to enable you to modify 

timesheet requirements for your agency. 

 

Example   
 

You may choose to require all employees within a specific NU to complete time in/time out 

timesheets vs. Present/Absent timesheets. You may also limit the number of hours employees may 

accrue under the Comp Over 40 option. 

 

Viewing a Negotiating Unit 

 

TABLE MAINTENANCE > NEGOTIATING UNITS 
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Step #    Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Negotiating Units Enter search criteria, select 

the Search button.  LATS will 

search all of the Negotiating 

Units fields for a match on 

the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Negotiating Unit 

Details. 

 

 

Creating a New Negotiating Unit 

 

TABLE MAINTENANCE > NEGOTIATING UNITS 

 

Step #        Active Window Actions 

1 Home Page  

2 Table Maintenance 

 

 

3 Negotiating Units 

 

Click on the Add tab 

 

4  Enter information about that 

negotiating unit. 

5  Negotiating Unit Code: Enter 

a one- to two-digit code 

which your LATS installation 

will use to identify the 

negotiating unit. 

Example: 02 for CSEA 

Administrative employees, 03 

for CSEA Operational 

employees. 

6  Negotiating Unit: Enter the 

name of the negotiating unit. 

Example: CSEA-2, CSEA-3 

7  Required In/Out: From the 

drop-down list, select Y if 

employees represented by this 

negotiating unit must enter 

their time as In/Out or N if 

they do not. Example: All 

PS&T employees must enter 

time in/time out regardless of 

grade. 

8  PA Required: From the drop-

down list, select Y if 
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employees represented by this 

negotiating unit must enter 

their time as Present/Absent 

or N if they do not. If both 

In/Out and P/A are chosen, 

LATS will select the proper 

timesheet based on Salary 

grade. Example: You may 

require certain MC employees 

to complete their timesheets 

using P/A. 

9  Max Comp over 40: Enter the 

Maximum accruals amount 

for employees participating in 

the Over 40 Comp program. 

10  Prefill Holiday:  If this 

indicator is set to Yes, LATS 

will automatically ADD the 

HOL row for full time 

employees when the 

timesheet is initially saved. 

11  IPP Sick Leave Rules: A 

values of Yes directs LATS 

that there are IPP Sick leave 

rules associated to this 

Negotiating Unit and the 

employees attached to it.  

This affects employees that 

have dates in the IPP 1 and 

IPP 2 fields on the Users 

Accruals tab of their 

administration record.  A 

value of No directs LATS to 

not look for IPP sick leave 

rules. 

12  Show Lunch Row: A value of 

Yes displays the Lunch row 

on the timesheet for 

employees attached to this 

Negotiating Unit and a value 

of No will not display the 

Lunch row. 

13  Show Tardy Row:  This 

setting indicates whether or 

not employees attached to this 

Negotiating Unit will see the 

Tardy row on their timesheet 

or not.  ** If there is No 

Tardy Key selected in the 
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LATS main configuration 

table a Tardy Row will not be 

displayed on the time sheet 

regardless of this setting. 

14  Show VRWS Row: A value 

of Yes displays the VRWS 

row for employees attached to 

this Negotiating Unit.  A 

value of No does not display 

the VRWS row for employees 

attached to this Negotiating 

Unit 

15  Use Enhanced OT Rules: If 

this setting is set to Yes, 

LATS will enforce the 

enhanced OT rules where 

overtime may be converted to 

straight time if unscheduled 

sick leave is used in the same 

week that the OT is earned. A 

value of No in this field 

bypasses the enhanced OT 

logic. 

16  Max Holidays Paid: This 

value identifies the maximum 

number of holidays that 

seasonal employees are 

allowed to earn per year. 

17  Min Hours Straight: Seasonal 

employees must work a 

minimum number of hours 

per season before becoming 

eligible for holiday pay.  This 

threshold can vary by NU. 

18  Min Weeks Full: Seasonal 

employees must work a 

minimum number of weeks at 

full pay (meeting the Min 

Hours per Week) per season 

before becoming eligible for 

holiday pay.  This threshold 

can vary by NU. 

19  Min Hours Week: Seasonal 

employees must work a 

minimum number of hours 

per week per season before 

becoming eligible for holiday 

pay.  This threshold can vary 

by NU. 
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20  Enable Pre-shift:  A value of 

Yes in this field displays the 

Pre-shift check box on 

employee’s timesheets that 

are attached to this Neg Unit. 

**This is just a visual 

identifier and does not have 

pre-shift payment logic 

attached to it. 

  Click SAVE. 

 

 

Changing a Negotiating Unit 

 

TABLE MAINTENANCE > NEGOTIATING UNITS 

 

Step #        Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Negotiating Units 

 

Enter search criteria, select 

the Search button.  LATS will 

search all of the Negotiating 

Units fields for a match on 

the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Negotiating Unit 

Details. LATS will display 

the Modify Tab. 

5 Modify Tab Make any necessary changes. 

6  Click SAVE 

 

 

Titles 
 

Your LATS system may already include all of your agencies active titles and new titles may be 

added via HRIS/NYSTEP or in some other HR systems your organization provided. In that case, 

you will only need to add to or correct current information 

  

Viewing a Title 

 

TABLE MAINTENANCE > TITLES 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Titles Enter search criteria, select 

the Search button.  LATS will 
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search all of the Titles fields 

for a match on the entered 

criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Title Details. 

 

  

Creating a New Title 

 

TABLE MAINTENANCE > TITLES 

 

Step #              Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Titles Click ADD tab. 

4  Title Code: Enter unique code 

for this title. 

5  Title: Enter the full 

description for this title. 

6  Short Title: Enter the short 

description for this title (20 

character maximum). This 

field will display when the 

employee or administrator 

reviews employee 

information on the timesheet. 

7  Negotiating Unit: From the 

drop-down list, select the 

Negotiating Unit which will 

represent this title. (No longer 

has functionality in LATS) 

8  Click SAVE. 

 

 

Changing a Title 

 

TABLE MAINTENANCE > TITLES 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Titles Enter search criteria, select the Search 

button.  LATS will search all of the 

Titles fields for a match on the 

entered criteria. 

4  Search results are displayed.  Click on 

the appropriate row to display Title 
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Details. LATS will display the 

Modify Tab. 

5 Modify Tab  Make any necessary changes. 

6  Click SAVE. 

 

 

Deleting a Title 

 

TABLE MAINTENANCE > TITLES 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Titles Enter search criteria, select the Search 

button.  LATS will search all of the 

Titles fields for a match on the 

entered criteria. 

4  Search results are displayed.  Click on 

the appropriate row to display Title 

Details. LATS will display the 

Modify Tab. 

5 Modify Tab Select Delete 

6  Message will be displayed asking for 

confirmation of the Delete. 

 

 

 

Cost Centers 
 

TABLE MAINTENANCE > COST CENTERS 

 

Viewing Cost Center Information 

 

  

 

Creating a New Cost Center 

 

TABLE MAINTENANCE > COST CENTERS 

Step #            Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Cost Centers Enter search criteria, select the Search 

button.  LATS will search all of the 

Cost Center fields for a match on the 

entered criteria. 

4  Search results are displayed.  Click on 

the appropriate row to display Cost 

Center Details  
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Step #          Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Cost Centers Click Add tab. 

4  Enter information about the 

cost center. 

5  Cost Center: Enter a name for 

the cost center; up to six 

characters may be used. 

6  Variable: Enter the variable 

with which this cost center 

will be associated; up to two 

characters may be used. 

7  Budget Year: Enter the fiscal 

year in which this cost center 

will be active. 

8  Begin Date: Click on the 

calendar. From the calendar 

window, select a start date. 

9  End Date: Click on the 

calendar. From the calendar 

window, select an end date. 

10  Click SAVE. 

 

 

 

Changing Cost Center Information 

 

TABLE MAINTENANCE > COST CENTERS 

 

Step #        Active Window  Actions 

1 Home Page  

2 Table Maintenance  

3 Cost Centers Enter search criteria, select 

the Search button.  LATS will 

search all of the Cost Center 

fields for a match on the 

entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Cost Center 

Details.  LATS will display 

the Modify Tab  

5 Modify Tab Make the desired changes. 

6  Click SAVE. 

 

Note:  Cost Centers may not be deleted once saved; however, you may make them inactive. 
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Deleting a Cost Center 

 

TABLE MAINTENANCE > Cost Center 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Cost Center Enter search criteria, select the Search 

button.  LATS will search all of the 

Cost Center fields for a match on the 

entered criteria. 

4  Search results are displayed.  Click on 

the appropriate row to display Cost 

Center Details. LATS will display the 

Modify Tab. 

5 Modify Tab Select Delete 

6  Message will be displayed asking for 

confirmation of the Delete. 

 

  

Object Codes 
  

Viewing Object Codes 

 

TABLE MAINTENANCE > OBJECT CODES 

 

Step #       Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Object Codes Enter search criteria, select 

the Search button.  LATS will 

search all of the Object codes 

fields for a match on the 

entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Object Codes 

Details. 

 

 

Creating a New Object Code 

 

TABLE MAINTENANCE > OBJECT CODES 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  
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3 Object Codes Click NEW OBJECT CODE. 

4  Enter information about the 

Object Code. 

5  Object Code: Enter a code of 

up to five characters which 

uniquely identifies the object 

code. 

6  Description: Enter a 

description of the object code 

and its use. 

7  Active: Select Yes or No to 

indicate if the object is 

currently in use. 

8  Click SAVE. 

 

 

Changing an Object Code 

 

TABLE MAINTENANCE > OBJECT CODES 

 

Step #      Active Window Actions 

1 Home Page 

 

 

2 Table Maintenance  

3 Object Codes Enter search criteria, select 

the Search button.  LATS will 

search all of the Object Codes 

fields for a match on the 

entered criteria. 

  Search results are displayed.  

Click on the appropriate row 

to display Object Codes 

Details.  LATS will display 

the Modify Tab. 

4 Modify Tab Make desired changes. 

5  Click SAVE. 

 

Note:  Object codes cannot be deleted once used; however, you may make them inactive. 

 

 

Deleting an Object Code 

 

TABLE MAINTENANCE > Object Code 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Object Codes Enter search criteria, select the Search 

button.  LATS will search all of the 
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Object Codes fields for a match on the 

entered criteria. 

4  Search results are displayed.  Click on 

the appropriate row to display Object 

Code Details. LATS will display the 

Modify Tab. 

5 Modify Tab Select Delete 

6  Message will be displayed asking for 

confirmation of the Delete. 

 

 

 

 

 

Work Locations 
  

A work location is a specific location at which an employee works. It is more specific than the 

Location variable, which identifies only the locale to which an employee is assigned. A single 

Location can include several buildings or a city; a Work Location can be used to identify a 

specific building, floor or room to which the employee is assigned. If your agency chooses to 

enable this feature, the Work Location will appear on the employee timesheet. 

  

Viewing Work Locations 

 

TABLE MAINTENANCE > Work Locations 

 

Step #       Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Work Locations Enter search criteria, select 

the Search button.  LATS will 

search all of the Work 

Locations fields for a match 

on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Work Locations 

Details. 

 

 

Creating a Work Location 

 

TABLE MAINTENANCE > WORK LOCATIONS 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Work Locations Click ADD tab. 
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4  Enter the following 

information. 

5  Code: A unique code (up to 

10 characters) for the work 

location. 

6  Description: A precise 

description for the work 

location. 

7  Agency:  Set “All Agencies’ 

or specify the Agency for the 

Work Location being created. 

8  Click SAVE 

 

Uploading a Work Location 

 

TABLE MAINTENANCE > WORK LOCATIONS 

  

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Work Locations Click UPLOAD tab. 

4  Click BROWSE 

5  Navigate to the location of 

the CMA formatted 

spreadsheet 

6  Click UPLOAD 

 

 

 

Modifying the Description of the Work Location 

 

TABLE MAINTENANCE > WORK LOCATIONS 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Work Locations Enter search criteria, select 

the Search button.  LATS will 

search all of the Work 

Locations fields for a match 

on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Work Locations 

Details.  LATS displays the 

Modify tab. 

5 Modify Tab Modify the description. 

6  Click SAVE. 
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Deleting a Work Location 

 

TABLE MAINTENANCE > WORK LOCATIONS 

 

Step #   Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Work Locations Enter search criteria, select 

the Search button.  LATS will 

search all of the Work 

Locations fields for a match 

on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Work Locations 

Details.  LATS displays the 

Modify tab. 

5 Modify Tab Click DELETE. 

  Message will be displayed 

asking for confirmation of the 

Delete. 

 

Note:  A Work Location cannot be deleted once it is assigned to an employee. 

  

 

 

Tips 
 

Tips may be added, modified or deleted as required. Tips that are active are displayed in order of 

entry and only one will be displayed daily. Tips are not limited by dates. You may stop a tip from 

displaying by changing it to inactive in "Modifying a Tip". 

 

Note:  The Home page will not display for all employees if there is no active announcement. 

  

Viewing Tips 

 

TABLE MAINTENANCE > Tips 

 

Step #       Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Tips Enter search criteria, select 

the Search button.  LATS will 

search all of the Tips fields 

for a match on the entered 

criteria. 
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4  Search results are displayed.  

Click on the appropriate row 

to display Tips Details. 

 

 

Creating a New Tip 

  

TABLE MAINTENANCE > TIPS  

 

Step #  Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Tips Click on the Add Tab. 

5  Enter the following 

information: 

6  Title: Enter a unique title for 

the tip you want to add. 

7  Text: Enter the text of the tip 

you want to display on the 

Home Page on LATS. 

8  Active: From the drop-down 

list, enter Y if you want the 

tip to be Active; enter N if 

you do not want the tip to be 

active. 

 

9  Click Save. 

 

Note:  A tip will not be displayed immediately when added. Tips are displayed, one per day, in the 

entry order. 

 

Modifying a Tip 
  

TABLE MAINTENANCE > TIPS 

 

Step #  Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Tips Enter search criteria, select 

the Search button.  LATS 

will search all of the Tips 

fields for a match on the 

entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Tips Details.  

LATS will display the 

Modify tab. 

5 Modify Tab Make any necessary changes.  



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 1: Table Maintenance Procedures, 32 of 233 

6  To make inactive, change to 

No in the ACTIVE box. 

7  Click SAVE. 

 

 

 

 

Deleting a Tip 

 

TABLE MAINTENANCE > TIPS 

 

Step # Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Tips Enter search criteria, select 

the Search button.  LATS will 

search all of the Tips fields 

for a match on the entered 

criteria.. 

4  Search results are displayed.  

Click on the appropriate row 

to display Tips Details.  

LATS will display the 

Modify tab. 

5 Modify Tab Click DELETE. 

6  Message will be displayed 

asking for confirmation of the 

Delete. 

 

 

 

 

 

 

Announcements 
 

Announcements will be displayed on a Home Page. If enabled and an active announcement 

exists, the LATS will display the Home Page when an employee logs in LATS. The employee 

must then click the TIMESHEET tab to open the timesheet. 

Beginning and Endings Dates define an announcement's life span. LATS will display all active 

announcements on the home page every day they are active. You may end the display of an 

announcement by deleting the announcement or you may modify the end date to stop displaying 

the announcement. Modifying the end date will retain the announcement for display in the future. 

  

Viewing Tips 

 

TABLE MAINTENANCE > ANNOUNCEMENTS 

 

Step #       Active Window Actions 
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1 Home Page  

2 Table Maintenance  

3 Announcements Enter search criteria, select 

the Search button.  LATS will 

search all of the 

Announcements fields for a 

match on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Announcements 

Details. 

 

 

Creating a New Announcement 

 

TABLE MAINTENANCE > ANNOUNCEMENTS  

 

Step #     Active Window Actions   

1 Home Page  

2 Table Maintenance  

3 Announcements Click on the Add tab. 

 

4  Topic: Enter a unique topic 

for the announcement you 

want to add. 

5  Content: Enter the text of the 

announcement you want to 

add. 

6  Begin Date: Click on the 

calendar next to this field and 

choose the date you want this 

announcement to be 

displayed. 

7  End Date: Click on the 

calendar next to this field and 

choose the date you want to 

stop displaying this 

announcement. 

8  Click SAVE. 

 

 

Modifying an Announcement 

 

TABLE MAINTENANCE > ANNOUNCEMENTS 

 

Step #          Active Window Actions 

1 Home Page  

2 Table Maintenance  
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3 Announcements Enter search criteria, select 

the Search button.  LATS will 

search all of the 

Announcements fields for a 

match on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Announcements 

Details.  LATS will display 

the Modify Tab. 

5 Modify Tab Make necessary changes. 

6  Click "Save". 

 

 

 

Deleting an Announcement 

 

TABLE MAINTENANCE > ANNOUNCEMENTS 

 

Step #    Active Window Actions 

1 Home Page  

2 Table Maintenance  

3 Announcements Enter search criteria, select the 

Search button.  LATS will 

search all of the 

Announcements fields for a 

match on the entered criteria 

4  Search results are displayed.  

Click on the appropriate row to 

display Announcements Details.  

LATS will display the Modify 

Tab. 

5 Modify Tab Click on "Delete".  

6  Message will be displayed 

asking for confirmation of the 

Delete. 

 

 

Time Clock Card 
 

TABLE MAINTENANCE > TIMECLOCK CARD 

 

Viewing all employees that are configured for a Time Clock Card 

 

The Time Clock Card application allows the system administrator to manage and assign the users 

Time Clock Cards. It will allow a search by Employee, Card ID or All Employees (default 

search).  An employee MUST already have the Time Clock user configuration checked on their 

employee profile for them to appear in this application. 
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Step #    Active Window Actions       

1 Home Page  

2 Table Maintenance  

3 Time Clock Cards Defaults to the list of All 

Clock Users. 

4  To search for a specific 

TimeClock Card change the 

Search By dropdown to Card 

ID and enter the Card ID and 

click search. 

5  To search for a specific 

employee change the Search 

By dropdown to Employee 

and enter the Employee and 

click search. 

6  Click on the appropriate 

employee row to view the 

Card Id and Status. 

 

 

Modifying a Card ID or Status 

 

Step #    Active Window Actions     

1 Home Page  

2 Table Maintenance  

3 Time Clock Cards Defaults to the list of All 

Clock Users. 

4  To search for a specific Time 

Clock Card change the Search 

By dropdown to Card ID and 

enter the Card ID and click 

search. 

5  To search for a specific 

employee change the Search 

By dropdown to Employee 

and enter the Employee and 

click search. 

6  Click on the appropriate 

employee row to access the 

Card Id and Status. 

7  Modify the card id or change 

the card status. 

8  Click Save. 

 

 

Adding a Card ID or Status 

 

TABLE MAINTENANCE > TIMECLOCK CARD 
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Step #    Active Window Actions   

1 Home Page  

2 Table Maintenance  

3 Time Clock Cards Defaults to the list of All 

Clock Users 

4  To search for a specific Time 

Clock Card change the Search 

By dropdown to Card ID and 

enter the Card ID and click 

search. 

5  To search for a specific 

employee change the Search 

By dropdown to Employee 

and enter the Employee and 

click search. 

6  Click on the appropriate 

employee row to access the 

Card Id and Status. 

7  Add a card id and add the 

card status. 

8  Click Save. 

 

 

Deleting a Card ID  

 

TABLE MAINTENANCE > TIMECLOCK CARD 

 

Step #    Active Window Actions   

1 Home Page  

2 Table Maintenance  

3 TimeClock Cards Defaults to the list of All 

Clock Users 

4  To search for a specific 

TimeClock Card change the 

Search By dropdown to Card 

ID and enter the Card ID and 

click search. 

5  To search for a specific 

employee change the Search 

By dropdown to Employee 

and enter the Employee and 

click search. 

6  Click on the appropriate 

employee row to access the 

Card Id and Status.  

7 Modify Tab Select DELETE 
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8  Message will be displayed 

asking for confirmation of the 

Delete. 
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Password Rules 
 

TABLE MAINTENANCE > PASSWORD RULES 

 

LATS will allow the system administrator to define the password requirements that must be met 

when an end user creates a password.  The following settings can be modified if the configuration 

setting for password rules in enabled. 

 

Password Minimum Length:  The minimum length the initial and subsequent passwords need to 

be. 

 

Password maximum:  The maximum length the initial and subsequent passwords can be. 

 

Minimum Age (In Days):  The number of days that must lapse before a password can be changed 

– from the last time it was changed. 

  

Maximum Age (In Days):  The number of days the password can be in effect before the system 

prompts the end user to create a new password. 

 

Unique History:  The frequency in which a password can be re-used.  For example, if this is set to 

2 then you cannot re-use a password again until you have used two different passwords. 

 

Max Wrong Attempts:  The number of incorrect login attempts made before the system locks the 

end user out. 

 

Minimum Upper Case Characters:  The number of upper case characters   required in the 

password. 

 

Minimum Lower Case Characters:  The number of lower case characters   required in the 

password. 

 

Minimum Numeric Characters:  The number of numeric characters   required in the password. 

 

Minimum Special Characters:  The number of special characters required in the password. 

 

Configurable Settings 
 

TABLE MAINTENANCE > CONFIGURABLE SETTINGS 

 

LATS has configurable settings, by Agency, that allow the system to be modified to meet 

customer requirements and provide additional flexibility. LATS configurable settings can be 

accessed by following the path below: 

 

Step #    Active Window Actions   

1 Home Page  

2 Table Maintenance  

3 Configurable Settings Expand the “tree” on the left 

panel. 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 1: Table Maintenance Procedures, 39 of 233 

4  Click on a setting and the 

current settings window will 

pop up on the right hand side 

of the window. 

5  Value: This is where the 

configuration manager sets 

the value for the specific 

agency. 

6  Default: This is the system 

default value when LATS is 

initiated. 

7  Required: This field is 

disabled and is a visual  

8  Requires Restart: This  

9  Clone: This button allows the 

user to create a copy of the 

config setting and to be 

assigned to a different 

agency. 

10  Save:  Save changes made to 

the config setting. 

   

 

Note: LATS Product Manager has already set the required configurable settings identified during 

the implementation process.  If you wish to modify a configurable setting please contact a 

member of the LATS Customer Support Team prior to making any modifications to any 

configurable settings.  The support team will be able to identify what the configuration setting 

does and how it will impact your current system or work flow. 

 

**Please see the LATS Configuration addendum for complete list of LATS configurable settings. 

 

 

 

TABLE MAINTENANCE>EARNINGS COMBOS  

 

Step# Active Window Actions 

 Home Page  

 Table Maintenance  

 Earnings Combos Click on the Search button 

  Select the appropriate Pay 

Adj Type for the Pay Basis 

Earnings Code combo 

  Select the Neg Unit, if 

applicable, 

Earnings Combo 
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  Select Pay Basis: Annual or 

Hourly 

  Select the Earnings Code: 

Active earnings codes are 

available in the drop down 

list. 

   

 

 

TABLE MAINTENANCE>PAY BASIS DEFAULTS 

 

Step #    Active Window Actions   

 Home Page  

 Table Maintenance  

 Pay Basis Defaults  

  Select Pay Basis dropdown: 

Annual, Hourly, and Per 

Diem. The options available 

on the Pay Basis Defaults page 

are different based on the 

selected pay basis. 

 Annual Pay Basis TA Eligible: If checked default 

on the accruals tab will be TA 

eligible. 

 Annual Pay Basis Eligible to use Vacation: If 

checked the default accruals 

tab will be checked and 

employees are eligible to use 

vacation time. 

 Annual Pay Basis TDS Required: If checked 

employees are required to 

enter TDS data on the 

timesheet. ** Checking this 

box enables the TDS By 

Percent check box. 

 Annual Pay Basis OT Eligible: If checked the 

default accruals page for 

employees will have the OT 

Eligible check box checked 

and employees are OT 

eligible. **checking this box 

will enable the Method of 

Recording OT drop box to be 

enabled. 

Pay Basis Defaults 
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 Annual Pay Basis Holiday Waiver:  If checked 

the default accruals page for 

employees will be checked. 

 Annual Pay Basis Clock User:  If checked the 

employees default accruals tab 

will have this box checked. 

**Checking this will enable 

the Soft Clock Types drop 

down. 

 Annual Pay Basis Soft Clock Types:  This 

identifies how LATS should 

handle punches from the 

LATS Soft Clock. Options are: 

1) Default – from soft clock 

tab to the timesheet. 2) Process 

as regular punch – sends soft 

clock punches through the 

lats_input_log for reporting 

purposes 3) Deny Soft Clock – 

does not display the soft clock 

tab. **This option is for 

employees using a different 

type of hand reader or card 

reader punch clock. 

 Annual Pay Basis Method of Recording OT:  

Options are Timesheet OT, 

Additional Time, Overtime tab 

(no longer in use) 

 Annual Pay Basis Min Hrs. Worked to Earn OT: 

 Annual Pay Basis Eligible to Earn Pass Days: 

 Annual Pay Basis HOP: This is for the old NYS 

Health Option Plan.  **This 

check box should never be 

checked. 

 Annual Pay Basis Hours Per Day: Employees 

base hours per day. New 

employees will have the 

selected base hours per day as 

the default on the accruals 

page. 

 Annual Pay Basis AWS: If this is checked all 

employees with the annual pay 

basis will have the AWS check 

box checked and will be AWS 

by default. **If this is checked 

it will enable the Week 1/Week 

2 drop downs. 

 Annual Pay Basis Week 1 Normal Hours: 

Options can be in between 35 
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– 40 in quarter hour 

increments. 

 Annual Pay Basis Week 2 Normal Hours: 

Options can be in between 35 

– 40 in quarter hour 

increments. 

 Annual Pay Basis Allow Excess Vacation 

Balance: If checked the default 

page for annual employees 

will have the Allow Excess 

Vacation box checked. 

 Annual Pay Basis TDS By Percent: If this box is 

checked employees will be 

required to enter TDS time by 

percent worked on each task 

instead of hours. 

 Annual Pay Basis Comp Over 40 Eligible: If this 

is checked the employee will 

be expected to complete the 

required number of hours in 

the Comp Over 40 row of their 

timesheet before being eligible 

to earn OT. 

 Annual Pay Basis Enforce Punch Restriction: No 

longer in use. This was for a 

specific customer and allowed 

LATS to not allow the 

employee to punch in before 

their minimum shift start time 

identified on their shift. 

 Annual Pay Basis Accrue Non Comp: If checked 

employees with less than a 40 

hour work week will have the 

earned non comp. 

 Annual Pay Basis Num of Weeks OT Applies: 

This field is enabled only if 

the Method of Recording OT 

is set the Additional Time.  

Options are 1 week and 4 

weeks. 

 Annual Pay Basis Timesheet Validation: 

Employees will have the 

timesheet validation default set 

to Hrs./Day and AWS or 

Schedules. Validation set to 

Hrs. Per Day /AWS looks at 

the employees Hours Per Day 

or weekly expected total if 

AWS.  If this is set to 
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Schedules LATS will look at 

the employee rotation to 

determine expected work 

hours per day OR the admin 

schedule planner. 

 Annual Pay Basis Dynamic Employee Percent: 

This applies to seasonal 

(hourly) employees.  The 

default page for annual 

employees will be set to Fixed 

or Dynamic based on this 

setting. 

 Annual Pay Basis Biweekly Total: This check 

box only applies to non OT 

eligible employees.  If 

checked, LATS will look for 

the expected hours for the 

entire pay period to be met, 

not on a specific day or week. 

 Annual Pay Basis Week 1 Pass days: Check days 

are the default days off. 

 Annual Pay Basis Week 2 Pass days: Check days 

are the default days off. 

 Annual Pay Basis Freeze Vacation Earnings: 

Affects employees who 

change from FT to PT and are 

over the new PT max allowed 

vacation time. 

 Hourly Pay Basis TA Eligible: If checked default 

on the accruals tab will be TA 

eligible. 

 Hourly Pay Basis Eligible to use Vacation: If 

checked the default accruals 

tab will be checked and 

employees are eligible to use 

vacation time. 

 Hourly Pay Basis TDS Required: If checked 

employees are required to 

enter TDS data on the 

timesheet. ** Checking this 

box enables the TDS By 

Percent check box. 

 Hourly Pay Basis OT Eligible: If checked the 

default accruals page for 

employees will have the OT 

Eligible check box checked 

and employees are OT 

eligible. **checking this box 

will enable the Method of 
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Recording OT drop box to be 

enabled. 

 Hourly Pay Basis Holiday Waiver:  If checked 

the default accruals page for 

employees will be checked. 

 Hourly Pay Basis Clock User:  If checked the 

employees default accruals tab 

will have this box checked. 

**Checking this will enable 

the Soft Clock Types drop 

down. 

 Hourly Pay Basis Soft Clock Types:  This 

identifies how LATS should 

handle punches from the 

LATS Soft Clock. Options are: 

1) Default – from soft clock 

tab to the timesheet. 2) Process 

as regular punch – sends soft 

clock punches through the 

lats_input_log for reporting 

purposes 3) Deny Soft Clock – 

does not display the soft clock 

tab. **This option is for 

employees using a different 

type of hand reader or card 

reader punch clock. 

 Hourly Pay Basis Method of Recording OT:  

Options are Timesheet OT, 

Additional Time, Overtime tab 

(no longer in use) 

 Hourly Pay Basis Min Hrs. Worked to Earn OT: 

 Hourly Pay Basis Eligible to Earn Pass Days: 

 Hourly Pay Basis HOP: This is for the old NYS 

Health Option Plan.  **This 

check box should never be 

checked. 

 Hourly Pay Basis Hours Per Day: Employees 

base hours per day. New 

employees will have the 

selected base hours per day as 

the default on the accruals 

page. 

 Hourly Pay Basis AWS: If this is checked all 

employees with the annual pay 

basis will have the AWS check 

box checked and will be AWS 

by default. **If this is checked 

it will enable the Week 1/Week 

2 drop downs. 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 1: Table Maintenance Procedures, 45 of 233 

 Hourly Pay Basis Week 1 Normal Hours: 

Options can be in between 35 

– 40 in quarter hour 

increments. 

 Hourly Pay Basis Week 2 Normal Hours: 

Options can be in between 35 

– 40 in quarter hour 

increments. 

 Hourly Pay Basis Allow Excess Vacation 

Balance: If checked the default 

page for annual employees 

will have the Allow Excess 

Vacation box checked. 

 Hourly Pay Basis TDS By Percent: If this box is 

checked employees will be 

required to enter TDS time by 

percent worked on each task 

instead of hours. 

 Hourly Pay Basis Comp Over 40 Eligible: If this 

is checked the employee will 

be expected to complete the 

required number of hours in 

the Comp Over 40 row of their 

timesheet before being eligible 

to earn OT. 

 Hourly Pay Basis Enforce Punch Restriction: No 

longer in use. This was for a 

specific customer and allowed 

LATS to not allow the 

employee to punch in before 

their minimum shift start time 

identified on their shift. 

 Hourly Pay Basis Accrue Non Comp: If checked 

employees with less than a 40 

hour work week will have the 

earned non comp. 

 Hourly Pay Basis Num of Weeks OT Applies: 

This field is enabled only if 

the Method of Recording OT 

is set the Additional Time.  

Options are 1 week and 4 

weeks. 

 Hourly Pay Basis Timesheet Validation: 

Employees will have the 

timesheet validation default set 

to Hrs./Day and AWS or 

Schedules. Validation set to 

Hrs. Per Day /AWS looks at 

the employees Hours Per Day 
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or weekly expected total if 

AWS.  If this is set to 

Schedules LATS will look at 

the employee rotation to 

determine expected work 

hours per day OR the admin 

schedule planner. 

 Hourly Pay Basis Dynamic Employee Percent: 

This applies to seasonal 

(hourly) employees.  The 

default page for annual 

employees will be set to Fixed 

or Dynamic based on this 

setting. 

 Hourly Pay Basis Biweekly Total: This check 

box only applies to non OT 

eligible employees.  If 

checked, LATS will look for 

the expected hours for the 

entire pay period to be met, 

not on a specific day or week. 

 Hourly Pay Basis Week 1 Pass days: Check days 

are the default days off. 

 Hourly Pay Basis Week 2 Pass days: Check days 

are the default days off. 

 Hourly Pay Basis Freeze Vacation Earnings: 

Affects employees who 

change from FT to PT and are 

over the new PT max allowed 

vacation time. 

 Per Diem TA Eligible: If checked default 

on the accruals tab will be TA 

eligible. 

 Per Diem Eligible to use Vacation: If 

checked the default accruals 

tab will be checked and 

employees are eligible to use 

vacation time. 

 Per Diem TDS Required: If checked 

employees are required to 

enter TDS data on the 

timesheet. ** Checking this 

box enables the TDS By 

Percent check box. 

 Per Diem OT Eligible: If checked the 

default accruals page for 

employees will have the OT 

Eligible check box checked 

and employees are OT 
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eligible. **checking this box 

will enable the Method of 

Recording OT drop box to be 

enabled. 

 Per Diem Holiday Waiver:  If checked 

the default accruals page for 

employees will be checked. 

 Per Diem Clock User:  If checked the 

employees default accruals tab 

will have this box checked. 

**Checking this will enable 

the Soft Clock Types drop 

down. 

 Per Diem Soft Clock Types:  This 

identifies how LATS should 

handle punches from the 

LATS Soft Clock. Options are: 

1) Default – from soft clock 

tab to the timesheet. 2) Process 

as regular punch – sends soft 

clock punches through the 

lats_input_log for reporting 

purposes 3) Deny Soft Clock – 

does not display the soft clock 

tab. **This option is for 

employees using a different 

type of hand reader or card 

reader punch clock. 

 Per Diem Method of Recording OT:  

Options are Timesheet OT, 

Additional Time, Overtime tab 

(no longer in use) 

 Per Diem Min Hrs. Worked to Earn OT: 

 Per Diem Eligible to Earn Pass Days: 

 Per Diem HOP: This is for the old NYS 

Health Option Plan.  **This 

check box should never be 

checked. 

 Per Diem Hours Per Day: Employees 

base hours per day. New 

employees will have the 

selected base hours per day as 

the default on the accruals 

page. 

 Per Diem AWS: If this is checked all 

employees with the annual pay 

basis will have the AWS check 

box checked and will be AWS 

by default. **If this is checked 
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it will enable the Week 1/Week 

2 drop downs. 

 Per Diem Week 1 Normal Hours: 

Options can be in between 35 

– 40 in quarter hour 

increments. 

 Per Diem Week 2 Normal Hours: 

Options can be in between 35 

– 40 in quarter hour 

increments. 

 Per Diem Allow Excess Vacation 

Balance: If checked the default 

page for annual employees 

will have the Allow Excess 

Vacation box checked. 

 Per Diem TDS By Percent: If this box is 

checked employees will be 

required to enter TDS time by 

percent worked on each task 

instead of hours. 

 Per Diem Comp Over 40 Eligible: If this 

is checked the employee will 

be expected to complete the 

required number of hours in 

the Comp Over 40 row of their 

timesheet before being eligible 

to earn OT. 

 Per Diem Enforce Punch Restriction: No 

longer in use. This was for a 

specific customer and allowed 

LATS to not allow the 

employee to punch in before 

their minimum shift start time 

identified on their shift. 

 Per Diem Accrue Non Comp: If checked 

employees with less than a 40 

hour work week will have the 

earned non comp. 

 Per Diem Num of Weeks OT Applies: 

This field is enabled only if 

the Method of Recording OT 

is set the Additional Time.  

Options are 1 week and 4 

weeks. 

 Per Diem Timesheet Validation: 

Employees will have the 

timesheet validation default set 

to Hrs./Day and AWS or 

Schedules. Validation set to 
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Hrs. Per Day /AWS looks at 

the employees Hours Per Day 

or weekly expected total if 

AWS.  If this is set to 

Schedules LATS will look at 

the employee rotation to 

determine expected work 

hours per day OR the admin 

schedule planner. 

 Per Diem Dynamic Employee Percent: 

This applies to seasonal 

(hourly) employees.  The 

default page for annual 

employees will be set to Fixed 

or Dynamic based on this 

setting. 

 Per Diem Biweekly Total: This check 

box only applies to non OT 

eligible employees.  If 

checked, LATS will look for 

the expected hours for the 

entire pay period to be met, 

not on a specific day or week. 

 Per Diem Previous Qualifying Pay 

Periods: The number of pay 

periods that an employee has 

in full pay status that are not in 

LATS. 

 Per Diem Total Qualifying Pay Periods: 

This is a calculated value that 

adds the number in the 

qualifying prior pay periods to 

the calculated number of 

qualifying pay periods in 

LATS.  

 Per Diem Week 1 Pass days: Check days 

are the default days off. 

 Per Diem Week 2 Pass days: Check days 

are the default days off. 

 Per Diem Freeze Vacation Earnings: 

Affects employees who 

change from FT to PT and are 

over the new PT max allowed 

vacation time. 
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Chapter 2:  Code Maintenance 
 

Topics Discussed In This Chapter: 

 

 Audit Adjustment Codes 

 Miscellaneous Leave Codes and Categories 

 Misc. Payment Codes and Earnings Codes 

 E-Mail Messages 

  

Adjustment Codes 
 

Adjustment codes are used when making adjustments to employees' leave accruals in LATS. 

Adjustment codes can be useful when running ad hoc reports to search for specific adjustment 

types. 

 

Example  
 

An employee receives a donation of leave from another employee. These accruals will be added 

to a specific miscellaneous leave code on the employee's accruals. As part of that adjustment, you 

will choose an adjustment code that will be Adjustment Codes Procedures. 

 

Adjustment codes which are known to be used by all agencies are included in your LATS 

installation. These system adjustment codes cannot be changed or manipulated. 

Many agencies, however, have created their own set of adjustment codes to meet the agency's 

needs. This section covers the procedures used to maintain your agency's agency-specific 

adjustment codes. 

 

Creating an Adjustment Code 

  

What you will need to create audit adjustment codes: 

 A list of codes your agency needs that are not included in the installation. Each code 

should have a concise but clear explanation associated with it. 

 Each code is associated with a narrative that explains the reason for the change to 

accruals. 

 

To create a new adjustment code: 

 

CODE MAINTENANCE > ADJUSTMENT CODES 

 

Step# Active Window Actions 

1 Home Page  

2 Code Maintenance  

3 Adjustment Codes Click on the ADD tab. 

4  Define the new adjustment 

code: 

5  Reason Code: Enter a code 

you will use to identify the 
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adjustment to the employee's 

accruals. 

6  Description: Enter a concise 

but clear description of the 

reason for the adjustment. 

7  Click SAVE. 

 

Changing an Adjustment Code 

 

On occasion, you will need to modify an existing audit code, either because a typographical error 

was made during its creation, or because the description has changed. 

To modify an existing adjustment code: 

 

CODE MAINTENANCE > ADJUSTMENT CODES 

 

Step# Active Window Actions 

1 Home Page  

2 Code Maintenance  

3 Adjustment Codes Enter search criteria, select 

the Search button.  LATS will 

search all of the Adjustment 

Code fields for a match on the 

entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Adjustment Code 

Details.  LATS will display 

the Modify Tab. 

5 Modify Tab Make any necessary changes 

to the adjustment code. 

6  Click SAVE. 

 

Note:  You cannot make any modifications to any system supplied codes. 

 

The changes will be reflected anywhere this code is displayed; for instance, in an employee's 

accrual history window. 

 

Deleting an Adjustment Code 

 

If you find an adjustment code that has not been used and will not be used, you may delete that 

code. 

 

CODE MAINTENANCE > ADJUSTMENT CODES 

 

Step# Active Window Actions 

1 Home Page  

2 Code Maintenance  

3 Adjustment Codes Enter search criteria, select 

the Search button.  LATS will 
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search all of the Adjustment 

Code fields for a match on the 

entered criteria 

4  Search results are displayed.  

Click on the appropriate row 

to display Adjustment Code 

Details.  LATS will display 

the Modify Tab. 

5 Modify Tab Click the delete button. 

6  Answer OK when you get the 

message asking if you want to 

delete the Adjustment Code. 

Note:  LATS will not allow you to delete an adjustment code which has been used. 

Note:  You cannot delete any system supplied codes. 

 

 

Miscellaneous Leave Codes and Categories 
  

To meet the needs of specific agencies, LATS provides each agency the capability to create and 

maintain its own list of Miscellaneous Leave Codes and Categories. 

Miscellaneous leave codes allow employees to account for time when basic accrual charges do 

not provide required detail for time charged. Their use enables employees to accurately complete 

their timesheets. 

  

Example 1 

  

The employee has attended a training seminar. Although the employee is not at his/her work 

location, the employee is on agency business and is entitled to be paid for the time spent at the 

training seminar. The Miscellaneous Leave code chosen will complete the work schedule for the 

time spent at training will not charge employee accruals but will be included in accrual 

calculations. 

   

Example 2 

  

Employee is charging sick leave accruals but the agency requires employees to indicate sick leave 

is scheduled or unscheduled. The Miscellaneous Leave code chosen will charge sick leave 

accruals for this time and will allow agency to identify unscheduled sick leave. 

 

Leave Without Pay (LWOP) and Lost Time must always be entered on the timesheet with a 

miscellaneous leave code. Using these codes will prevent the addition of accruals to a timesheet 

when the employee is not eligible to accrue time. 

  

Example 3 

  

The employee has exhausted accruals and has been placed on LWOP. The employee's timesheet 

must be completed with a code that indicates LWOP. The employee will not earn biweekly sick, 

annual, or personal leave accruals. 
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LATS groups miscellaneous leave codes into categories for reporting purposes; each 

miscellaneous leave code must be associated with a category. 

 

Limits may be set for any category you create. Limits may be set by maximum usage, by calendar 

year and can be limited to either hours or days. When an employee has reached that number of 

hours/days or the maximum usage, no more charges can be added to any miscellaneous leave 

code within that category. If restriction is limited to calendar year, LATS will reset the maximum 

at the end of that period. 

 

You may activate or de-activate individual leave codes within a category. You may also restrict 

their use to employees within specified negotiating units and codes may be restricted to allow 

only LATS administrators to use a specific code. 

  

What you will need to create miscellaneous leave codes: 

 

 A list of categories your agency will use to group miscellaneous leave codes. This list 

should include any categories your agency plans to use but categories can be added as 

required. Categories cannot be made inactive but codes within categories can be made 

inactive. 

 

 The list should include a short code for each category, a short description, and, if the 

category is to be limited, a maximum number of hours/days for the category. Codes may 

be entered in both numeric and alpha form. 

 

 A list of miscellaneous leave codes your agency will use. 

 

Note:  You cannot limit usage on a code; only categories may be limited. 

 

This list should include any codes your agency plans to use but miscellaneous leave codes can be 

added to a category as required. The list should include the category with which the 

miscellaneous leave code is associated, a short description, the negotiating units whose 

employees may charge time to the code, and a short narrative which explains to employees the 

proper use of the miscellaneous leave code. 

 

Miscellaneous Leave Procedures 

 

Included in your LATS installation are miscellaneous leave categories and codes that have special 

meaning in LATS. These are known as system-defined miscellaneous leave categories and codes; 

you may add codes to system-defined categories. 

System-defined Categories do not require accrual balances. Limits will be imposed based on 

availability of accruals for the category. 

  

Example 

  

Vacation will be limited to the number of hours the employee has accrued in Vacation balance; 

Earned Non Comp will be limited to the number of hours the employee has accrued in Earned 

Non Comp balance. 

 

Usage type is always in hours; there are no Max Usage limits or Calendar year cutoffs. 
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If you require limits on a Category, you must create a new category and define the limits within 

the new category. These Categories are designated as "Agency-Defined.” 

  

Example 

  

You want to limit the amount an employee may charge to FMLA. You must create a new Agency 

Category, defining the limits within the new Category. You may change the association of the 

existing code (previously associated with the System Category) to associate with the new 

category you created or you may create a new code. 

  

Miscellaneous Leave Categories 

 
Display Miscellaneous Leave Categories  

 

CODE   MAINTENANCE > MISC LEAVE CODES > CATEGORIES 

 

Step #          Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Leave Codes  

4 Categories Enter search criteria, select 

the Search button.  LATS will 

search the Category Name, 

Description, Counts toward 

Full Pay and System 

Category fields for a match 

on the entered criteria. 

(clicking search with no 

criteria will return all codes) 

5  Search results are displayed.   

Click on the appropriate row 

to display Category Details.  

LATS will display the 

Modify Tab.   

6  To sort the codes by System 

Categories click on the 

System Category link on the 

System Category column.   

7  This will group the codes by 

System and Non System 

Categories 
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Creating a Miscellaneous Leave Category 

 

CODE   MAINTENANCE > MISC LEAVE CODES > CATEGORIES 

 

All miscellaneous leave charge codes must be associated with a miscellaneous leave category. 

The categories allow agencies to group codes for reporting purposes. 

To add a miscellaneous leave category for your agency: 

 

Step #          Active Window Actions 

1 Home Page  

2 Misc. Leave Codes   

 Categories Click on the Add tab 

3  Category Name - Enter the 

name of the new category (10 

character maximum) 

4  Description -Enter a 

description for the category. 

5  Counts toward Full Pay 

Status - Select Yes or No. 

(See Note 1) 

6  Balance Required - Select 

Yes or No. If set to YES, the 

remaining fields will not 

apply and will be grayed out. 

(See Note 2) 

8  Usage Type - Hours or Days. 

A day is 7.50 or 8 hours, 

depending on the Employee's 

normal hours. 

9  Max Hours per Occurrence - 

The number of hours or days 

an employee may use for one 

instance of this category, even 

if no Max Usage exists. 

10  Max Usage: The total number 

of hours or days the employee 

may use within the period 

designated in Usage Cut Off. 

11  Usage Year Type -  Select 

Calendar Year or Fiscal Year 

12  Usage Cut Off (Calendar 

Year): Enter number of years 

if applicable. 

  Select the agencies that are 

allowed to use misc. leave 
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codes that are attached to the 

misc. leave category. 

13  Click Add. 

  

Example 

 

Employee attends a retirement party and is allowed one hour extra without charge, but there is 

no limit on how many retirement parties the employee may attend in a year. Enter 1 in Max 

Hours per Occurrence but do not enter a Max Usage. 

 

 

Example 

 

Agency sponsored Christmas Party is limited to 4 hours each year. Enter 4 in Max Usage, 1 in 

Usage Cut off and choose Hours in Usage Type. If an amount is entered in Max Usage, an entry 

in the Usage Cut Off field is required. 

 

Note 1:  Miscellaneous leave categories may or may not count towards full pay status. Employee 

will not receive biweekly accruals if timesheet does not meet full pay status requirements. This 

designation should be decided before the new category is added. 

 

Note 2:  If Balance Required is set to YES, all additional fields (Usage Type, Max Hours per 

Occurrence, etc.) will be disabled. Leave codes associated with this category will only be 

available to employees with a category balance. An administrator must add that balance to the 

employee's miscellaneous leave. All additional fields, Usage type, Max hours per occurrence, and 

others, will be disabled if set to YES. 

 

 

Changing a Miscellaneous Leave Category 

 

You may change the attributes of any agency-defined miscellaneous leave category. You may not 

change the code attribute or any attribute of a system-defined category.  

 

To change an Agency-Defined Miscellaneous Leave Category: 

 

CODE MAINTENANCE > MISC LEAVE CODES > CATEGORIES 

 

Step #          Active Page Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Leave Codes  

4 Categories Enter search criteria, select 

the Search button.  LATS will 

search the Category Name, 

Description, Counts toward 

Full Pay and System 

Category fields for a match 

on the entered criteria. 
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(clicking search with no 

criteria will return all codes) 

5  Search results are displayed.   

Click on the appropriate row 

to display Category Details.  

LATS will display the 

Modify Tab.   

6 Modify Tab Modify as necessary 

7  Click Save 

 

 

Deleting a Miscellaneous Leave Category 

 

You may delete a miscellaneous leave category only when the category has no miscellaneous 

leave codes associated with it. If a category has a miscellaneous leave code connected to the 

category you will receive this message: "This Misc. Leave category record has misc. lv codes 

attached to it. Cannot delete". 

 

CODE MAINTENANCE > MISC LEAVE CODES > CATEGORIES 

 

To delete a miscellaneous leave category: 

 

Step #        Active Page Action 

1 Home Page  

2 Code Maintenance   

3 Misc. Leave Codes   

4 Categories Enter search criteria, select 

the Search button.  LATS will 

search the Category Name, 

Description, Counts toward 

Full Pay and System 

Category fields for a match 

on the entered criteria. 

(clicking search with no 

criteria will return all codes) 

5  Search results are displayed.   

Click on the appropriate row 

to display Category Details.  

LATS will display the 

Modify Tab.   

6 Modify Tab Select DELETE 

7  The warning "Are you sure 

you want to delete this 

record?" will be displayed. 

 

8  Click OK to confirm. 

 

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 2: Code Maintenance, 58 of 233 

Miscellaneous Leave Charge Code 

 

Creating a Miscellaneous Leave Charge Code 

 

A miscellaneous leave code is an item against which an employee can charge time. All 

miscellaneous leave codes must be associated with a miscellaneous leave category. If you need to 

create a new category for the miscellaneous leave code you want to create, see Creating a 

Miscellaneous Leave Category. 

 

There are two ways to navigate through the process of adding a Miscellaneous Leave Code.  The 

first way is by searching and selecting a category and the second way is by going to the Misc. 

Leave Charge Code menu option. 

 

The work flow described below adds the Misc. Leave Code from the Misc. Leave Category. 

 

Add a Miscellaneous Leave Code 

 

CODE MAINTENANCE > MISC LEAVE CODES > Charge Codes 

 

Step #          Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Leave Codes   

4 Charge Codes Select the Add Tab and enter 

the following data: 

5  Misc. Leave Charge code (10 

character maximum):  This 

code will be viewed and 

chosen by the employee from 

the drop-down list of codes. 

6  Code Description: This will 

be viewed by employees 

under "View Description". 

7  Is Active: Click in this box to 

make the new code active. 

8  Time Records: Click in this 

box if you want to limit 

access to this Misc. Leave 

code to authorized 

administrative employees. 

9  Narrative: Enter information 

if appropriate. Employees 

may view this information 

under View Description. 

10  Negotiating Units: LATS 

defaults to unchecked. 

Checked boxes will allow 

employees in those 

Negotiating Units to use this 
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code on the timesheet (within 

category designated limits). 

  Enhanced FMLA 

functionality: If this is 

checked and the system 

Enhanced FMLA config 

setting is turned ON, LATS 

will deduct time charged 

against this code from the 

available FMLA balance. 

  Enhanced Not Full Pay 

functionality:  

  Enhanced Overtime 

functionality: If this is 

checked, and the Use 

Enhanced OT is turned ON 

for the Negotiating Unit, 

LATS will convert any 

voluntary OT to straight time 

depending on the number of 

hours of unscheduled sick and 

voluntary OT hours. 

  Enhanced Workers Comp 

functionality:  If this is 

checked, LATS will apply 

time charged to this leave 

code to the appropriate 

Worker Compensation case. 

11  Click ADD  

 

Note:   Active leave codes that are not restricted to HR or administrative use and that are 

available to the employee's negotiating unit, will be displayed on the drop-down list in the leave 

field on the front of the employee timesheets or on the Misc. leave tab. Codes will be displayed in 

numerical/alphabetical order. 

 

 

Changing a Miscellaneous Leave Code 

 

CODE MAINTENANCE > MISC LEAVE CODES > Charge-Codes 

 

You may change any of the attributes of a miscellaneous leave charge code. Changes are not 

retroactive; timesheets will reflect the attributes of miscellaneous codes active when the 

timesheets are processed. 

 

Step #          Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Leave Categories  
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4 Charge - Codes Enter search criteria, select 

the Search button.  LATS will 

search the Active, Code, 

Category, Description and 

Time Record fields for a 

match on the entered criteria. 

(Clicking search with no 

criteria will return all codes). 

5  Search results are displayed.   

Click on the appropriate row 

to display Charge Code 

Details.  LATS will display 

the Modify Tab.   

6 Modify Tab Make any necessary changes. 

You may make a charge code 

"inactive" on this screen. 

7  Click SAVE. 

 

 

Deleting a Misc. Leave Code 

 

CODE MAINTENANCE > MISC LEAVE CODES > Charge-Code 

 

You may only delete miscellaneous leave charge codes which are unused. After any employee 

has charged any time to a particular miscellaneous leave charge code, you will not be able to 

delete that charge code. You will be able to make the code inactive, preventing further use by 

employees. See "Changing a Miscellaneous Leave Code". 

 

To delete a miscellaneous leave charge code: 

 

Step # Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Leave Categories  

4 Charge -Code Enter search criteria, select 

the Search button.  LATS will 

search the Active, Code, 

Category, Description and 

Time Record fields for a 

match on the entered criteria. 

(Clicking search with no 

criteria will return all codes). 

5   Search results are displayed.   

Click on the appropriate row 

to display Charge Code 

Details.  LATS will display 

the Modify Tab.   

6 Modify Tab  Click DELETE.   
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7  The warning "Are you sure 

you want to delete this 

record?" will display. 

8  Click OK to confirm. 

 

 

Miscellaneous Payment Codes and Earnings Codes 
 

LATS implements payment codes to allow agencies to record time and payments for specific 

conditions or reasons. Your system may already have this information included when you start on 

LATS. Payments are recorded on the "Payment" tab of the timesheet. If your organization does 

not use the payment function, the tab will be disabled: it will not appear on employee timesheets. 

 

Payment Codes 

Creating Agency-Specific Miscellaneous Payment Codes 

 

Miscellaneous payment codes allow your agency to track miscellaneous payments and generate 

the required PayServ record for each payment. 

 

What you will need to create miscellaneous payment codes: 

 A list of all miscellaneous payment codes in use by your agency and the corresponding 

PayServ earning code with which it is associated. 

 For each code, an indication whether the payment is available to all members of one or 

more negotiated units or whether it is available to specific individuals, specific titles or 

specific item numbers. You will also need lists of the specific employees, titles, and item 

numbers if required. 

 For each earnings code, create an earnings code record. 

 For each payment code which is available to all members of one or more negotiating 

units, create a payment code with a negotiating unit specified. 

 For each payment code which is available only to specific individuals, titles and/or item 

numbers, create a payment code with no negotiating unit specified. 

 A payment code available only to specific individuals, titles or item numbers requires a 

payment roster, which is a named list containing the names of employees, titles or item 

numbers authorized to receive this payment. For each payment code of this type, create a 

payment roster. 

 After the payment roster is created, you must indicate the individuals, titles or item 

numbers that will be authorized to receive the payment associated with the roster. 

 An earnings code is used to link your agencies allowed miscellaneous payments with a 

payroll system, PayServ for example. 

 

 

Creating a Payment Code 

 

Payment codes are used to create an association between your agency's internal pay codes with 

the earnings codes used by PayServ. 

 
CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT CODES 
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To create a payment code: 

 

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Payment Codes  

4 Payment Codes Click on the Add tab. 

5  Payment Code: Add the 

numeric Payment Code. 

6  Earnings Code: Select the 

appropriate Earnings Code 

from the dropdown. 

7  Description: Enter 

description. 

8  Payable:  Yes or No.  Set this 

to Yes if this item will be 

payable. 

9  Active:   Yes or No.  If this 

payment code is to be used 

now set the Active flag to 

Yes. 

10  Hrs. Per Day:  Options are 

All, 7.00, 7.50 and 8.00.  If 

you limit the code to a certain 

number of hours per day only 

employees that are configured 

with that many hours per day 

will be allowed to access and 

use the code. 

11  Pay Basis: All employees, 

Annual Employees or Hourly 

Employees.  If you limit the 

code to a certain Pay Basis, 

only employees that are 

configured with that Pay 

Basis will be allowed to 

access and use the code. 

12  OT Eligible: Options are OT 

Eligible Only, Non OT 

Eligible and ALL 

13  Amount Type: Select Days, 

Hours or Units depending on 

how the code should be paid. 

14  Min Amount: Minimum 

amount due to an employee 

when using this payment 

code.  For example, an 

employee may be called in 
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and work 15 minutes but if 

the Min Amount is set to 

3.75, the employee will get 

3.75 hours of OT. 

15  Max Amount: The maximum 

amount an employee can be 

paid when using this payment 

code. 

   Additional Fields 

16  Comp Time Affected: If this 

is checked then hours charged 

in this payment code must be 

reconciled on the face of the 

timesheet. 

17  TDS Affected: If this is 

checked the time charged to 

this payment code must be 

reconciled with the TDS tab. 

18  Time Required: If this is 

checked the Begin/End Time 

will be in red font on the 

payment tab and must be 

filled in. 

19  Comment Required: If this is 

checked the Comment label 

will be in red font and a 

comment must be entered. 

20  Holiday Use Only: If 

checked, allows only use of 

the payment code on a 

holiday. 

21  Pass day Use Only: If 

checked, allows only use of 

the payment code on a pass 

day.  

22  Payable Immediately: 

Indicates there are no 

minimum hours worked 

criteria to be eligible for this 

payment. Applies to NYSP 

only. 

23  Contiguous:  If check the 

code may be used contiguous 

to another payment code. 

24  Overlap Days:  Allows the 

payment code to be used 

across 12 midnight. 
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25  Min Hrs. Worked: Minimum 

hours that must be worked in 

order to use a payment code. 

26  Validate Work Time: If this is 

checked the Start/End Work 

Time entries are required and 

LATS will not allow the 

payment code to be used 

outside of those stated hours. 

27  Enter Start Work Time: The 

payment code cannot be used 

before the Start Work Time. 

**Required if the Validate 

Work Time is checked. 

28  End Work Time: The 

payment code cannot be used 

after the End Work Time. 

**Required if the Validate 

Work Time is checked. 

29  Claim Meal Allowance: 

Identifies whether employees 

can claim meals when using 

the payment code. 

30  Enforce Quarter Hour Time: 

Requires time entry in quarter 

hour time. 

31  Narrative 

32  Negotiating Units: 

Negotiating Units that are 

allowed access to the 

payment code. 

  Agencies: Agencies that are 

allowed access to the 

payment code. 

33  Select Add 

 

Define the new payment code. An explanation of payment fields may be accessed by clicking on 

Click for Help at the top right of this screen. 

 

Note:  Payment code types usually match the earnings code type with the exception of Days. If the 

payment code is set to hours, but the earnings code is set to days, LATS will convert the hours 

entered into days when sending to HRIS or PayServ. 

 

 

Changing a Payment Code 

 

If changes to a payment code are required, follow this procedure: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT CODES 
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Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Payment Codes   

4 Payment Codes Enter search criteria, select the Search 

button.  LATS will search the Payment 

Code, Earnings Code, description, 

Active, Time Required, OT Eligible, 

Pay Basis and Pass day Only fields for a 

match on the entered criteria. (Clicking 

search with no criteria will return all 

codes). 

5  Search results are displayed.   

Click on the appropriate row to display 

Payment Code Details.  LATS will 

display the Modify Tab 

6 Modify Tab Make any necessary changes. You may 

make a payment code "inactive" on this 

screen. 

7  Click SAVE. 

 

 

Deleting a Payment Code 

 

If you need to delete a payment code, follow this procedure: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT CODES 

  

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Payment Codes   

4 Payment Codes Enter search criteria, select the Search 

button.  LATS will search the Payment 

Code, Earnings Code, description, 

Active, Time Required, OT Eligible, 

Pay Basis and Pass day Only fields for a 

match on the entered criteria. (Clicking 

search with no criteria will return all 

codes). 

5  Search results are displayed.   

Click on the appropriate row to display 

Payment Code Details.  LATS will 

display the Modify Tab. 

6 Modify Tab Click DELETE. 

7  If the payment code has never been 

used, the system will delete it.  If the 
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payment code has been used, the system 

will not allow you to delete the code. 

 

Note:  The system will not allow you to delete a payment code which has been used. If a payment 

code is no longer active but has been used in the past, follow the procedure in Changing a 

Payment Code and make the payment code inactive. 
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Earnings Codes 

 
Creating an Earnings Code 

 

The Earnings Code must be created prior to the creation of a payment code because the Earnings 

Code populates one of the dropdowns on the Payment Code configuration page. 

 

To Create an Earnings Code: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > EARNINGS CODES 

 

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Payment Codes  

4 Earnings Codes Click on the ADD tab. 

5  Code: Enter the PayServ 

earnings code. This must 

match an existing PayServ 

earnings code or any 

transactions reported will be 

rejected. 

6  Description: Enter a concise 

but clear description of the use 

of this earnings code. (30 

character limit) 

7  Usage: Defaults to M. This 

indicates that the code is 

submitted via miscellaneous 

payments. LATS only allows 

earnings codes that can be 

submitted via miscellaneous 

payments. 

8  Type: Select the type of 

earnings (hours/days/units) 

from the drop-down list. This 

should match entry option on 

PayServ. 

9  Roll up: Choose PERIOD or 

DATE from the drop-down 

list. LATS defaults to 

PERIOD. If set to PERIOD, 

overtime will be transferred to 

OSC in a range of dates, 

beginning with the earliest 

date of payment and ending 

with the last day of that 

payment within the period and 

with a total count for each 
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period. If set to DATE, 

instances of payment or 

additional time will be 

reported separately for each 

day. 

10  Verification required: LATS 

defaults to NO. If set to YES, 

all instances of overtime that 

fall in this earnings code will 

have to be verified by the 

authorizing supervisor. 

11  Counts Toward Paid OT: 

LATS defaults to NO. If set to 

NO, miscellaneous payments 

entered on the 

Additional/Payment tab will 

not be included in hours 

entered on the face of the 

timesheet.  Example 1: IIP 

requires unit entry on 

PayServ; Units must be 

chosen in the earnings type. 

Holidays are entered in days 

on PayServ; Days must be 

chosen in the earnings type.  

Example 2: An employee 

works on a holiday, enters the 

hours worked on the face of 

the timesheet and enters 

payment for the holiday on the 

Additional Time tab. Total 

hours for the week will not be 

increased by the entry on the 

Additional Time tab because 

the payment is set to NO (does 

not count toward paid OT). 

If set to Yes, any hours 

entered on the Additional 

Time tab will be included in 

timesheet calculations. 

 

12  Conversion Factor:  It is used 

in LATS when payments are 

generated - when a payment 

code is set to hours, but the 

earnings code is Days.  If the 

value is zero (default, and 

most often the case), LATS 

will use the employee's 
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hrs_per_day to convert the 

hours to decimal days (as 

always);  If it's filled in, LATS 

will use the value entered to 

convert hours to decimal days. 

13  Click SAVE. 

 

Note:  If PayServ entry requires days or decimal days, earnings type should be set for days. If 

PayServ requires an entry that will never be converted to days, earnings type should be set to Units. 

 

 

Changing an Earnings Code 

 

On some occasions, due to possible typographical errors or changing conditions with contracts, it 

may become necessary to change the definition of an earnings code in your installation. 

 

To change an earnings code: 

CODE   MAINTENANCE > MISC PAYMENT CODES > EARNINGS CODES 

 

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Misc. Payment Codes  

4 Earnings Codes Enter search criteria, select the Search 

button.  LATS will search the Code,   

Description, Usage, Type, Roll-up, 

Verification Required, and Counts 

toward Paid OT fields for a match on 

the entered criteria. (Clicking search 

with no criteria will return all codes). 

5  Search results are displayed.   

Click on the appropriate row to display 

Earnings Code Details.  LATS will 

display the Modify Tab. 

6 Modify Tab You can modify:  Description, Type, 

Roll Up, Verification, Counts Towards 

Paid OT or Conversion Factor. 

7  Click SAVE. 

   

 

Deleting an earnings code: 

 

CODE MAINTENANCE > MISC PAYMENT CODE > EARNINGS CODES 

 

When it is necessary to delete an earnings code, follow this procedure: 

 

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  
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3 Misc. Payment Codes  

4 Earnings Codes Enter search criteria, select 

the Search button.  LATS will 

search the Code,   

Description, Usage, Type, 

Roll-up, Verification 

Required, and Counts toward 

Paid OT fields for a match on 

the entered criteria. (Clicking 

search with no criteria will 

return all codes). 

5  Search results are displayed.   

Click on the appropriate row 

to display Earnings Code 

Details.  LATS will display 

the Modify Tab. 

6 Modify Tab Click delete. 

7  If the earnings code has never 

been used, the system will 

delete it.  If the payment code 

has been used, the system will 

not allow you to delete the 

code. 

 

Note:  If the earnings code has never been used, the system will delete it. If the earnings code has 

been used, the system will not allow you to delete the code. 

 

Payment Roster 

Creating a Payment Roster 

 

A payment roster designates the type of payment that will be made available to a specific 

employee, title or item, (Examples: SBC-Standby on Call, IIP-Intermittent Inconvenience Pay) or 

it may designate a bureau or section in the agency, (Examples: Utilities, Human Resources). 

Multiple payment codes may be assigned to a payment roster. Roster Details are used to assign a 

payment code(s) to a list of employees, items or titles. Using payment rosters, you are able to 

change the payment code for a particular miscellaneous payment without having to adjust the 

individual records for each employee who is eligible to receive that type of payment. 

 

Before you can create a payment roster, the payment code with which it will be associated must 

exist. If it does not, see Creating a Payment Code. 

 

To create a payment roster: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT ROSTERS 

  

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  
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3 Payment Codes  

4 Payment Rosters Click on the ADD tab. 

5  Roster Name: enter a user-

defined name for the payment 

roster. 

6  Effective Begin Date: Click 

the Calendar and from the 

Calendar page select the first 

day on which individuals can 

use the payment code 

associated with this payment 

code. 

7  Effective End Date: Click the 

Calendar and from the 

Calendar page select the last 

day on which individuals can 

use the payment code 

associated with this payment 

roster. Leave this field blank 

if open-ended. 

8  Roster Type:  select 

Employee, Item or Title 

9  Payment Code: From the 

Available Payment Code list, 

select the payment code(s) 

associated with the selected 

payment roster, click the > to 

move the codes to the 

"Selected Payments Code" 

box. If multiple codes are 

required, select multiple 

codes by holding down the 

Shift key and selecting enter.   

10  Codes can be removed from 

the “Selected Payment 

Codes” box by selecting the 

code and selecting the < 

symbol. 

11  Click SAVE. 

 

 

Copy a Payment Roster 

You may also copy a payment roster. 

 

Example 

 

A roster is set up for the year 2004-2005. This roster may be extended by copying the 2004-2005 

Roster and extending the dates. Employees, items or titles assigned to the original roster will 

automatically be assigned to the copied roster. 
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Note:  When copying a roster, available rosters will display in the drop-down list based on 

"Roster Type" chosen. A roster may not be deleted if any employees/items/titles are assigned to 

that roster. A message will be displayed at the top of the page, above the Payment Code drop-

down list, indicating the roster has details and cannot be deleted. 

 

To copy a payment roster: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT ROSTERS 

  

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Payment Codes  

4 Payment Rosters Click on the ADD tab. 

5  Click on Copy Payment 

Roster Button. 

6  Select the Roster Type to 

copy from 

7  Select the Roster Name to 

copy from 

8  Enter the Target Roster Name  

9  Enter the Target Effective 

Begin Date:  

10  Enter the Target Effective 

End Date.   

11  Click SAVE. 

 

 

Creating Roster Details 

 

Roster Details allows you to specify individuals who are eligible to use a particular Payment Roster. 

 

To create Roster Details: 

 

CODE MAINTENANCE > MISC PAYMENT > PAYMENT ROSTERS 

  

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Payment Codes  

4 Payment Rosters Enter search criteria, select 

the Search button.  LATS will 

search the Roster ID, Roster 

Name, Effective Begin Date, 

Effective End Date, and 

Roster Type fields for a 

match on the entered criteria. 

(Clicking search with no 

criteria will return all codes). 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 2: Code Maintenance, 73 of 233 

5  Search results are displayed.   

Click on the appropriate row 

to display Earnings Code 

Details.  LATS will display 

the Modify Tab. 

6    

7  If Employee type roster is 

chosen, click ADD 

EMPLOYEE TO ROSTER. 

If Item type roster is chosen, 

click ADD ITEM TO 

ROSTER. If Title type is 

chosen, click ADD TITLE 

TO ROSTER. 

8  Employee Name: Click 

"Search" and from the 

Employee search window 

select the name of the 

individual to assign to the 

selected payment roster. 

 

9  Effective Date: Click the 

Calendar and from the 

Calendar page select the first 

day on which the individual 

can use the payment code 

associated with the selected 

payment roster. 

10  Click SAVE. 

 

Note:  If you are adding an item number or a title to a roster, follow the procedure detailed above 

but add the desired item number to the "Item Number" field or the desired title to the "Title Code" 

field (click drop-down list and choose title). Any employees in the corresponding items or titles 

will be dynamically linked to the roster. 

 

Removing a Roster Detail 

 

When circumstances change which make an employee no longer eligible for a particular type of 

miscellaneous payment, you will need to remove that employee/item/title from the payment roster. 

 

To remove an employee from the payment roster: 

 

CODE MAINTENANCE > MISC PAYMENT CODES > PAYMENT ROSTERS 

  

Step# Active Window Action 

1 Home Page  

2 Code Maintenance  

3 Payment Codes  
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4 Payment Rosters Locate the Payment Roster where you 

want to delete an employee, item, or 

title.  

5  Click appropriate Roster Detail for that 

roster. LATS displays the Modify 

Payment Roster Details window. 

6 Modify Payment Roster tab Click DELETE. 

7  A message "Are you sure you want to 

delete this record?" will be displayed. 

Click OK to confirm. 

 

Note:  If you want to delete an item number from a Roster, follow procedures above but on the 

Roster Details screen choose Item from the drop-down list. Screen will re-display with item 

numbers highlighted in blue. Click the Item number. Payment Roster Detail (Item Roster (edit)) 

screen will be displayed, click DELETE. "Are you sure you want to delete this record?" will be 

displayed. Click OK to confirm. If you want to delete a Title from a Roster, follow procedures 

above but choose Title from the drop-down list. 

 

Auto Holiday Payments 

 
LATS contains functionality that allows auto-generation of holiday payments if the system is 

configured properly.  This is a multi-step configuration process.  There is a main configuration 

setting that must first be enabled: Configuration Settings> Payments> 

AutoGenerateHolidayPayments.   

 

Once the main configuration setting is enabled there are configurations that need to be set up 

under Code Maintenance> Misc. Payment Codes> Auto Holiday Codes.  Selecting this option 

will open the configuration page seen below: 

 

 
Once all configurations are complete, the employee’s timesheets will be populated with the 

appropriate holiday payment code as displayed in the screenshots below.  

 

Note:  The auto-payment is not added to the payment tab until after the HOL is removed from the 

timesheet. 
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Below is the auto-payment that was added to the Payment tab for the employee. 
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There is logic built into LATS that adds the appropriate number of hours worked on a holiday 

when a partial day was worked as well.  Notice in the screenshot below the employee worked 

4.50 hours on the holiday and claimed 3.00 hours in the HOL row.  LATS created an auto-holiday 

payment for the 4.50 hours worked on the holiday. 
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E-Mail Messages 
 

You will have the option on LATS of choosing from several e-mail messages available. 

E-mail messages are configurable and your agency may choose to use all, some or none of the e-

mail messages available. In addition, the verbiage of the e-mail message and the recurrence of the 

messages may be modified. 
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E-mail messages may be modified but they may not be added or deleted. You may make an e-

mail message inactive by choosing "not specified" in the drop-down list for "Perform this task". 

 

The following e-mail messages are currently available: 

 

 #1 Timesheet Submission: This e-mail will be sent to a supervisor each time one 

of the supervisor's direct reports submits a timesheet for approval. 

 

 #2 Supervisor Change: This e-mail is used by agencies that allow employees to 

choose their own supervisor on the timesheet. E-mail is sent to the old 

supervisor to notify him/her of the change. 

 

 #3 Supervisor Select: This e-mail is used by agencies that allow employees to 

choose their own supervisor on the timesheet. E-mail is sent to the new 

supervisor to notify him/her of the change. 

 

 #4 Overdue Time Sheets: This e-mail will be sent to employees 

that have not submitted timesheets for one or more period. 

 

 #5 Approval Overdue Time Sheets: This e-mail will be sent to a supervisor who 

has not approved employee timesheets for a period designated by the agency. 

 

 #6 Unapprove Time Sheets: This e-mail will be sent to an employee when a 

supervisor unapproves the employee's timesheet. A message may be sent with 

the e-mail by filling in the field provided, but a message is not required for 

this e-mail to be sent. 

 

 #7 Unsubmit Time Sheets: This e-mail will be sent to an employee when a 

supervisor unsubmits the employee's timesheet. A message may be sent with 

the e-mail by filling in information in the field provided, but a message is not 

require for this e-mail to be sent. 

 

 #8 Notify Supervisor:  This e-mail will be sent when a soft clock user clicks on the 

Notify Supervisor button on the soft clock to have request a punch time change request. 

 

 #9 Forgot Password: This e-mail is generate when the Forgot Password configuration 

setting is enabled on the homepage.  LATS will auto-generate a temporary password that 

meets the password rules criteria and send it to the e-mail on file for the employee. 

  
 #10 Schedule Change: This e-mail is generated when an employee changes their 

schedule and the configuration settings that allow employees to modify their schedule is 

enabled. 

 

Note:  An error message will be displayed if the mail address is not filled in. If the error is 

received, you should contact your Account Manager. If you are currently using the Overdue 

Timesheet e-mail, this address will already be filled in. 

 

After you choose which e-mail you want enable, you should contact your administrator at CMA 

to activate the messages you want to use. 
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Chapter 3:  Rules Maintenance 
 

Topics Discussed In This Chapter: 

 

 State Holidays 

 Personal Leave Accrual Rules 

 Sick Leave Accrual Rules 

 Vacation Leave Accrual Rules 

 VRWS Accruals 

 Pass days 

 Seasonal Hours 

 Academic Year 

 

 

State Holidays 
 

This procedure provides a way to check and if necessary to correct, the settings for each state 

holiday in your LATS installation. 

 

What you will need to check state holidays: 

 

 A list of all state holidays for the remainder of the current fiscal year and for the 

next fiscal year. 

 For each holiday, an indication of whether the holiday is, or is not, a floating 

holiday. 

 For each holiday, an indication of whether the holiday falls on a Saturday. 

 For each holiday, an indication of whether this holiday qualifies as a holiday that 

allows veterans and/or former reservists to earn holiday time for the hours 

worked on this day. 

 The expiration date for both floating holidays and regular holidays. 

 

To check the state holidays in your system: 

 

1. From your Home Page, RULE MAINTENANCE > HOLIDAYS. The State 

Holidays Maintenance window will display. The holidays are displayed in chronological 

order, with the most recent holiday displayed at the top of the list. 

2. In the Fiscal Year field, make sure the current fiscal year is selected from the drop-down list. 

3. For each holiday on your list: 

a. Ensure that the holiday is present; if it is not, see "Creating a State Holiday”   

b. Ensure that the date and description for the holiday is correct; if it is not, see 

"Changing a State Holiday"   

c. Ensure that the holiday's floater designation is correct; if it is not, see 

"Changing a Holiday's Floater Designation"   

d. If the holiday falls on a Saturday, ensure the designation is correct. 

e. For each holiday, an indication of whether this holiday qualifies as a holiday that 

allows Veteran's and/or Former Reservists to earn holiday time for the hours 

worked on this day. 

f. If a holiday is listed in the system but not on your list, see "Deleting a State Holiday". 
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Maintenance of State Holidays 

 

RULE MAINTENANCE > HOLIDAYS 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Holidays Click on the appropriate 

Fiscal Year or leave it at the 

default value of ALL. 

4  Click on the holiday you wish 

to edit. 

5  Make the appropriate changes 

to: Description, Veteran Rule, 

and Former Reservist Rule.  

For Each applicable 

Negotiating Unit make the 

appropriate changes to:  

Floater status, Expiration 

Date, Accrual Rate or 

Accrual Bucket. 

6  Click Save. 

 

 

Creating a State Holiday 

 

RULE MAINTENANCE > HOLIDAYS 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Holidays Click on the ADD tab. 

4  Click on the calendar and 

select the date from the 

Calendar Window or 

manually enter date 

 

5  Description: Enter the name 

of the holiday. 

 

6  Veteran Rule.  This field 

default to NO. Qualifying 

holidays must be set to YES 

to enforce Veteran's rules. If 

an employee works on one of 

the qualifying holidays and is 

a veteran or former reservist, 
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and their holiday waiver is 

NO, they will earn holiday 

time for the hours worked, up 

to one day. 

 

 

7  Former Reservist Rule.  This 

field default to NO. 

Qualifying holidays must be 

set to YES to enforce 

Veteran's rules. If an 

employee works on one of the 

qualifying holidays and is a 

veteran or former reservist, 

and their holiday waiver is 

NO, they will earn holiday 

time for the hours worked, up 

to one day. 

8  If desired, enter the following 

data in the Set Template 

Section: Floater, Expiration 

Date, Accrual Rate and 

Accrual Bucket.  After these 

values are entered, Select Fill 

all and the values will be 

filled for all NUs 

 

9  For Each applicable 

Negotiating Unit make the 

appropriate changes to:  

Floater status, Expiration 

Date, Accrual Rate or 

Accrual Bucket. 

 

10  Click ADD. 

 

Note:  State Holidays will need to be added to LATS each year when the list of Holidays for the 

next year is issued by the NYS Department of Civil Service. 

 

Changing a State Holiday 

 

This procedure allows you only to change the floater status and description of the selected 

holiday. To change the date of a holiday, you must first delete the old holiday and create a new 

one with the desired date. 

 

RULE MAINTENANCE > HOLIDAYS 

 

Step # Active Window Action 

1 Home Page  
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2 Rule Maintenance  

3 Holidays Locate the holiday you want 

to change. 

 

  Former Reservist Rule:  This 

field defaults to NO. 

Qualifying holidays must be 

set to YES to enforce Former 

Reservist rules. 

4  If you want to set all the 

Negotiating Unit to have all 

the same settings you can 

click on the  set template 

section to complete by 

completing the following 

fields: Negotiating Unit 

(applies template to all 

Negotiating Units), Floater 

(will check the Floater check 

box for all Negotiating Units 

to identify the holiday as a 

Floating holiday, Expiration 

Date, Accrual Rate (1.0 or 

1.50) and the Accrual Bucket 

(Floater, Holiday and 

Vacation) 

5  Make the appropriate changes 

to the holiday. 

6  Click SAVE. 

 

Deleting a State Holiday 

 

To delete a holiday: 

 
RULE MAINTENANCE > HOLIDAYS 

 

Step  #          Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Holidays Locate the holiday you want 

to delete. 

4  Click on the date for that 

holiday. 

5  Click DELETE. 

 

Note:  LATS will not allow you to delete any holiday that has been used by an employee. The 

message "There is/are misc. leave charge(s) made against this holiday so it cannot be deleted" 

will be displayed at the top of the screen above the list of holidays. 
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Changing a Holiday's Floater Designation 

 

To change the floater designation of a holiday: 

 

RULE MAINTENANCE > HOLIDAYS 

 

Step #          Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Holidays Locate the holiday you want 

to change. 

 

4  Click on the date for that 

holiday. 

 

5  If the holiday is to be a 

floating holiday, modify the 

appropriate flags. 

6  Click SAVE. 

 

Note: If a holiday is designated as a Floating holiday the Floater check box must be checked, an 

Expiration Date should be entered AND the Accrual Bucket should be set to Floater. 

 

Personal Leave Accrual Rules 
 

Accrual rules must exist for all time and attendance eligible employees. If your agency has 

Employees that work part time and in various Negotiating Units, there must be accrual rules set 

for each percentage and NU. 

 

Viewing the Personal Leave Accrual Rules 

 

RULE MAINTENANCE > PERSONAL LV ACCRUALS 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Personal L Accruals Agency: Select the 

appropriate agency if 

applicable or leave the agency 

drop down set to All if there 

is no agency assigned to this 

specific rule. 

4  Select the appropriate 

Negotiating Unit from the 

dropdown or leave it at the 

ALL default. 

5  Click on the rule you wish to 

view. 
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Note:  LATS defaults to a list of "All" for Agency and Negotiating Unit. You may limit your 

search to a specific Agency and/or Negotiating Unit by clicking on the drop-down list and 

choosing the specific Agency and/or Negotiating Unit (this will return results for the selected 

Agency and/or Negotiating Unit only). 

 

Creating a Personal Leave Accrual Rule 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Personal L Accruals Click on the ADD tab. 

4  Select the Negotiating Unit. 

5  Hrs. Per day: choose 7, 7.5 or 

8. 

6  Enter the Percent Working. 

(Matches up to the Employee 

percent on the employee 

profile) 

7  Accrual Effective Date: 

LATS defaults to 1/1/1900. 

8  Accrue Per Period: LATS 

will add this amount to each 

biweekly timesheet (if 

employee qualifies for earned 

accruals). Enter 0 if employee 

does not accrue biweekly. 

 

9  Max Accrual: Limits the 

number of hours an employee 

may accrue under this 

category. 

Example: You may limit a 

7.50 hour employee to 37.50 

hours annually. 

 

10  Annual Adjustment: This 

amount will be added to the 

employee's timesheet on 

which the personal leave date 

falls. 

 

11  Starting Years of Service: 

Sets the number of years an 

employee must complete to 

qualify for accruals earned 

under this rule. If the 

employee is eligible to earn 
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Personal Leave immediately, 

enter 0 in this field. 

 

12  Ending Years of Service: Sets 

the number of years that an 

employee would become 

ineligible to earn these 

accruals. Enter 99 if 

eligibility does not end. 

 

13  Select the Agency or set the 

dropdown to All. 

14  Click ADD. 

 

Note:  If a Personal Leave rule does not have an agency assigned to it, the rule is available to all 

agencies. 

 

Changing a Personal Leave Accrual Rule 

  

RULE MAINTENANCE > PERSONAL LV ACCRUALS 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Personal Leave Accruals Locate the Personal Leave 

Accruals rule you want to 

modify. 

4  Click on Select for that rule. 

Make the desired changes. 

5  Click SAVE. 

 

 

 

 

 

Deleting a Personal Leave Accrual Rule 

 

RULE MAINTENANCE > PERSONAL LV ACCRUALS 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Personal Leave Accruals Locate the Personal Leave 

Accruals rule you want to 

modify. 

4  Click on Select for that rule. 

5  Click Delete and then 

confirm the delete. 
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Sick Leave Accrual Rules 
 

RULE MAINTENANCE > SICK LV ACCRUALS 

 

Viewing the Sick Leave Accrual Rules 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Sick Leave Accruals Leave the filter on ALL or 

select the appropriate Agency 

from the dropdown. 

4  Leave the filter on ALL or 

select the appropriate 

Negotiating Unit from the 

dropdown. 

5  Click on the row with the 

appropriate Hours Per Day 

and % Working. 

   

Note:  LATS defaults to a list of "All" for Agency and Negotiating Unit. You may limit your 

search to a specific Agency and/or Negotiating Unit by clicking on the drop-down list and 

choosing the specific Agency and/or Negotiating Unit (this will return results for the selected 

Agency and/or Negotiating Unit only). 

 

Creating a Sick Leave Accrual Rule 

 

RULE MAINTENANCE > SICK LV ACCRUALS 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Sick Leave Rules Click on the ADD tab. 

4  Negotiating Unit: Limits this 

rule to employees that fall in 

this Negotiating Unit. 

5  Hours per day: Limits this 

rule to employees whose 

normal schedule matches the 

number of hours chosen: 

Example: If 8 is chosen from 

drop-down list, this rule will 

only be applied to employees 

set to 8 Hours per Day on 

Employee Edit or Accruals 

screens. 

6  Percent Working: Limits this 

rule to employees whose 
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profile matches this 

percentage. 

7  Accrual Effective Date: 

LATS defaults to 1/1/1900. 

8  HOP: LATS defaults to blank 

in this field. No longer valid 

in LATS. 

9  Accrue Per Period: LATS 

will add this amount to each 

biweekly timesheet (if 

employee qualifies for earned 

accruals). Enter 0 if employee 

does not accrue biweekly. 

10  Max Accrual: Limits the 

number of hours an employee 

may accrue under this 

category. 

Example: You may limit a 

7.50 hour employee to 1500 

hours. Biweekly timesheet 

accruals will be limited to 

that maximum amount. 

11  Annual Adjustment: This 

amount will be added to the 

employee's timesheet on 

which the annual leave date 

falls.  If there will be no 

annual adjustment enter a 

zero in this field. 

12  IPP: LATS defaults to blank. 

Click to place a check in this 

field if the employee's 

Negotiating Unit participates 

in IPP. 

13  Starting Years of Service: 

Sets the number of years an 

employee must complete to 

qualify for accruals earned 

under this rule. Enter 0 for all 

other Negotiating Units. 

14  Ending Years of Service: Sets 

the number of years that an 

employee would become 

ineligible to earn these 

accruals. Enter 99 if 

eligibility does not end. 

15  Annual Adj. Date Month, 

Day.  The month and day that 
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the annual adjustment will 

occur on each year. 

16  Sick Monthly Adj. Amount.  

The amount that will be 

added each month.  Enter a 

zero if this does not apply. 

17  Monthly Adj. Day.  Pick a 

day of the month that the 

adjustment will occur even if 

the adjustment amount is 

zero. 

18  Agency: Select the 

appropriate agency if 

applicable or leave the agency 

drop down set to All if there 

is no agency assigned to this 

specific rule. 

19  Click Save. 

 

 

Changing a Sick Leave Accrual Rule 

 

RULE MAINTENANCE > SICK LV ACCRUALS 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Sick Leave Rules Leave the filter on ALL or 

select the appropriate Agency 

from the dropdown. 

4  Leave the filter on ALL or 

select the appropriate 

Negotiating Unit from the 

dropdown. 

5  Click on the row with the 

appropriate Hours Per Day 

and % Working. 

6  Make the appropriate 

modifications. 

7  Click Save. 

 

 

Deleting a Sick Leave Accrual Rule 

 

RULE MAINTENANCE > SICK LV ACCRUALS 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  
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3 Sick Leave Accruals Filter by Agency and/or 

Negotiating Unit via the 

dropdown and locate the 

appropriate row/rule. 

4  Click Select for the 

appropriate rule. 

5  Click the Delete button. 

6  Confirm the delete by 

clicking Ok. 

 

Caution:   You may end up with a missing rule that will prevent timesheets from processing. 

 

 

  

Vacation Leave Accrual Rules 
 

Viewing the Vacation Leave Accrual Rules 

 

RULE MAINTENANCE > VACATION LV ACCRUALS 

 

Step# Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Vacation L Accruals Filter on appropriate Agency 

and/or Negotiating Unit 

4  Click Select for the 

appropriate rule.  This will 

open the rule maintenance 

screen so you can view the 

entire rule. 

 

Note:  LATS defaults to a list of "All" for Agency and Negotiating Unit. You may limit your 

search to a specific Agency and/or Negotiating Unit by clicking on the drop-down list and 

choosing the specific Agency and/or Negotiating Unit (this will return results for the selected 

Agency and/or Negotiating Unit only). 

 

   

Creating a Vacation Leave Accrual Rule 

 

RULE MAINTENANCE > VACATION LV ACCRUALS 

 

Step # Active Window Action 

5 Home Page  

6 Rule Maintenance  

7 Vacation L Accruals Click on the ADD tab. 

8  Define the new accrual rule: 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 3: Rules Maintenance, Page 91 of 233 

9  Negotiating Unit: Limits this 

rule to employees that fall in 

this Negotiating Unit. 

 

10  Hours per day: Limits this 

rule to employees whose 

normal schedule matches the 

number of hours chosen: 

Example: If 8 is chosen from 

drop-down list, this rule will 

only be applied to employees 

set to 8 Hours per Day on 

Employee Edit or Accruals 

screens. 

 

11  Percent Working: Limits this 

rule to employees whose 

profile matches this 

percentage. 

 

12  Years of Service: Enter the 

number of years an employee 

must complete to be eligible 

to earn accruals based on this 

rule. 

Example: A CSEA-3 

employee who has completed 

1 year will earn 8 hours on 

the annual bonus adjustment.   

A rule must exist for each 

Negotiating Unit, for each 

Percentage amount and for 

each year completed. 

 

13  Accrual Effective Date: 

LATS defaults to 1/1/1901. 

 

14  Accrue Per Period: LATS 

will add this amount to each 

biweekly timesheet (if 

employee qualifies for earned 

accruals). Enter 0 if employee 

does not accrue biweekly. 

 

15  Max Accrual: Limits the 

number of hours an employee 

may accrue under this 

category. 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 3: Rules Maintenance, Page 92 of 233 

Example: You may limit an 8 

hour employee to 320 hours 

maximum. LATS will deduct 

any hours that exceed that 

amount on the Use Over Max 

by date unless employee is set 

to Allow Excess Vacation 

Balance-Y. 

 

16  Annual Bonus Time: This 

amount will be added to an 

employee's timesheet on 

which the vacation leave date 

falls. 

17  Use Over Max By: Select the 

month and date that 

employees annual leave 

accruals must not exceed the 

Max Accrual amount. 

 

18  Fiscal Adjust Period: Select 

the timesheet period that 

annual adjustment should 

occur (if not on employee's 

anniversary date). 

 

19  Fiscal Adjust Time: Enter the 

adjustment amount employee 

should earn on Fiscal Adjust 

Period. 

 

20  Starting Years of Service: 

Sets the number of years an 

employee must complete to 

qualify for accruals earned 

under this rule. If employee is 

eligible to earn Vacation 

accruals immediately, enter 0 

in this field. LATS will 

accrue vacation leave but not 

display accruals or allow 

employee to charge unless 

Eligible to Use Vacation is set 

to Y. 

 

21  Ending Years of Service: Sets 

the number of years that an 

employee would become 

ineligible to earn these 
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accruals. Enter 99 if 

eligibility does not end 

22  Accrue Method:  Determines 

frequency of accruals. 

23  Accrue month: month 

accruals are credited. 

24  Accrue Date: day of the 

month accruals are credited. 

25  Accrue Amount: Amount of 

additional annual accrual. 

26  Agency: Select the 

appropriate agency if 

applicable or leave the agency 

drop down set to All if there 

is no agency assigned to this 

specific rule.  

27  Click Add 

 

 

 

 

Changing a Vacation Leave Accrual Rule 

 

RULE MAINTENANCE > VACATION LV ACCRUALS 

 

Step # Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Vacation Leave Accruals Locate the Vacation Leave 

Accruals rule you want to 

modify. 

 

4  Click Select for that rule. 

 

5  Make the desired changes. 

6  Click SAVE. 

 

 

Deleting a Vacation Leave Accrual Rule 

 

RULE MAINTENANCE > VACATION LV ACCRUALS 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Vacation Leave Accruals Locate the Vacation Leave 

Accrual rule you want to 

delete. 
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4  Click Select for that rule. 

5  Click DELETE. The message 

"Are you sure you want to 

delete this vacation leave 

rule?" will display. 

6  Click OK. 

7  Caution:   You may end up 

with a missing rule that will 

prevent timesheets from 

processing. 

 

 

VRWS Accruals 
 

Although many of the VRWS Accrual Rules are included when you start on LATS, it may be 

necessary to add a rule based on your agency's requirements. 

 

Note:  Unless the specific rule is included in or has been added to VRWS Accrual Rules, an 

employee's timesheets will not accrue VRWS credits. 

 

Note: VRWS accrual rules require a Delta Percent. The Delta Percent is the difference between 

100% and the VRWS percentage the employee is working. 

 

Example 
  

Employee elects to work an 80% VRWS schedule. The Delta Percent is 20. 

  

Viewing the VRWS Accrual Rules 

 

RULE MAINTENANCE > VRWS ACCRUALS 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 VRWS Accruals Select the appropriate 

Negotiating Unit from the 

drop down. 

 

Adding a new VRWS Accrual Rule 

 

 RULE MAINTENANCE > VRWS ACCRUALS 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 VRWS Accruals Click on the ADD tab. For 

each new accrual rule you 

want to define: 
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4  Negotiating Unit: Limits this 

rule to employees that fall in 

this Negotiating Unit. 

5  Hours Per Day: Limits this 

rule to employees whose 

normal schedule matches the 

number of hours chosen. 

6  Percent Delta: The Delta 

Percent is the difference 

between 100% and the 

VRWS percentage the 

employee is working. 

7  Accrue Per Period: Enter the 

number of hours the 

employee should accrue per 

pay period. 

8  Click ADD. 

 

 

 

Changing a VRWS Accrual Rule 

 

RULE MAINTENANCE > VRWS ACCRUALS 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 VRWS Accruals Locate the appropriate 

VRWS rule by narrowing the 

selection by selecting a 

specific Negotiating Unit in 

the Negotiating Unit 

dropdown. 

4  Click on the Neg Unit row 

that contains the appropriate 

Delta Percentage and Hours 

Per Day. 

5  Make the appropriate change 

to the page. 

6  Click Save. 

 

 

Deleting a VRWS Accrual Rule 

 

RULE MAINTENANCE > VRWS ACCRUALS 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  
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3 VRWS Accruals Locate the appropriate 

VRWS rule by narrowing the 

selection by selecting a 

specific Negotiating Unit in 

the Negotiating Unit 

dropdown. 

4  Click Select for that rule. 

5  Click DELETE. The warning 

"Are you sure you want to 

delete this VRWS Accrual 

Rule?" will display. 

6  Click Ok. 

 

Caution:   You may end up with a missing rule that will prevent timesheets from processing. 
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Pass days 
 

The Pass day function is used to define rules for employees who receive time for working on a 

Pass day. The employee will not be paid for time worked on a Pass day. Eligibility is based on 

your organization's policy. 

 

Note:  If your organization does not earn Pass days, you may skip this section. 

  

Reviewing Pass day Types 

 

RULE MAINTENANCE > PASSDAY TYPES 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Pass day Types LATS defaults to "All" Pass 

day Types. 

4  Click on Pass day Type Name 

under the Description column 

to view the rules for 

established Pass day Types. 

5  Click CANCEL. 

 

Creating a Pass day Type 

 

RULE MAINTENANCE > PASSDAY TYPES 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Pass day Types LATS defaults to "All" Pass 

day Types. 

4  Click ADD Tab 

5  Pass day Type: Assign a one-

letter designation. 

6  Description: Title of 

employees who will earn this 

Pass day type. 

7  Usage in Days: Number of 

days employee will have to 

use earned accruals before 

LATS deletes the accruals. 

8  Min. Hrs. Worked: Number 

of hours employee must work 

on Pass day to earn accruals. 

Must be entered in quarter-

hours. 
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9  Amt. Earned in Hours: The 

number of hours the 

employee will earn if the 

employee works the 

Minimum required. 

10  Click ADD. 

 

 

Changing Pass day Types 

 

RULE MAINTENANCE > PASSDAY TYPES 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Pass day Types LATS defaults to "All" Pass 

day Types. 

4  Click on Pass day Type Name 

under the Description column 

to edit rules for an established 

Pass day Type. 

5  Modifications may be made 

to all fields, including 

Minimum number of hours 

required to earn Pass day, 

Number of hours earned, etc. 

6  Click SAVE. 

  

 

Seasonal Hours Overview 
 

The seasonal hour’s functionality was developed to support a business requirement where 

employees are granted a certain amount of time each day as paid time since they work an 

abbreviated schedule during the summer months.  Automatically adding this specified time on to 

each day will ensure that they meet the required hours per day as long as they work the scheduled 

reduced hours on a daily basis.  Employees are credited with the number of hours based on items 

configured by the LATS Administrator. The logic built into this functionality should allow many 

combinations to exist concurrently. 

 

Configuration Steps for Seasonal Hours 

 

Below outlines the steps required to setup and configure seasonal hours. The details follow. 

1. Create a new ‘No Charge’ leave category 

2. Assign a leave code to the category – which will be the leave code added to the user’s 

timesheet. 

3. Set up the season hour’s rules, which are date effective. 

4. Assign the seasonal hour rule to the individual employee, all in the negotiating unit or to 

specific rotations. 
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The seasonal hours are added to a user’s timesheet for all scheduled days of the pay period – 

when the user’s timesheet for that pay period is first created (typically after the first punch is 

received). 

 

The following are exceptions that must be handled by the Time and Attendance personnel – 

for users who have no access to a timesheet.  These exceptions can be handled thru the Punch 

Detail page or directly on the timesheet. 

 

 Employee leaves early.  T/A will need to remove the .50 hours credited for 

seasonal hours, and charge the appropriate leave category. 

 Employee takes the day off.  T/A will need to remove the .50 hours credited for 

seasonal hours and charge the appropriate leave category. 

 Employee works a full 8 hours or more.  T/A will need to remove the .50 hours 

credited for seasonal hours. 

 Holidays.  T/A will need to remove the .50 hours credited for seasonal hours.   

This exception will be handled in a future modification. 

 

Seasonal Hours Detailed Steps 

 

 Create a new charge code under the No Charge category.  To do this you would need to 

go to the Code Maintenance – Categories and search for No Charge and then click on the 

No Charge row to open the Edit window. 

 Once you are in the edit window you can click on the Add Code button to add a new 

Charge Code. 

 Complete the new code window that is attached to the No Charge category. 

 Next you can create the rule for the Seasonal Hours under the Rules Maintenance menu 

option. 

 Select the Seasonal Hours sub menu option and complete the fields that identify how 

many hours and for what duration the time should be added for the employees. 

 

 After the rule is created you can manage the Seasonal Hours under the Admin Menu by 

selecting the Manage Seasonal Hours sub menu.  You can manage these by employee or 

Negotiating Unit. 

 You can also add the summer hours rule to existing rotations and propagate these changes 

to existing employee rotations.  To do this you would need to go into the Scheduling 

menu option and then click on the Rotation tab. 

 

If you wish to attach a Seasonal Rule to an existing Rotation instead of creating a new rotation 

just for seasonal hours you can do so by clicking on the desired rotation and this will open the 

edit window. 

 Select the appropriate Seasonal Hours rule from the dropdown menu option and then 

select Yes in the Propagate Changes dropdown box. (We have identified which changes 

in this screen will propagate to existing rotations for you.) 

 If you go into an employee’s record and click on the Rotation tab you should now see the 

appropriate seasonal hours in the Seasonal Hours dropdown tab. 

 

View Seasonal Hours rules 

 

RULE MAINTENANCE > Seasonal Hours 
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Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Seasonal Hours Will display all existing 

Seasonal hours Rules 

4  Click on the row for the 

desired seasonal rule 

5  Seasonal Rule will be 

displayed 

6  Click Cancel 

 

 

Creating Seasonal Hours rules 

 

RULE MAINTENANCE > Seasonal Hours 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Seasonal Hours Will display all existing 

Seasonal hours Rules 

4  Click ADD Tab 

5  Description: Enter 

Description of the Seasonal 

Rule 

6  Add Daily Hours:  Enter the 

number of daily hours 

7  Leave Code:  Select Leave 

Code to use 

8  Start Date:  Enter date to start 

seasonal rule 

9  End Date:  Enter date to end 

seasonal rule 

10  Click Save 

 

 

Change Seasonal Hours rules 

 

RULE MAINTENANCE > Seasonal Hours 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Seasonal Hours Will display all existing 

Seasonal hours Rules 

4  Click on the row for the 

desired seasonal rule 
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5  Seasonal Rule will be 

displayed 

6  Modify data as necessary 

7  Click Save 

 

 

 

 

Delete Seasonal Hours rules 

 

RULE MAINTENANCE > Seasonal Hours 

 

Step#  Active Window Action 

1 Home Page  

2 Rule Maintenance  

3 Seasonal Hours Will display all existing 

Seasonal hours Rules 

4  Click on the row for the 

desired seasonal rule 

5  Seasonal Rule will be 

displayed 

6  Click Delete 

7  Confirm Delete by selecting 

OK 

 

Academic Year 
 

Academic Year:  This menu item is used to set up the calendar year for the teacher population 

and to manage their floating holiday and personal leave credits.  

 

Step#  Active Window Action 

 Home Page  

 Rule Maintenance  

 Academic Year Click the Add tab 

  Select the Agency from the 

dropdown list or select –ALL—if 

this academic calendar will apply 

to any agency. 

  Select the Start Date Month and 

Day. 

  Select the End Date Month and 

Day. 

  Enter the number of Floating 

holidays per year that teachers 

should accrue. 

  Enter the number of Personal 

Leave Days per year that teachers 

should accrue. 
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  Enter the Floating Days Expiration 

Date Month/Day. 

  Enter the Personal Leave Days 

Expiration Date Month/Day 

  Click Add 
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Chapter 4:  Time Distribution System 
 

Topics Discussed In This Chapter: 

 

 TDS Categories and Tasks 

 Maintaining TDS 

 TDS Category Association 

 TDS Percent Distribution 

 

 
 

TDS Categories and Tasks 
 

If your organization requires all or some of its employees to distribute time to tasks, you will need 

to create the TDS categories and their associated tasks. If your organization requires none of its 

employees to do so, you may skip this chapter. 

 

What you will need to create TDS categories and tasks: 

• A list of all TDS categories. 

• For each TDS category, a list of all currently active tasks to which employees can 

distribute time. If the task has a beginning and end date associated with it, you will need 

to know those dates. 

 

To create TDS Categories and tasks: 

For each TDS category, you will need to create the category within LATS. To do this, see 

"Creating a TDS Category". 

 

For each task within the category you have created, you will need to create an entry for the task. 

To do this, see "Creating a TDS Task". 

 

Maintaining TDS 

TDS Categories 

Four types of categories are available in LATS. You may not see all four, however. Display of 

Custom and Imported categories is limited to those agencies which have purchased advanced 

functionality.  

 

The four types of categories are as follows: 

 

Global 

 

Select GLOBAL if you want to include a common set of tasks for all regular categories. Global 

categories allow you to define tasks once that may be used in many different categories. Global 

categories will not display in an employee's drop-down category list; but choosing any category 

from the list will display global tasks that are set to the employee's organizational structure or that 

are not limited to a specific organizational area. These tasks will also be displayed if your agency 

is using either Custom or Imported categories. 
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Regular 

 

Select REGULAR when defining categories and tasks that will use the standard TDS entry pages. 

Regular categories can be set to a specific organizational structure or agency-wide. Regular 

categories will be displayed in the dropdown list on an employee's TDS page. Tasks associated to 

a Regular category can only be used by that category. 

 

Custom 

 

This choice will be displayed only if your agency is using a TDS custom page version 2. Custom 

categories will be displayed on the custom TDS page. 

  

Imported 

 

This choice will be displayed only if your agency is importing TDS information from a source, as 

opposed to direct entry. These categories will be displayed on the TDS custom page version 1. 

  

Creating a TDS Category 

 

TDS MAINTENANCE > TDS CATEGORIES 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Categories Click on the ADD tab. 

4  Category: A short name, or 

code, for the category; a 20-

character maximum. 

5  Category Type: From the 

drop-down list, choose the 

type of category. 

6  Description: A concise but 

clear description of the 

intended use of the new 

category; 150-character 

maximum. 

7  Narrative: The description of 

the category which will 

display when a user clicks 

Narrative; 255-character 

maximum. 

8  Active: Check the box to 

indicate the category will 

immediately become active. If 

a category is not active, 

LATS will not display it; 

therefore, employees will be 

unable to select it. 
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9  Non-Productive: Check the 

box if the category will not be 

directly work-related/billable; 

for example, training. 

10  Agency: Select the agency 

with which this category is 

associated. 

11  Division: If you want the 

category to be available only 

to employees in a particular 

division, select the division 

from the drop-down list. 

12  Bureau: If you want the 

category to be available only 

to employees in a particular 

bureau within the selected 

division, select the bureau 

from the drop-down list. 

13  Click SAVE. 

 

 Reassigning TDS Categories 

 

TDS MAINTENANCE > TDS CATEGORIES 

 

Occasionally, the hierarchy of organization-to-category relationship changes. To accommodate 

this, you may move categories from one organization to another. 

  

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Categories TDS Category: Locate the 

category you want to 

reassign. 

4  Click on the Short Name for 

that category. 

5  Indicate the new level of your 

agency for which the                                  

category will be available by 

making choices from the 

Division and Bureau drop-

down list. 

6  Click SAVE. 

 

Deleting TDS Categories 

 

TDS MAINTENANCE > TDS CATEGORIES 

 

Step#  Active Window Action 

1 Home Page  
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2 TDS Maintenance  

3 TDS Categories Locate the category you want 

to delete. 

4  Click on the Short Name for 

that category. 

 

5  Click DELETE. The message 

"Are you sure you want to 

delete this Category?" will be 

displayed. 

6  Click OK to confirm. 

 

Note:  If a category has been created in error, you can delete that category only when no tasks 

have been assigned to it. If a category has already been used, you will be unable to delete it. You 

may choose to remove the check on the Active setting to prevent employees from selecting it. 

 

TDS Tasks 

 
Creating a TDS Task 

 

TDS MAINTENANCE > TDS TASKS 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Tasks Click the ADD tab. 

4  Category: Select the 

appropriate Category from the 

drop down that the Task will 

be associated with. 

5  Task Code: System Defined 

(configurable setting) 

7  Description: A concise but 

clear description of the 

intended use of the task; 75-

character maximum. 

8  Activation Date: The first 

date on which time can be 

distributed to the new task. 

9  Inactivation Date: The last 

date on which time can be 

distributed to the new task. 

10  Narrative: The text which the 

system will display to a user 

who clicks on Narrative; 255-

character maximum. 
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11  Comments: Additional 

Information about the new 

task, if necessary. 

  Direct/Indirect: Options are 

Not Specified, Direct, 

Indirect.  These flags are used 

to identify Tasks for TDS 

reporting/billing.  There is no 

functionality associated with 

this dropdown.  This field is 

for reporting purposes only. 

  Sub Task Required: Options 

are Not Required or Required.  

If the sub task is required, 

LATS will flag an error on 

the TDS page alerting the 

employee that they must 

select a sub task for the entry 

to be saved. 

12  Click SAVE. 

 

Note: It is important to remember that all tasks must be associated with a category. If the new 

task will be associated with a category that does not yet exist, see "Creating a TDS Category". 

 

Note: Employees will not be able to select or use a task which falls outside of the Active dates as 

designated above. 

 

Reassigning TDS Tasks 

 

TDS MAINTENANCE > TDS TASKS 

 

Occasionally, the hierarchy of category-to-task relationships changes. To accommodate this, you 

may move tasks from one category to another. 

 

To reassign tasks: 

  

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Categories Locate the category currently 

associated with the task you 

want to reassign 

4  Click TASKS for that 

category. 

5 TDS Tasks Locate the task you want to 

reassign. /Click the Task 

Code for that task. 

6  Select the new category from 

the drop-down list. 
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7  Click SAVE. 

 

 

 

Changing the Date Range for a Task 

 

TDS MAINTENANCE > TDS TASKS 

 

Occasionally, it is necessary to alter the Activation Date, the Inactivation Date, or both, for a 

particular task. To do this: 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Categories Locate the category 

associated with the task that 

you want to modify the date 

range for. 

4  Click on the Tasks for that 

category. 

5 TDS Tasks Locate the task you want to 

reassign. 

6  Click the Task Code for that 

task. 

7  Modify the Activation and/or 

Inactivation dates. 

8  Click Save. 

 

 

Deleting TDS Tasks 

 

TDS MAINTENANCE > TDS TASKS 

 

If a task is created erroneously, you can remove the task from the LATS database. 

 

Note:  The LATS system will not allow you to delete tasks to which users have assigned time. If 

you find that time has been assigned to a task you want to delete, you will need to make the task 

inactive to make it unavailable for further use. See "Changing the Date Range for a Task". 

 

To remove a task from the LATS database: 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Tasks Locate the task you want to 

delete. 

4  Click the Task Code for that 

task. 

5  Click DELETE. 
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6  Click Ok to confirm deletion 

of task. 

 

 

Viewing the Change History for a Task 

 

TDS MAINTENANCE > TDS TASKS 

 

Over the life span of a task, changes to its definition may occur. To view a history of these changes: 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Tasks Locate the task you want to 

examine. 

4  Click the HISTORY button 

for that task. 

5  Click the Close “X” in the 

upper right hand corner of the 

History page. 

 

TDS Sub Tasks 

 

Sub Tasks are assigned at the TDS Category level and not specifically attached to a specific task. 

 

To view and modify sub tasks attached to a specific category 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Subtasks Select the appropriate Subtask name 

or TDS category from the drop down 

list and click Search. 

4  This will return all subtasks related to 

that category. 

5  Click on the Subtask Code, LATS 

will display the Modify Tab for 

selected subtask 

6  Make Changes as necessary 

7  Select SAVE 

 

Creating a new sub task 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Subtasks Click the ADD tab. 
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4  Enter the Sub Task Code 

5  Enter the description 

6  Select the appropriate category from the 

dropdown list. 

7  Select the appropriate Agency.  

8  Select the appropriate Division if applicable. 

9  Check the Active box if the Sub Task is 

active. 

10  Enter a narrative about the sub task if desired. 

  Sub Task Type: Options are Not Specified, 

Federal and Non-Federal.  There is no 

functionality assigned to the options in this 

dropdown.  This field is for reporting 

purposely. 

11  Click Save. 

 

Deleting a sub task 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 TDS Subtasks Select the sub task you wish to delete 

from the Sub task drop down. 

4  Click on the Sub task code. 

5  Click Delete. 
 

***Sub Tasks that have been used cannot be deleted.  If a Sub Task has been used the end user 

may make it Inactive by un-checking the Active box.  This will not allow the Sub Task to be 

utilized any longer. 
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Custom TDS 
 

Customers have the option of utilizing a Custom TDS page for recording TDS information if the 

standard TDS model does not meet their requirements.  Currently there are four Custom TDS 

pages available in LATS. 

 

Custom Page Version 1 allows the end user to search by Project Number and Project Title. 

Custom Page Version 2 allows the end user to search by Exam Number or Comp. Name. 

Custom Page Version 3 allows the end user to search by Category, Task and Cost Center. 

Custom Page With Section allows the end user to narrow TDS options by Agency, Division, 

Bureau, Section, Function Group (Category) and Function Code (Task). 

 

Note:  If there is no custom page assigned to an agency (this is normal) the employees will have 

the standard TDS page for TDS entries. 

 

 

Creating a new Custom TDS Task 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 Custom TDS Access Click on the ADD tab. 

4  Page Version:  select the 

appropriate custom page 

5  Agency:  select the 

appropriate agency. 

6  Division: select the 

appropriate Division if 

applicable or leave blank if 

applicable to all Divisions in 

the Agency. 

7  Bureau:  if an Agency and 

Division are selected the end 

user may select the 

appropriate Bureau. 

 

Deleting a Custom TDS Task 

 

Step#  Active Window Action 

1 Home Page  

2 TDS Maintenance  

3 Custom TDS Access Click on the Search tab. 

4  Click on the Organization 

link for the Custom TDS 

Page you want to delete. 

5  Click Delete. 

6  Click Ok to confirm delete. 
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TDS Category Association 
 

The TDS Category Association module allows a project code (category) to be associated with 

more than one cost center, and an activity code (task) can be associated to multiple projects. 

LATS utilizes a Custom TDS page to manage the TDS Category, TDS Task, Cost Center and 

percent.   

 

When a task or cost center is added (associated) to a category, there are additional attributes. It 

can be identified as being valid for the TDS Percent distribution (which is TDS that is set up for 

specific item numbers or employees and prefills their timesheet. It can also be identified as being 

valid for TDS – meaning the combination can be added to the TDS page by an employee, in 

addition to their default TDS. 

 
Viewing/Editing an Existing Record 

 

Step#  Active Window Action 

 TDS Maintenance  

1 TDS Category Association Enter Category Code or 

Description. 

2  Click the Search button. 

3  LATS will return data rows 

that meet the search/partial 

search criteria. 

4  Click the Detail link to 

manage the Task and Cost 

Center Data. 

5  Make the appropriate edits 

for the Tasks or Cost Center 

and click Save. 
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TDS Percent Distribution 
 
The TDS Percent Distribution page is used in conjunction with the TDS Category Association. 

 
Hourly employee percentage distribution is not tied to an item number, but directly to the 

employee.  The Category, Task, Cost Center and Regular Hours Percent and OT Hours Percent. 

 

The TDS Percent Distribution page allows a search by employee or by item number.   

 

  
 

Note: Distribution data for annual employees (pay basis AN) is associated to an item number 

only, not directly to the employee. 

 

When searching by Agency code and Item number, after retrieving a valid record, the name of the 

employee currently appointed to the item is displayed on the page. If multiple employees are tied 

to the same item number LATS will display a Multiple Incumbents page to select the correct 

employee. 

 

 
 

 

 

Example of the Multiple Incumbents page is below: 
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Search by name – after entering 3 characters a selection list will be built containing matches 

(searches both first and last name) 

 

 

 
 

 

Once an employee, or item number is selected, the admin can modify the Percent Distribution 

page.  The data that is configured on the Percent Distribution page will prefill the employees TDS 

tab based on hours entered on the face of the timesheet. 

 

 
 

 

If the employee enters hours on the face of the timesheet, LATS will automatically apply the 

percent distribution to those hours and the employee does not need to enter them on the TDS tab.  

The employee can update the TDS tab is necessary but this is usually an exception based on 

feedback from the agency. 

 

Screen shot of the daily time entry: 
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A screen shot of the associated TDS tab: 
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Chapter 5:  Working with Employees         
 

Topics Discussed In This Chapter: 

 

 Establishing Employee Initial Status 

 Entering a New Employee 

 Assigning Supervisor 

 Working with Alternates 

 

  

Establishing Employee Initial Status 
 

If your organization can import employee status from HRIS, NYSTEP, HCM or another 

personnel system, parts of this step will not be necessary.  

 

LATS allows entry and edit of most employee information through the ADMIN > USERS path. 

As each screen is completed and saved, LATS re-displays tabs for other options, including 

General Info, Employee, Accruals, Time clock, Supervisor, Delegate, Timekeeper, Rotation, 

Misc. Leave and Adjustments. 

 

What you will need to establish employee status: 

 

A list of all employees in your agency; or, at the very least, a list of all employees in the unit(s) 

your agency will begin implementation with. 

 

For each employee on the list, you will need the following information: 

• What is the employee's annual leave date? If your Agency can import information from 

the personnel system this is not necessary. 

• What is the employee's personal leave date? If your Agency can import information from 

the personnel system this is not necessary. 

• Does the employee participate in IPP? M/C employees who participate in IPP do not earn 

sick leave accruals on biweekly timesheets. They earn a lump sum amount semi-annually 

based on dates entered in IPP Grant Dates. If so, what are the grant dates for sick time? If 

your Agency can import information from the personnel system, this is not necessary. 

• Does the employee record his time on an administrative or institutional pay cycle?   

Note:   Beginning and end dates on timesheet are determined by this selection. 

• Is the employee eligible to earn and use leave (time and attendance eligible)? 

• Is the employee eligible to earn and use vacation? 

• Is the employee allowed to accrue vacation time above the "normal" limit? 

• Is the employee required to use TDS? If so, is the employee required to allocate the time 

by percentage? 

• Does the employee have a holiday waiver? 

• Does the employee need to use a time clock to record his ins/outs? 

• Is the employee eligible to receive overtime compensation? Is so, has the employee 

elected to participate in Over40 Non Comp program? 

• Does the employee participate in AWS? If so, what are normal Pass days for the 

employee? 
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• What method will this employee use to record overtime? Will it be based on entries on 

the timesheet or will overtime be recorded on the Additional Time tab? 

• Does this employee accrue Non Comp overtime? 

• Is this employee eligible to earn Pass days? 

• For each accrual category, the number of hours the employee has accumulated. 

 

Enter the employee's accrual balances as of the date shown in the Initial Balance Date for each 

category in which the employee has a balance. These accrual amounts will become the beginning 

balances on the employee's first timesheet on LATS. 

   

 Additional items that can be configured for the employee are: 

 

 T/A Eligible: If the employee is Time and Attendance eligible (will earn accruals) check 

this box. 

 Eligible to use Vacation:  If the employee is going to be allowed to use their vacation 

prior to the waiting period check this box. 

 TDS Required:  If the employee will be required to record their time worked on specific 

tasks check this box. 

 OT Eligible: If the employee is allowed to earn overtime pay or time check this box. 

 Holiday Waiver:  If the employee is choosing to earn time instead of pay for holidays 

worked check this box. 

 Former reservist:  If the employee is a former reservist and entitled to additional 

benefits/pay on certain holidays check this box. 

 LATS will default to TIMESHEET OT on Method of Recording Overtime (overtime is 

recorded on the main timesheet page). If employee's overtime will be captured through 

the Additional Time tab, choose that option from the drop-down list.  

 Min. Hrs. Worked to Earn OT and Num of Weeks OT Applies will default to correct 

settings based on the choice in Method of Recording Overtime. 

 LATS will default to N/A on Eligible to Earn Pass days. If employee does earn time 

when working on a Pass day, choose the correct Pass day policy from the drop-down list. 

 Min Hours Worked to earn OT:  The number of hours and employee must work before 

being eligible to earn OT. 

 AWS: If the employee will work an alternate work schedule (flex time) check this box.  

If one of the following statements is true: 

The employee participates in AWS, or 

You want the system to check the employee's timesheet only to make sure that weekly or 

biweekly hourly totals are met, not that each day must have a specific number of hours. 

An employee on AWS may work long and short days or may work a reduced number of 

days during a pay period, but still work the total expected hours. 

If neither of the statements is true, proceed to the next step. 

AWS: Select YES from the drop-down list. 

Select the appropriate number of hours for each week in a payroll period from the Week 

1 Normal Hours and Week 2 Normal Hours fields. 

If you want the system to check the employee's timesheet for the selected number of 

hours for each week, select NO in Bi-Weekly Total. 

 Last Accrual Date:  the last date the accrual process ran for this employee. 

 Allow Excess Vacation Balance:  Check this box if the employee will be allowed to 

exceed the maximum vacation balance allowed on the accrual rule. 
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 TDS By Percent:  This field is enabled if the TDS Required check box is checked.  If the 

employee is to record TDS by a percentage rather than hours worked check this box. 

 Comp Over 40 Eligible:  Checking this box will display an additional overtime line 

(Comp Over40) and will require employee to enter all overtime worked in that line until 

the maximum is reached. 

 Enforce Punch Restriction:  If this attribute is checked it enables the function to lock out 

a clock user from punching at a clock before a certain time.  **This needs to be 

configured on the clock with the new dotNet release. 

 Veteran Status:  If the employee is a veteran and should receive additional benefits for 

working certain holidays check this box. 

 Accrue Non Comp:  If the employee is allowed to bank the time worked between their 

normal hours per week and 40 hours check this box.  The most common scenario is for a 

7.50 hour per day employee.  This type of employee works 37.50 hours per week.  Any 

time worked between 37.50 and 40.00 can be accrued as non-comp time and used at an 

additional date for paid time off. 

 Num of Weeks OT Applies:  If the Method of Recording OT is set to Timesheet or 

Overtime tab the default is 1 week.  If the Method of Recording OT is set to Additional 

Time the values available are 1 week or 4 weeks. (Most clients will use the 1 week value.   

If you are unsure of which option to select please contact your client support 

representative) 

 Timesheet Validation forces the timesheet to validate against the schedule planner or 

based on Hours/Days/Pass days. LATS will default to HRS/DAYS and AWS in 

Timesheet Validation. If your organization requires validation based on the Schedule 

Planner, choose SCHEDULES from the drop-down list. 

 Click to select the appropriate Pass days in the Week 1 Pass days and Week 2 Pass days 

area. LATS defaults to the number of hours per day and work week entered in the 

Employee Information window. 

 

Note:  Pre-set Pass days may be set for days other and Saturday/Sunday for employees not 

designated AWS. Edits will prevent setting more than four Pass days for a non-AWS employee. In 

addition, Pass days can be set from the timesheet profile page. Changes made on the profile will 

affect that timesheet only. 

 

 Choose the correct Pass days for this employee. Pass days may be changed and saved 

without setting AWS to YES if the employee is part-time. LATS will not allow more than 

two Pass days per week for a full-time employee without changing the AWS setting for 

the employee to YES . 

 

Comments: If necessary, add a concise but clear explanation of why you are setting the 

employee's initial balance date. 

 

 Click SAVE. LATS will save the information you have entered about the employee and 

re-display the Accrual Balances window. 
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Establishing Employee Initial Status 

 

If the Employee:  Take this action:  Otherwise 

 

Is eligible to use leave  Put a check mark in  Do not check TA Eligible 

    TA Eligible 

Checking the box will allow the employee to accrue and charge Personal and Sick Leave. 

 

If the Employee:  Take this action:  Otherwise 

 

Is eligible to use vacation Check the Eligible to  Do not check the Eligible to 

Use Vacation box Use Vacation/Annual Leave box. 

     

Checking the box will allow the employee to accrue and charge to Vacation Leave.  

 

If the Employee:  Take this action:  Otherwise 

 

Is allowed to accrue  Check the Allow  Do not check the Allow 

vacation time above the  Excess Vacation box  Excess Vacation box 

Excess Vacation 

"normal" limit  

 

Checking the box will allow the employee to exceed the maximum balance on the "use over Max 

by" date set in the Vacation leave accrual rules. The employee will not be cut back to the 

maximum. 

 

If the Employee:  Take this action:  Otherwise 

 

Is required to use TDS  Check the TDS   Do not check the TDS 

Required box.   Required box 

 

Checking the box will require the employee to complete Time Distribution information on the 

LATS timesheet. Employee will complete information in hours. 

 

If the Employee:  Take this action:  Otherwise 

 

If required to use TDS,  Check the TDS by  Do not check the TDS by 

allowed to allocate time by Percent  box   Percent box. 

percentage? 

 

Checking the box will require employees to complete Time Distribution information by 

percentage. 

 

If the Employee:  Take this action:  Otherwise 

 

Is eligible for overtime  Check the box for   Do not check the OT Eligible 

OT Eligible box. 
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Checking the box will display overtime lines on the timesheet. Not checking the box will remove 

all overtime lines from the timesheet and will allow the employee to exceed usual hours without 

accounting for extra hours. The employee will be able to submit the timesheet as completed. OT 

Eligible employees will always have a Time In/Time Out timesheet. 

 

If the Employee:  Take this action:  Otherwise 

 

Is eligible for overtime and Check the Comp  Do not check the Comp 

elected to participate in  Over40 Eligible box.  Over 40 Eligible box. 

Over 40 non comp 

 

Checking the box will display an additional overtime line (Comp Over40) and will require 

employee to enter all overtime worked in that line until the maximum is reached. 

 

If the Employee:  Take this action:  Otherwise 

 

Has signed a waiver  Check the Holiday  Do not check the Holiday 

accepting holiday time  Waiver  box.   Waiver box. 

instead of holiday pay 

 

Checking the box will result in the addition of Holiday accruals to the timesheet for any hours 

worked on a holiday during the employee's normal work schedule. The employee will not enter or 

receive payment for time worked on a holiday. 

 

If the Employee:  Take this action:  Otherwise 

 

Is required to use a time  Check the Clock User  Do not check the Clock User 

clock to record time in   box.    box. 

and time out. 

 

Checking the box in this field will require the employee to enter time by swiping on a time clock 

or by entry on a "soft clock". The employee will not be able to add, delete, or change time in/time 

out entries. 

 

If the Employee:  Take this action:  Otherwise 

  

Will accrue non comp   Check the Accrue   Do not check the Accrue 

Overtime   Non Comp box   Non Comp box. 

 

Checking the box allows the employee to earn time for hours worked between 37.50 and 40. Not 

checking the box prevents the employee from earning non comp overtime for these hours 

according to organizational policy. 

 

 If the Employee:  Take this action:  Otherwise 

 

Is hourly and will earn   Select DYNAMIC in  Select FIXED in 

accruals based on actual  Dynamic Employee  Dynamic Employee Percent 

number of hours worked  Percent    (LATS will default to 

during each timesheet      FIXED) 
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Selecting DYNAMIC in this field allows the employee to earn accruals based on the number of 

hours actually worked in the pay period. LATS calculates the percentage and grants accruals to 

the employee based on that percentage. 

  

 

Entering a New Employee    
 

Most LATS installations receive their information about new employees either from HRIS or 

NYSTEP or some other agency-specific HR system. However, it is necessary, on occasion, to 

enter information about a new employee directly into LATS. 

 

To enter a new employee: 

 

LATS ADMIN > Users (General tab) 

 

Step# Active Window Action 

1 Home Page  

2 Admin> Users  

3 General Tab Social Security Number: 

Enter the new employee's 

unique Social Security 

number. Note:  If an 

employee has been 

established on LATS and the 

Social Security number was 

entered incorrectly, you may 

correct the Social Security 

number by clicking in the box 

next to the current Social 

Security number and entering 

the correct number. 

 

First Name: Enter the first 

name as you want it to appear 

on LATS 

4  Mid Initial: Enter a middle 

initial for the employee, if 

available. This will be helpful 

if your organization has more 

than one employee with the 

same first and last name. 

5  Last Name: Enter the last 

name as you want it to appear 

on LATS. 

6  Name Suffix: as you want it 

to appear on LATS. 

7  Email Address: This 

information will be required 

if your organization is 
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sending LATS e-mails to 

remind employees to submit 

or approve timesheets. 

8  Address 1: as you want it to 

appear on LATS. 

9  Address 2 (if applicable): as 

you want it to appear on 

LATS. 

10  City: as you want it to appear 

on LATS. 

11  State: as you want it to appear 

on LATS. 

12  Zip Code: as you want it to 

appear on LATS. 

13  Phone Number: as you want it 

to appear on LATS. 

  NYS Employee ID: Enter the 

NYS Employee ID.  Non 

State customers can use this 

field to enter a unique 

employee id number. 

14  User Name:  the login id the 

employee will use to utilize 

LATS. 

15  User Roles:  Check the boxes 

for the appropriate user roles 

for the employee.  ALL 

LATS users must have the 

User check box checked. 

**Please see security role 

access addendum for specific 

role access and setting any 

segmentation access. 

16  Select the appropriate 

Agency, Division, Bureau and 

Section for the employee. 

17  Click Save. 

 

  

Employee Entry (Employee tab) 

 

Step# Active Window Action 

1 Employee Tab Employee Priority: LATS 

defaults to 1.  If your 

organization chooses to use 

the LATS Payment transfer 

function, this number must 

agree with PayServ employee 

number. 
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2  Percent: LATS defaults to 

100. If employee is working 

part-time, this amount should 

be changed to the employee's 

correct percentage. 

3  Salary Grade: Enter correct 

salary grade for the new 

employee. LATS requires this 

information for certain 

timesheet and accrual rules. 

4  Salary: Enter the Per Diem 

base Salary rate. **This field 

is only required if Pay Basis = 

Per Diem. 

5  Status Flag: LATS defaults to 

P (permanent). Choose the 

correct designation for this 

employee from the dropdown 

list. 

6  Initial State: Date the 

employee first begins work 

for your organization. 

7  Effective Date: Enter the date 

this transaction should take 

effect on LATS. 

8  VRWS percent: If the 

employee participates in 

VRWS, change this 

percentage to 100%. 

9  Pay Basis: LATS defaults to 

ANNUAL. Other options in 

the dropdown are: Hourly, Per 

Diem and Calendar. 

10  Active Status: LATS defaults 

to ACTIVE. If the employee 

is hired and put on immediate 

leave, you may choose 

LEAVE from the drop-down 

list or you may choose to set 

the Initial Balance Date at a 

later time. 

11  Full/Part Time: LATS default 

to F. Choose the correct 

designation from the drop-

down list if the employee is 

part-time or is VRWS. This 

designation must agree with 

percent and VRWS percent 

entered previously. 
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12  Negotiating Unit: Choose the 

correct negotiating unit for the 

employee. This information is 

required for LATS to enforce 

accruals, payments, etc. 

13  Item Number: Enter the 

correct item number for the 

employee. This information 

will be used for such functions 

as Payment Transfer. 

14  Title: Choose the correct title 

from the drop-down list. If the 

title does not exist, see 

"Creating a New Title". 

15  Work Location: Choose the 

employee work location from 

the dropdown list. If the work 

location does not exist, see 

"Creating a new Work 

Location” Note: this is not 

required by default.  There is 

a config setting 

(AllowChangeWorkLoc) 

which makes this a required 

field. 

16  Location: Choose the 

employee location from the 

dropdown list. If the location 

does not exist, see "Creating a 

new Location" 

17  Position Pool ID: Enter 

information, if required by 

your organization. 

18  Position Number: Enter, if 

required by your organization. 

19  Click Save. 

 

Employee Entry (Accruals Tab)  

 

Step# Active Window Action 

1 Accruals Tab Personal Leave Data: Enter 

the date which LATS will use 

to calculate Personal Leave 

accruals for the employee.  

2  Vacation Leave Date: Enter 

the date which LATS will use 

to calculate Vacation Leave 

accruals for the employee. 
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3  IPP Grant Date 1: For MC 

employees only, enter the date 

employees will earn their first 

bucket of IPP sick time. 

4  IPP Grant Date 2: For MC 

employees only, enter a date 

six months after the IPP Grant 

Date 1. Sick leave will be 

granted on these dates. 

5  Pay Cycle: Select 

INSTITUTIONAL or 

OTHER from the Pay Cycle 

drop-down list. 

6  Initial Balance Date: Select 

the appropriate Pay Period in 

which LATS will start 

looking for timesheets to be 

submitted. (Dates are based 

on Pay Cycle)  Selecting an 

IB Date will enable the 

accrual balance fields for data 

entry if employees are 

carrying accruals from a prior 

agency. 

7  Enter any beginning accrual 

balances that the employee 

may be starting with. 

8  TA Eligible:  check box if 

employee will be earning 

accruals. 

9  Eligible to Use vacation: 

check if employee will be 

allowed to use vacation time.. 

10  TDS Required: check if 

employee is required to record 

time by task on TDS tab. 

11  OT Eligible: check box if 

employee is allowed to earn 

overtime time/pay. 

12  Holiday Waiver: check if 

employee has opted to earn 

time instead of pay on 

holidays worked. 

13  Clock User: Check this box if 

the employee is a Clock User.  

Note:  This enables the Soft 

Clock Types dropdown box. 
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14  Former Reservist: check if the 

employee is a former 

reservist. 

15  Method of Recording OT: 

Options are Timesheet, 

Additional Time or Overtime 

tab. Select the appropriate 

method for your agency. Most 

customers will use the 

Timesheet or Additional Time 

tab. 

16  Min Hours Worked to earn 

OT:  The number of hours and 

employee must work before 

being eligible to earn OT. 

Note: This field is enabled 

with the Method of Recording 

it set to Additional Time. 

17  Eligible to Earn Pass days. If 

employees earn time when 

working on a Pass day, 

choose the correct Pass day 

policy from the drop-down 

list. Note: This is specific for 

the NYSP at this time. 

18  Hours per day: Choose the 

correct number of hours per 

day that the employee will 

normally work. Hours entered 

are used as the basis for the 

accrual rules. If the employee 

is part-time, LATS will 

calculate hours based on the 

percentage of the normal work 

day. 

19  AWS: If the employee will 

work an alternate work 

schedule (flex time) check 

this box. 

20  Week 1/Week 2 Normal 

Hours: This field is not 

enabled unless the employee 

is AWS. LATS defaults to 

37.50 for 7.50 hours per day 

employee. 

21  Default Present Absent:  This 

will force the employee to use 

the Present Absent timesheet 

regardless of the employee’s 
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Negotiating Unit and overtime 

status. 

22  Instructor:  This identifies the 

employee as a 

teacher/instructor. Note:  If an 

employee is an Instructor, 

they will use the Academic 

calendar to identify work 

days. For the Academic 

calendar logic to work the 

LATS admin will need to set 

up the Academic Year to 

identify work days. 

23  Last Accrual Date: The date 

that the employee accrual 

balances were last updated via 

the accruals process. 

24  Allow Excess Vacation 

Balance:  If the employee will 

be allowed to exceed the 

vacation balance limit on the 

accrual rule check this box. 

25  Comp Over 40 Eligible:  if the 

employee signed up to 

participate in the Comp Over 

40 program check the box. 

26  Enforces Punch Restriction: 

No longer used in LATS. 

Disregard field. 

27  Veteran: if the employee is a 

veteran of the US military 

check this box. 

28  Accrue Non Comp:  If the 

employee is allowed to bank 

the time worked between their 

normal hours per week and 40 

hours check this box.  The 

most common scenario is for 

a 7.50 hour per day employee.  

This type of employee works 

37.50 hours per week.  Any 

time worked between 37.50 

and 40.00 can be accrued as 

non-comp time and used at an 

additional date for paid time 

off. 

29  Num of Weeks OT Applies:  

If the Method of Recording 

OT is set to Timesheet or 
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Overtime tab the default is 1 

week.  If the Method of 

Recording OT is set to 

Additional Time the values 

available are 1 week or 4 

weeks. (Most clients will use 

the 1 week value.   If you are 

unsure of which option to 

select please contact your 

client support representative) 

30  Timesheet Validation:  forces 

the timesheet to validate 

against the schedule planner 

or based on Hours/Days/Pass 

days. LATS will default to 

HRS/DAYS and AWS in 

Timesheet Validation. If your 

organization requires 

validation based on the 

Schedule Planner, choose 

SCHEDULES from the drop-

down list. 

31  Dynamic Percent: Applies to 

PT employees only.  If 

checked, employees will earn 

accruals based on the hours 

worked for each PP. 

32  Biweekly Total: This field can 

be checked for overtime 

ineligible employees.  If this 

is checked LATS will look for 

the total hours necessary per 

pay period (75/80) versus 

daily hours (7.00/7.50/8.00) 

or a weekly total 

(37.50/40.00) 

33  Occasional Employee:  

Options are Yes or No. LATS 

will not mark a timesheet as 

missing if the Occasional 

Employee check box is set to 

Yes on that specific timesheet.  

This is used for employees 

that have irregular work 

schedules. 

34  Freeze Vacation Earnings:  

This applies to employees that 

go from full time to part time 

status.  It will not allow 
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employees to earn accruals at 

the new part time percentage 

until their vacation balance is 

under the new leave max rule. 

35  Comment:  Enter any 

applicable comments 

regarding the employee.  For 

example, note the date of 

transfer from a different 

agency and the agency name. 

 

Assigning Supervisors 
 

A supervisor in LATS is a person who is authorized to approve the timesheet of another 

employee; an alternate is a person who is authorized to perform that function in the absence of a 

supervisor. Alternates are assigned to supervisors; when Person B is assigned as the alternate to 

Person A, all persons whose timesheet can be approved by Person A may also have their 

timesheets approved by Person B. Supervisors and Alternates are currently assigned in a direct 

supervisor chain. 

 

Agencies often wish to assign another employee in the supervisor's section that will have the 

ability to approve timesheets in the supervisor's absence. Care must be taken to ensure that this 

action does not give the alternate the ability to approve his/her own timesheet. 

 

Example 
 

Supervisor A approves Employee A, B and C. If employee A is designated as an alternate for 

Supervisor A, that employee will have the ability to approve their own timesheet. The correct 

assignment of alternates would be Supervisor A’s immediate supervisor and that supervisor's 

supervisor. 

 
You may however, choose, as an alternate, another supervisor in that unit if that supervisor does 

not report to Supervisor A. 

 

When an employee opens a timesheet, LATS checks to ensure that the employee has a designated 

supervisor for the pay period covered by the timesheet. If no supervisor has been indicated for the 

pay period, LATS will display an error message (No Supervisor Selected) on the employee's 

timesheet. LATS will not allow the employee to submit a timesheet if no supervisor has been 

assigned. If your organization requires an administrator to assign a supervisor, the employee will 

be required to contact an administrator and request that action. 

 

LATS provides the following methods for assigning supervisors and alternates: 

 

• Authorizing Supervisors by Section 

• Assigning a Supervisor to an Individual Employee 

 

Note:  An employee will not appear in the drop-down list unless he has been designated as a 

Supervisor on the Security Role screen, thus authorizing that employee as a supervisor. 

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 5: Working with Employees, 131 of 233 

Assigning Supervisors 

 

To authorize an individual as a supervisor: 

 

LATS ADMIN > USERS > SUPERVISOR TAB 

 

Step# Start Window Action 

1 Home Page  

2 Users Search tab: Enter at least the 

last name of the employee 

whom you want to authorize 

as supervisor. If you use a 

first name, it should precede 

the last name. 

3  Click on the employee name. 

4  On the General tab scroll 

down to the Roles section and 

check the Supervisor box. 

5  Click Save. 

 

Note:  You may also designate an employee as a supervisor by clicking in the Supervisor Role 

box on the Supervisor Assignments screen. From Supervisor Assignment screen, enter the 

supervisor's name and, from the list displayed, click on employee name. When the name is 

displayed, place a check in the Supervisor Role box by clicking in the box and saving. The 

employee may now be chosen from the drop-down list of Supervisor names. 

 

After you designate an employee as a supervisor and assign employees to that supervisor, the 

supervisor's name will appear as underlined and in blue on the security page. Clicking on the 

supervisor name will display a list of direct approvals, with employee information. 

  

 

Authorizing Supervisors by Section 

 

Supervisors are those people authorized to approve the timesheets of others. To authorize 

supervisors for employees within a section: 

  

ADMIN > SUPERVISOR ASSIGN Search by: Select Section 

 

Step# Start Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Agency: Select the agency 

you want to examine from the 

drop-down list. 

4  Division: Select the division, 

in any, within that agency 

from the drop-down list. 
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5  Bureau: Select the bureau, if 

any, within that division from 

the drop-down list. 

6  Section: Select the section, if 

any, within that bureau from 

the drop-down list.  

7  Click SEARCH. 

 

8  Click on an employee name 

in the Employee field. 

 

9  Supervisor: Select the desired 

supervisor from the 

Supervisor drop-down list. 

10  Click SAVE. 

 

Assigning a Supervisor to an Individual Employee 

 

When a new person enters your agency, or when a person is transferred from one section to 

another, it will be necessary to assign that person a supervisor. 

 

To assign a supervisor to an individual employee: 

 

LATS ADMIN > SUPERVISOR ASSIGN Search by: Select employee 

 

Step# Start Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Employee: Enter the name of 

the employee to whom you 

want to assign a supervisor. 

4  Click SEARCH. 

5  Locate the name of the 

employee to whom you want 

to assign a supervisor. 

6  Click on the name in the 

Employee field. 

7  Supervisor: From the drop-

down list, select the name 

of the supervisor you want to 

assign to the selected 

employee. 

8  Click SAVE. 

  

Note:  If a supervisor change is required after a timesheet is established and saved, you must also 

correct the supervisor on the established timesheet. You may change the Supervisor and the 1st 

Alternate on an established timesheet by clicking on Supervisor on the employee's timesheet. A 

list of the employee's supervisor and all alternates will be displayed.  
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CHANGE SUPERVISOR: enter the name of the new supervisor and SEARCH. From the list of 

supervisors displayed, choose the new supervisor by clicking SELECT. YOU may also correct 

the 1st Alternate following this procedure. Click CLOSE WINDOW. 

Viewing All Employees Assigned to a Supervisor. 

On occasion, it is useful to produce a listing of all employees who are direct reports to a particular 

supervisor. 

  

Example 

 

A supervisor retires and his direct reports and alternates need to be reassigned to a new 

supervisor. The ability to identify all the employees supervised will ensure all employees are 

reassigned and all alternates are corrected. 

 

 

 

To view all direct reports to a supervisor: 

 

ADMIN > SUPERVISOR ASSIGN Search by: Select Supervisor from the drop-down list. 

 

Step# Start Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Enter the name of the 

supervisor whose reports you 

want to view. 

4  Click SEARCH. 

 

 

Reassigning a Supervisor's Direct Reports 

 

To reassign all direct reports from one supervisor to another: 

 

ADMIN > SUPERVISOR ASSIGN by: Select Supervisor from the drop-down list. 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Enter the name of the 

supervisor whose reports you 

want to view. 

4  Click SEARCH. 

5  In the Supervisor column, 

click the name of the 

supervisor whose current 

reports you want to change. 

6  From the drop-down list, 

select the name of the new 

supervisor. 
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7  The message "Are you sure 

you wish to re-assign 

[Previous supervisor] direct 

reports to [New Supervisor]?" 

will be displayed. 

8  Click OK to confirm. 

 

Note:  You are reassigning a Supervisor if you click OK. Click CANCEL if you are trying to 

reassign an employee to a new supervisor and follow the procedure in "Assigning a Supervisor to 

an Individual Employee". 

 

Working with Alternates 
 

An alternate, in the LATS context, is a person authorized to review and approve (or unsubmit) 

timesheets of employees who are direct reports to another supervisor. 

In order for an individual to be selected as an alternate, that individual must have the security role 

of Supervisor. See "Authorizing a Supervisor" for details. 

 

Assigning Alternates to Supervisors 

  

Alternates are assigned to supervisors; therefore, all employees who are direct reports to a 

particular supervisor will have the same set of alternates. 

 

Note:  If your agency has employees choose their supervisors, this rule is not applicable. 

 

To assign one or more alternates to a supervisor: 

 

ADMIN > SUPERVISOR ASSIGN Search by: Select Supervisor from the drop-down list. 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Enter the name of the 

supervisor whose reports you 

want to view. 

4  Click SEARCH. 

5  In the Supervisor column, 

click the name of the 

supervisor whose alternates 

you want to add. 

6  Click EDIT SUPERVISOR. 

7  Alternate 1: Select the name 

of the 1st Alternate from 

the drop-down list. (Repeat 

this process for additional 

alternates) 

8  Click SAVE. 

 

Changing Alternates Assigned to a Supervisor 
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As changes occur, it may become necessary to change the alternates assigned to a particular 

supervisor. 

 

 

 

To change a supervisor's alternates: 

 

ADMIN > SUPERVISOR ASSIGN Search by: Select Supervisor from the drop-down list. 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assign Enter the name of the 

supervisor whose reports you 

want to view. 

4  Click SEARCH. 

5  In the Supervisor column, 

click the name of the 

supervisor whose alternates 

you want to add. 

6  Click EDIT SUPERVISOR. 

7  Alternate 1: Select the name 

of the new 1st Alternate. 

from the drop-down list. 

8  Repeat this process for 

additional alternates. 

9  Click SAVE. 

 

 

Note:  Deleting or changing a supervisor does not delete or correct the information when that 

supervisor is assigned as an alternate. The supervisor will remain as an alternate until deleted or 

corrected manually by an administrator. 
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Chapter 6:  Security Roles 
 

Topics Discussed In This Chapter: 

 

 Assigning Security Roles 

 Limiting Security by Segmentation 

 

Employees will require the User Role to be able to access, create and submit their timesheets.  

User ids will also have to be assigned for each employee before they can begin to use LATS. 

Additional employee access will require setting the appropriate security roles for that employee. 

 

Security roles may be assigned either by the employee name or by using the organizational 

structure. Each search method results in a list of employees (either those that match the name you 

have entered or those who are assigned to the unit you have selected). If you are limiting rollout 

of LATS to one group of employees, and you know that all employees are correct as assigned, 

you may benefit by using the Division/Bureau/Section method. 

 

Assigning Security Roles 
 

This section covers the following methods for assigning security roles to employees:  

 

 Assigning Security Roles by Employee Name  

 Assigning Security Roles by Division  

 Assigning Security Roles by Bureau  

 Assigning Security Roles by Section 

Assigning Security Roles by Employee Name 

 

ADMIN > SECURITY ROLES 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Security Roles Assign Roles by: From the 

drop-down list, select 

Employee Name. 

4  Enter the full or partial 

employee name. 

5  Click Search. 

6  Click on the employee 

name and then click on the 

required roles for the 

employee. 

7  If the employee needs their 

password reset, check the 

Reset Password check box. 

8  Click Save. 
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Assigning Security Roles by Division 

 

ADMIN > SECURITY ROLES 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Security Roles Assign Roles by: From the 

drop-down list, select 

Division. The page will be 

displayed to allow you to 

choose the required Division. 

4  Agency:  From the dropdown 

list select the appropriate 

Agency. 

5  Division: From the drop-

down list, select the division 

from which you want to 

assign security roles to 

employees. 

6  Click Search. 

7  For each employee that 

returns in the search list select 

the appropriate security roles. 

8  If the employee needs their 

password reset, check the 

Reset Password check box. 

9  Click Save. 

 

Assigning Security Roles by Bureau 

  

ADMIN > SECURITY ROLES 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Security Roles Assign Roles by: From the 

drop-down list, select 

Division. The page will be 

displayed to allow you to 

choose the required Division. 

4  Agency:  From the dropdown 

list select the appropriate 

Agency. 

5  Division: From the drop-

down list select the 

appropriate division. 
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6  Bureau: From the drop-down 

list, select the appropriate 

bureau from which you want 

to assign security roles to 

employees. 

7  Click Search. 

8  For each employee that 

returns in the search list select 

the appropriate security roles. 

9  Click Save. 

 

Assigning Security Roles by Section 

 

ADMIN > SECURITY ROLES 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Security Roles Assign Roles by: From the 

drop-down list, select 

Division. The page will be 

displayed to allow you to 

choose the required Division. 

4  Agency:  From the dropdown 

list select the appropriate 

Agency. 

5  Division: From the drop-

down list select the 

appropriate division. 

6  Bureau: From the drop-down 

list select the appropriate 

bureau. 

7  Section: From the drop-down 

list, select the appropriate 

section from which you want 

to assign security roles to 

employees. 

8  Click Search. 

9  For each employee that 

returns in the search list select 

the appropriate security roles. 

10  If the employee needs their 

password reset, check the 

Reset Password check box. 

11  Click Save. 

 

Note:  Please see the separate LATS Security Role addendum. 
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Limiting Security by Segmentation 
 

An additional limitation may be designated for employees who are given Time Records, 

Personnel, Payment Rosters, Timekeeper Assignees, Punch Detail, Delegates, Cost Splits and 

Searches (Timesheet, User, Schedules) in LATS. 

 

Example 

 

A Personnel Coordinator assigned to several Sections will need to view timesheets for all of the 

employees in those sections. Employee will be given access to HR under Security Role and all 

sections required (with the exception of the section where the employee is currently located) will 

be added under Segmentation. 

 

Step# Active Window Action 

1 Home Page  

2 Admin>Users Enter the name of the employee 

and click search. 

3  Click on the employee row. 

4  Click on the General tab. 

5  Assign one of the following 

security roles: Time Records, 

Personnel, Payment Rosters, 

Timekeeper Assignees, Punch 

Detail, Delegates, Cost Splits. 

6  Click SAVE. 

7  A Segmentation link will be 

displayed under the security 

roles section of the page. 

 

8  To add a segmentation record, 

click on Segmentation link. 

Choose the desired 

Agency/Division/Bureau/Section 

from the drop-down lists and 

click ADD. A reminder will be 

displayed to confirm your 

change. All areas that the 

employee may access will be 

displayed under Access Code in 

bottom segment of screen. 

LATS will display a % if all can 

be accessed. 

9  To delete additional areas, click 

SEGMENTATION next to 

employee’s name. Place a check 

in the box under “Delete Check” 

column. Click REMOVE 

SELECTED. A reminder will be 
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displayed to confirm your 

change. 
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Chapter 7:  Timesheets 
 

Topics Discussed In This Chapter: 

 

 Types of Timesheets on LATS 

 Timesheet Features and Administrator Edits 

 Error Codes and Notice on Timesheets 

 Links on Timesheet 

 

Types of Timesheets on LATS 
 

LATS provides two basic timesheets. An employee’s Negotiating Unit, Grade, 

Overtime Eligibility and rules set within your organization determine the type of timesheet the 

system displays.  Note:  Employees that have the Default Present Absent checked on the Accruals 

tab will have the Present Absent timesheet regardless of the built in edits that usually determine 

the type of timesheet that an employee will use. 

 

Present/Absent Timesheets 

 

Present/Absent timesheets display only Present and Absent boxes. No Day In/Day 

Out or Lunch in/Lunch out fields will be displayed. The employee will complete the timesheet by 

clicking in the Present box if they are at work and the Absent box if they are not at work. If 

employee works part of the day and charges time for the remainder of the day, they must click 

both Present and Absent and enter charge accruals. Employees complete charges to accruals in 

the same manner as Time In/Time Out employees. 

 

Time In/Time Out Timesheets 

 

Employees required to complete Time In/Time Out timesheets must complete the Day 

In and Day Out fields. Lunch Out and Lunch In will also need to be entered if required by your 

organization and by employee’s normal work schedule. 

 

Timesheet Features and Administrator Edits 
 

The LATS timesheet has many features which allow employees to view information which is not 

displayed on the face of the timesheet. Employees may use the Audit 

Screen to view all adjustments to timesheets, including initial balance amounts; they may also 

view a summary of their previous timesheets. Employees may also add Emergency Contact 

information, print their timesheet (single or range of timesheets), and change their password. 

 

Audit Link (Available to all employees) 

 

Clicking this label opens a new window which displays a list of adjustments completed on LATS, 

including initial balance accrual amounts, adjustments completed by administrators, and accruals 

deducted for tardy time. Information includes the date on which a particular adjustment took 

effect, the amount of the adjustment, and the reason for the adjustment. Any information created 

on the Adjustment tab of the LATS Admin > Accruals > Adjustment screen will be displayed. 
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LATS displays this label on all timesheets.  The information on this page can be exported to MS 

Excel by clicking on the Download Excel Report. 

 

Summary (Available to all employees) 

 

Clicking this label opens a new window which displays a Timesheet Summary. 

Information displayed includes timesheet pay periods (including dates), timesheet status 

(submitted, processed, etc.), Full Pay Status (A value of Y in this field means that employees will 

earn accruals for the pay period, If this value is N, the employee is not entitled to earn accruals) 

tardy time, Vacation time used, Personal time used, Comp time used, Comp Time paid, Comp 

Over 40 Earned, Comp Time Earned, Misc. Leave used, VRWS Used, VRWS Earned and Part 

Time paid extra. LATS displays the Summary link on all timesheets. 

 

Profile (Available to Administrators and limited availability to some supervisors and 

employees) 

 

Clicking this label opens a window showing selected information from Edit Employee, 

Appointments and Accruals. Administrators can change information in this window; when saved, 

these changes will take place immediately on the timesheet. 

 

Note: Changing information on this screen will not correct the “master” record for this 

employee. 

**Note:  Supervisors of a timeclock user are allowed access to the Profile link to change AWS 

status and passdays) 

***Note: When the config setting AllowUserExpectedHoursMod is enabled, employees will have 

access to the profile link and can only change the Week1/Week2 expected hours on the timesheet 

profile.  All other fields are locked down) 

 

Copy (Available only to Time Records role) 

 

Clicking this label allows an administrator to copy a previous timesheet to the next timesheet. 

This is useful when completing timesheets for an employee on extended leave or where the same 

leave accruals or miscellaneous leave codes are charged each period. Employee timesheets do not 

display this label. 

 

Delete (Available only to Time Records role) 

 

Clicking the Delete button will prompt the Time Records user to confirm that they want to delete 

the timesheet and all entries. Deleting a timesheet sets the Status back to New Timesheet. 

 

Notes (Available to all employees) 

 

Clicking this label allows users to add notes to the current timesheet. If the timesheet has been 

processed, LATS displays any notes added to the timesheet. LATS displays this label on all 

timesheets. 

 

Contact Info (Available to employee for update and limited information available to the 

supervisor in read-only mode) 

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 7: Timesheets, 143 of 233 

If this feature is enabled, clicking this label opens a new window in which an employee can 

update contact information for notification in case of emergencies. This information is not 

available to supervisors or administrators and cannot be displayed by them. 

 

 

Print and Print All 

 

Clicking on the Print link allows the user to print a timesheet that contains just the information on 

the timesheet tab.  After clicking the Print link the employees has the option to print a single 

timesheet (Print button) a Range of timesheets (Range button) or Close the window. 

 

Clicking on the Print All link allows the user to print a timesheet that contains information from 

the timesheet tab, Workers Comp tab TDS tab and Payments tab. After clicking the Print link the 

employees has the option to print a single timesheet (Print button) a Range of timesheets (Range 

button) or Close the window. 

 

 

 

Error Codes and Notice on Timesheets 
 

LATS displays color-coded error messages when it encounters errors on timesheets. 

The codes and colors display at the top left of the body of the timesheet; the column header for 

the day in which the error occurred will be colored to match the error code color. Table 1 contains 

the error codes, the color associated with each, the cause of each and a possible remedy. 

 

Note:  Because the column header can display only one color at a time, columns which contain 

multiple errors may require several iterations before all errors are corrected. 

 

 

Table 1. Timesheet error codes 

 

Code  Color  Error Possible Remedy 

24 Hour Error Blue Time Worked 

+charges 

are greater than 24 

hours for the day 

Check AM/PM 

designations on Time 

In/Time out fields. 

LATS defaults to 

Time In as AM and 

Time Out as PM. 

Also check for 

incorrect tardy 

minutes entry that 

may have caused 

LATS OT. 

Over Charge Error Orange-Red Charges to leave 

credits for a day are 

greater than the 

amount available on 

that day 

Check charges 

against available 

accruals. 

 

Example: Employee 

may have charged 
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Holiday instead of 

Floater or 4 hours of 

Personal Leave when 

only 2 hours are 

available. Employee 

may have charged 

accruals before they 

are available. 

Excess Time 

Allocated 

Yellow Charges to accruals 

for a day are greater 

than the normal hours 

to be worked for that 

day. Check at bottom 

of timesheet under 

Total Time. If total 

time worked exceeds 

the normal Pass day, 

check to make sure 

employee did not 

enter excessive 

accruals. Charges to 

Accruals on a Pass 

day. 

Check at bottom of 

timesheet under Total 

Time. If total time 

worked exceeds the 

normal Pass day, 

check to make sure 

employee did not 

enter excessive 

accruals. Check for 

charges to accruals on 

the employee’s Pass 

day. 

Incomplete Time Pink One of the two 

required pairs (Day 

In/Day Out or Lunch 

Out/Lunch In) is not 

complete; 

 

OR 

 

One of the extra 

In/Out Pairs is not 

complete 

Check for all Time 

In/Time Out entries. 

Make sure Lunch 

Out/Lunch In times 

are entered. 

 

If employee has Extra 

Time, make sure all 

pairs are entered. 

Some Other Error Orange Catch-all category, 

including such errors 

as: Pair entries are 

reversed; Time was 

earned on a weekend 

or Pass day 

Check for reversed 

entries on fields. 

Missing Time Light Steel 

Blue 

Time worked + 

charges entered do 

not equal a normal 

work day, work 

week, or pay period, 

depending on your 

position. 

Check for total hours 

worked. Hours 

entered need to meet 

or exceed (overtime) 

normal work 

schedule 

Comp Time Error  Lime Green Total hours worked 

are greater than a 
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normal work day and 

excess is not properly 

accounted for as 

Earned Non Comp or 

Paid Overtime or 

CompOV40 OR 

Earned Non Comp or 

Paid Overtime or 

CompOV40 is  

claimed for a day 

when total hours 

worked do not exceed 

normal work day; 

OR 

Earned Non Comp or 

Paid Overtime or 

CompOV40 is  

claimed by an 

employee who is not 

eligible for it; 

OR 

For an AWS 

employee, the total 

hours worked 

for the week are 

greater than the 

expected for the week 

and the excess is not 

properly accounted 

for as Earned Non 

Comp or Paid  

Overtime or 

CompOV40. 

Check for overtime 

entry. Make sure all 

overtime is entered in 

the correct category. 

If employee is 

designated as Comp 

OV 40, all overtime 

over 40 hours per 

week must be entered 

on that line until the 

maximum is reached. 

 

LATS enforces 

balances on a day to 

day basis. 

TDS Mismatch Aqua The employee is 

required to enter 

TDS, 

and the time recorded 

for TDS does not 

match the work time 

on that day. 

Check totals worked 

per day against TDS 

entries. Correct  

entries. 

Quarter Hour Error Dark Green A charge is made in 

less than a quarter 

hour increment but is 

required to be in 

quarter hour 

increment. 

Check for time 

in/time out entries 

that do not round to 

the nearest quarter 

hour. 

Sick Leave Notice Bisque The number of 

consecutive days 

charged to sick leave 

No action necessary. 

Timesheet may be 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 7: Timesheets, 146 of 233 

requires medical 

documentation to be 

provided. The 

number 

of days is 

configurable 

such that this 

message 

may never appear 

submitted with this 

message. Employee 

should submit 

documentation as 

required by 

organization 

Misc. Leave Over 

Charge 

Red Charges to a 

miscellaneous leave 

category exceed the 

amount available on 

that day 

Check charges to 

miscellaneous leave. 

Employee may have 

exceeded available 

balance or maximum 

amount allowed. 

Miscellaneous 

Payments Exist 

Unapproved or 

Miscellaneous 

payments exist 

Clear — 

text only 

Payments have been 

entered on the 

payment page of the 

timesheet 

No action required by 

administrators. 

Informational display 

only. A supervisor 

must approve 

payments before 

approving timesheets. 

Lateness 

Overcharge 

Yellow Text of this message 

is configurable. 

Displayed if the tardy 

credits are exceeded. 

Dependent on the 

Organization’s tardy 

policy. 

Check tardy minute 

entry. Amount 

entered may exceed 

the amount actually 

allowed regardless of 

accrual charges. 

No color message is 

displayed when 

accruals are charged 

for tardy minutes. 

Text only message. 

Missing Lunch 

Minutes 

Peach Error message is 

displayed if lunch is 

required and the 

employees has not 

taken the appropriate 

number of required 

lunch minutes. 

Employee must 

charge the minimum 

number of minutes 

for the Lunch 

Out/Lunch In total 

lunch minutes. 
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Links on Timesheet 
 

There are several areas on the LATS timesheet that, when opened, will display additional fields 

or information. 

 

 
 

Supervisor 

 

Clicking this link will allow employees, and administrators, to change employee supervisor 

information.  If the employee completes this transaction, and the associated e-mail configurations 

are enabled, an e-mail will be sent to the gaining supervisor AND the losing supervisor as well as 

a third party email (if configured). 
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Note: If an employee makes this change it updates their main profile (Admin>User).  If this is 

performed by a Time Records user it does not update the main profile, nor does it send out the e-

mail. 

 

Work Location 

 

If enabled, click this to display all available work locations. The employee would click this link to 

change their work location. 

 

Employee Name 

 

Displayed at the top center of the timesheet. Clicking the employee name will display static 

employee information (excluding Social Security number) This is a read only screen and displays 

partial information from several of the employee admin record tabs. 

 

Status 

 

Clicking this link will display all information relating to when and by whom the timesheet is 

submitted, approved, and processed. 

 

Outstanding Timesheets 

 

If this link is displayed, the employee has not submitted all required timesheets. Clicking the link 

will display a list of outstanding timesheets. Clicking the timesheet data displayed on that list will 

display that timesheet. 

 

Extras 

Clicking this field will open three extra sets of Time In/Time Out on the timesheet.  These extra 

punch pairs are used when the employee takes leave during the work day but returns to work. 

 

Balance Projection 

 

Clicking this link will allow the employee to enter a projection date, using the calendar to set that 

date. LATS will run a projected balance for the projection date, assuming that the employee does 

not charge any accruals between the current data and the projected date. 

 

Note:  This is ONLY a projection of future earnings. It cannot take into account any future time 

off. 

 

Non Comp 

 

Clicking on this link will display all available non-comp accruals. Accruals will be displayed for 

the previous fiscal year and the current fiscal year. 

 

FMLA Usage 

  

This link displays the Max Allowed FMLA time, FMLA Used and Remaining FMLA time 

available for the employee.  Charges to FMLA will only appear in this link if the Enhanced 

FMLA is enabled and charge codes are configured to apply towards Enhanced FMLA. 
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Chapter 8:  Accruals Processing 
 

Topics Discussed In This Chapter: 

 

 Running the Accrual Process 

 Accrual Processing Errors 

 Resetting the Accrual Process 

 Accrual Status – Process Tab 

 

 

After timesheet are submitted and approved, it is necessary to run the Accrual Process. This 

“finalizes” the accruals on the timesheets and prepares timesheet information for transfer to TDS, 

reports and the payment interface function. The accrual process may be run for all employees or 

for an individual employee, depending on what is chosen from the drop-down lists and may be 

run multiple times. Only approved timesheets are affected by the Accrual Process. 

 

Running the Accrual Process 
 

For all employees 

 

To complete the accrual process for one or more payroll periods for all employees: 

 

ADMIN > ACCRUAL PROCESS 

 

Step# Active Window Action 

1 Home page  

2 Admin  

3 Accruals Process Pay Cycle:  Select the Pay Cycle 

that you wish to run the accrual 

process for.  LATS will default to 

the users Pay Cycle. 

4  Run For:  Select All Employees. 

5  Click on the Select 'From Period' 

radio button. Available Pay 

Periods will display. 

6  Click on the earliest Pay Period 

that you want to run he accrual 

process for. 

7  Click on the Select 'To Period' 

radio button. Available Pay 

Periods will display. 

8  Click on the latest Pay Period that 

you want to run he accrual 

process for. 

9  Click the Run button. 

10  LATS will run the accrual process 

for Approved timesheets and then 
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the end user will land on the 

Status tab. 

 

For an individual employee 

 

To complete the accrual process for an individual employee: 

 

ADMIN > ACCRUAL PROCESS 

 

Step# Active Window Action 

1 Home page  

2 Admin  

3 Accruals Process Pay Cycle: Select 

ADMINISTRATION or 

INSTITUTION from the 

drop-down list. 

 

4  Run For: Choose SELECT 

EMPLOYEE from the 

dropdown list. 

 

5  Enter the full or partial name 

of the employee and click 

Search. 

6  Select the correct employee 

form the Select Employee 

drop down. 

7  Click on the Select 'From 

Period' radio button. 

Available Pay Periods will 

display. 

8  Click on the earliest Pay 

Period that you want to run he 

accrual process for. 

9  Click on the Select 'To Period' 

radio button. Available Pay 

Periods will display. 

10  Click on the latest Pay Period 

that you want to run he 

accrual process for. 

11  Click the Run button. 

12  LATS will run the accrual 

process for Approved 

timesheets and then the end 

user will land on the Status 

tab. 
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The accrual process will run and the Process Status screen will be displayed. You may need to 

refresh data to display the Process Complete message. Any timesheets that did not successfully 

process will be displayed by clicking the VIEW EXCEPTIONS link on the Status tab.  

 

To view exceptions, click on the View Exceptions link, Select Pay Cycle, Fiscal Year From, 

Fiscal Year To, From Pay Period and To Pay Period and then click the View Exceptions button. 

 

Accrual Processing Errors 
 

Following is a list of “common” error messages that may be displayed in “View Exceptions”: 

 

Overcharge-adjustment NOT successful 

Indicates an overcharge occurred. Generally should not happen, as this should be trapped before a 

timesheet is approved. However, if a retroactive adjustment was applied to reduce a balance, an 

overcharge could be trapped in the accruals process. This would prevent any unprocessed 

timesheets from processing even if they don’t display an error. 

 

How should I fix this? 

 

Review timesheets to determine where the error occurred. 

If the adjustment is correct, reset the timesheets, have the employee correct the timesheet that has 

the overcharge error and resubmit.  If the adjustment was not correct, create a second adjustment 

to offset the incorrect one and then recreate the adjustment on the correct timesheet. 

 

Date Missing-Timesheet Rejected 

Missing vacation or personal leave date. The report will indicate which one is missing. 

 

How should I fix this? 

 

Reverse the approval and submittal process and add the missing date. 

Have the employee resubmit, approve, and process. Be sure to add the date to the master record, 

either on the Edit Employee screen or on LATS ADMIN > ACCRUALS screen. 

 

Previous Timesheet was Not Processed 

A previous timesheet was not processed, so no subsequent timesheets will process. 

 

How should I fix this? 

 

Check for timesheets that have not been submitted and approved or that did not process for one of 

the other reasons listed in this section. Have the employee or supervisor complete the timesheet or 

correct the previous timesheet following instructions in this section. 

 

Timesheet Not Processed-Rule Missing 

An accrual rule is missing for the employee, based on their Negotiating Unit, hours per day, 

percent and/or possibly their years of service. The report will indicate which rule is missing. 

 

How should I fix this? 
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Check the Rules Maintenance tables to determine what rule is missing and add the rule following 

the instructions in “Rules Maintenance”. 

 

SQL Database error-Insert/Update 

This can occur if there is a data issue. 

 

How should I fix this? 

 

Contact LATS customer support on this issue. 

 

A previous Timesheet is missing (does not exist) 

A previous timesheet was not created (this, it is missing) for the employee. 

 

How should I fix this? 

 

Contact the employee and have them open, complete, save and submit the missing timesheet. 

Then contact the supervisor to approve the timesheet. 

 

Resetting the Accrual Process 
 

The accrual process may be “reversed” for all timesheets for one or more payroll periods or for an 

individual employee. This may be necessary if changes must be made to a timesheet once it has 

been processed. 

 

To reset the accrual process for an entire Pay Period: 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Accruals Process Click on the Accrual Reset Pay Period. 

4  Screen will display the “Last Processed Period”. 

5  Click RESET. The message “Reset a pay 

period. Do you wish to reset this entire Pay 

Period?” will display. Click OK to confirm. 

 

To reset the accrual process for an individual employee: 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Accruals Process Click Reset Timesheet.  

4  Enter full or partial employee name and click the 

Search button. 

5  Select the employee name from the drop down 

list. 

6  Select the appropriate Fiscal Year. 

7  Click Refresh Grid. 
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8  Select the appropriate Pay Period that you want to 

reset for that employee. 

9  Click the Reset button. 

10  Confirm the timesheet reset for the employee. 

 

 

Accrual Status – Process Tab 
 

The Status tab identifies the dates that the Accrual Process was run and provides the status of that 

process.   

 

The end user will have the ability to View Exceptions of timesheets that did not process when the 

Accrual Process was run.  To View the Exceptions perform the following steps: 

 

Step# Active Window Action 

1 Home Page  

2 Admin  

3 Accruals Process Click on the Status tab. 

4  Click on the View Exceptions link. 

5  Select the appropriate Pay Cycle from the drop 

down. 

6  Select the correct FROM Fiscal Year and the 

appropriate FROM Pay Period. 

7  Select the correct TO Fiscal Year and the 

appropriate TO Pay Period. 

8  Click the View Exceptions button. 
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Chapter 9:  LATS Payment Interface 
 

Topics Discussed In This Chapter: 

 

 Transmit 

 Payment Audit 

 Payment Transmit Status 

 Hourly Payments 

 Hourly Status 

 Payment Splits 

 HRISnet Payment Report 

 HRISnet Payment Processing 

 

The purpose of the LATS Payment Interface is to move payment transactions from LATS 

processed timesheets into HRIS’ payment interface for processing in HCM or HRISnet.  

Alternatively, the interface can be configured to transmit payments via an encrypted file directly 

to PayServ. 

 

Payment records are created in LATS when a timesheet is processed by running the Accruals 

Process.  The accruals process looks for all approved timesheets, applies time and attendance 

rules, updates master accrual balances, and writes payments claimed on a timesheet to a holding 

table. 

 

A user must be in the Time Records role to run the payment interface.  Conceptually, the 

interface works as follows: 

 

1. Accruals Process is run against all approved timesheets for a selected pay period.   

 

2. Timesheets with Overtime, Meals and PT Extra Time will have payment records written 

to a holding table in LATS.  

 

3. Any miscellaneous payments defined by the agency (IIP, Haz Duty, Holiday Pay etc.) 

and recorded by an employee will also have payment records written to a holding table in 

LATS. 

 

4. The holding table continues to accumulate payment records until a user transmits them to 

HCM or HRISnet (or PayServ) for payment processing. 

 

5. If a timesheet is re-processed in LATS (Reset and re-processed) and the existing payment 

record(s) has not been transmitted, it will be overwritten. 

   

6. If the existing payment record has been transmitted, it will not be re-written to the LATS 

holding file.  Any changes to that payment amount must be manually adjusted in HRISnet, 

HCM or PayServ. 
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Payment Transmit 
 

 

This option sends all payments marked as New or Ready to HRISnet,  HCM, PayServ or another 

Legacy payroll system.  To transmit payments the admin will need to select options for the 

following fields: 

 

Step# Active Window Action 

 Home Page  

 Admin  

  Owning Agency: Select the 

appropriate owning agency to be 

identified in the payment file. **Not 

included in the Export Type = HCM. 

 

  Pay Cycle: Select the appropriate pay 

cycle to be included in the payment 

file. 

 

  Submit Into:  This is a read only 

informational field. 

 

  Agencies:  List of agencies that have 

payments available to transfer.  Select 

the agency on the left and click the 

appropriate > to move one agency or 

>> to move all agencies. 

 

  Click the Transmit button to create 

the payment file to be transmitted. 
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Payment Audit 
 

This allows a time records user to review and edit payment records that have been claimed by 

employees and generated by the LATS Accruals Process.  Payment data can be edited, or specific 

payment records can be denied.  All changes are written to an audit table. 

 

When clicking on the name link, the audit detail page is displayed, where the payment can be 

edited or the record status can be changed to ‘Denied’ – which will prevent the payment from 

being transmitted. 

 

 

Step# Active Window Action 

 Home Page  

 Admin  

 Payment Audit Filter By: Options are All 

Employees, Employee or Payment 

Code. Changing the filter to 

Employee brings up a search box to 

enter employee name to search for 

employee. Changing the search filter 

to Payment Code will display a 

dropdown that contains all applicable 

payment codes to select from. 

  Pay Cycle: Select the appropriate pay 

cycle. 

  Fiscal Year: Select the appropriate 

fiscal year. 

  Pay Period:  Select the appropriate 

pay period.  Pay period dates are set 

by the pay cycle selected. 

  Record Status: Options are All, 

New, Ready to Transmit, 

Transmitted, Deny Payment. 

 

Once a record has been filtered the end user can click on the employee name and this will bring 

up the payment audit window displayed below.  The following fields can be modified in the 

payment audit window prior to the payment transmit. 

 Earnings Code 

 Record Status – New and Ready to Transmit will send the payment.  If the record 

is set to Deny Payment the payment will not be sent out of LATS and will remain 

in the payment audit table. 

 First Date 

 Last Date 

 Amount 

 Hours 

 Days 

 Audit Comments 
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Payment Transmit Status 
 

The Payment Transit Status tab displays an Event Log of all payment transmits run in LATS.  

The status page provides the Date, Description and Status.  If the payment interface is run and the 

Status equals Processed with Errors you should contact the CMA LATS Help Desk at 518-783-

9003 immediately for issue triage and resolution. 

 

Hourly Payments 
 

The Hourly Payment interface can send hourly payments to HCM, HRIS, PayServ or a Legacy 

payroll system.  To send hourly payments the LATS admin should perform the following tasks. 

 

Step# Active Window Action 

 Home Page  

 Admin  

 Payment Interface – Hourly 

Payments 

Select the agency to transfer 

or select All Agencies. 

  Pay Cycle: Administration or 

Institution 

  Fiscal Year 

  Pay Period 

 

Hourly Status 

 

The hourly status page shows the Date, Description and Status of the hourly payment transmit. 

Please call the CMA LATS Help Desk at 518-783-9003 if the payment transmit status is 

Processed with Errors. 

 

Payment Splits 
 

OSC requires the hours be split into separate RGH, OTK and PS4 payments if a rate change 

occurs within the pay period.  If an employee receives a rate change within the pay period, 

separate RGH payments must be created.  The first payment should have an earnings begin date 
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for the first day of the pay period (or the first day that the employee claimed hours within the pay 

period at the initial rate) and an earnings end date one day before the effective date of the rate 

change (or the last day that the employee claimed hours within the pay period at the initial rate). 

The second payment should have an earnings begin date equal to the effective date of the rate 

change (or the first day that the employee claimed hours after the effective date of the rate 

change) and an earnings end date of the last day of the pay period (or the last day that the 

employee claimed hours after the rate change).  The LATS Hourly Processing module now 

includes a Payment Split tab to manage these payment splits.  The end user should perform the 

following steps to create a payment split: 

 

Step# Active Window Action 

 Home Page  

 Admin  

 Payment Interface – Payment 

Split 

Select the employee’s 

agency. 

  Pay Cycle: Administration or 

Institution 

  Select the Pay Period Year 

  Select the Pay Period 

  Select the Split Date (Start 

Date of the second payment) 

  Employee (optional) 

  If there are payments 

available to split, LATS will 

display them and the end user 

will have a Split Payments 

button enabled. 

 

 
 

 

HRIS Payment Report 
 

This report reads data from the LATS payment holding table.  The report data is sorted by 

division, employee and pay period.  The report is launched from the LATS reporting module. 

 

Selection includes:  

a. Pay Year & Period 

b. Payment Status  
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 N=New – written to the payment holding table by the accruals process.  

 R=Ready – Selected for transmission to HRIS but not yet transmitted, or selected 

but the transmission failed. 

 T=already transmitted to HRIS. 

 Null = all status for the selected pay period. 

 

 
 

 

HRISnet Payment Processing 
 
The HRISnet - LATS Payroll Adjustment Interface accepts payment records created from the 

LATS application and performs the processing so the payments are included with the other 

payroll activity for a given agency code and pay period, and can be sent in one submission to 

PayServ.  The results become part of an employee's payroll adjustment in HRISnet. 

 

Once the records are transmitted to HRISnet, they remain in a holding file in HRISnet.  Users must 

go thru the Pay Adjustment Interface option in HRISnet.  The Pay Adjustment Interface page will 

be displayed. 
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The processing flow essentially follows the enabled links on this page.  Please be sure that you 

have the correct processing pay period and agency code set at the top of the screen.  The 

processing pay period is the pay period that will be submitted to PayServ.   

Through all of the processing stages, the highlighted links will indicate the next course of action 

to take.  The options are summarized below: 

 

Change the processing pay period and/or agency code.   

 

IMPORT: Records from a file transferred to the HRISnet server.  The data records will generally 

contain adjustments for the timesheet period(s) PRIOR to the indicated processing pay period.  

This only applies IF data is being fed from external systems other than LATS. 

 

EDIT: Performs edits the payment records against the HRISnet database, verifying SSN, Item 

number, hour increments and other information.  Since the records originated in LATS, there 

should be no discrepancies.  An adjustment must pass these edits before payment is generated. 

 

CORRECT: Finds any erroneous or miss-assigned employee records and allows corrections to be 

made.  Any corrections must be re-edited by running the EDIT before payments are generated. 

 

GENERATE: Posts the payment records to the employees pay adjustment history and readies 

them for transmission to PayServ via the Miscellaneous payment file. 
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Chapter 10:  Scheduling 
 

Topics Discussed In This Chapter: 

 

 Introduction to Scheduling 

 Working with Shifts 

 Working with Rotations 

 Working with Rotation Groups 

 Working with Schedules 

 

Introduction to Scheduling 

 
The scheduling module allows your agency to create work schedules which determine some of 

the rules used by LATS when checking employee timesheets. 

 

When LATS is installed at your agency, it includes several basic shift types, which include a set 

of rules regarding employee timesheets. You cannot create new shift types or modify these shift 

types, but you can use the Web interface to learn about each of them. 

 

In the scheduling interface, you can create lunch shifts which define a start and end time for mid-

shift breaks. 

 

The shift types and lunch shifts are combined to create shifts, which are specific to your agency. 

A shift includes starting and ending time ranges, and can make use of a defined lunch shift, but no 

lunch shift is required when you create a shift. 

 

After creating shifts for your agency, you can then create rotations, which define which shift is to 

be used for each day of a pay period, including Pass days. 

 

When all rotations for your agency have been defined, you then assign employees to the rotations. 

You can assign employees to the rotations in a variety of ways: 

 

• By Division 

• By Bureau within Division 

• By Section within Bureau within Division 

• By Negotiating Unit 

• By Supervisor 

• Individually 

 

Additionally, for each individual you have the ability to create an alternate rotation which can be 

applied only for a given pay period. 

 

Working with Shifts 

 

This section covers the following scheduling procedures: 
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• “Examining Shift Types” explains how to obtain basic information about each of the 

shift types included in your LATS installation. 

 

• “Creating Lunch Shifts” explains how to create lunch shifts which will be specific to 

your agency. 

 

• “Examining Defined Lunch Shifts” explains how to examine the specifics of currently 

defined shifts. 

 

• “Creating a New Shift” explains how to combine shift types, lunch shifts, and start and 

end times to create a series of shifts which will be specific to your agency. 

 

• “Deleting an Unused Shift” explains how to delete a shift which is not assigned as part 

of any defined rotation. You may not delete a shift which is in use as part of a rotation. 

 

Examining Shift Types 
 

Shift types determine policies such as rounding and flex time. This procedure will help you 

become familiar with the characteristics of the shift types included in your LATS installation. 

 

SCHEDULING > ADMINISTRATION 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click SHIFT TYPES tab. 

4  The Shift Types window 

shows all the shift types 

which 

have been included in your 

LATS installation. 

5  To display a detailed 

explanation of a particular 

shift type, click the Short 

Description field for that 

type. 

 

 
 

To find out what lunch shifts have already been defined for your agency and what the 

specifics of those shifts are: 

 

SCHEDULING > ADMINISTRATION 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click LUNCH SHIFTS tab. 
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4  To see all the available lunch 

shifts click the Search button.  

If you know the name of a 

specific lunch shift you are 

searching for enter the name 

in the description text box and 

click the Search button. 

5  This displays the current 

lunch shift configuration. 

 

 

Creating Lunch Shifts 
 

The use of lunch shifts allows LATS to check the timesheet of a Time In/Time Out employee to 

ensure that the reported Lunch Out/Lunch In pairs are within agency guidelines. Lunch shifts also 

allow LATS to calculate the correct hours for the each day (7.50 vs. 8). 

 

To create a lunch shift: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Lunch Shift tab 

and then click the ADD tab. 

4  Select the appropriate agency 

from the dropdown list or 

leave the agency setting to ---

ALL---. Leaving the agency 

set to ALL will allow the 

lunch shift to be available to 

all agencies. 

5  Short Description: A one- to 

10-character descriptive 

title for the lunch shift. 

6  Description: An informative 

description that more 

clearly defines the lunch hour 

than allowed in the Short 

Description. 

7  Start Time: Enter the time 

when the lunch shift begins, 

in HH:MM format. AM or 

PM is required. 

8  End Time: Enter the time 

when the lunch shift ends, in 

HH:MM format. AM or PM 

is required.  

9  Click Add. 
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Reviewing a Shift: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click SHIFTS tab. 

4  To see all the available shifts click the 

Search button.  If you know the name of 

a specific shift you are searching for 

enter the name in the description text 

box and click the Search button. 

5  Locate the shift you want to examine 

and click the 

Short Description field for that shift. 

6  When you have finished examining the 

shift, click CANCEL. 

 

Creating a New Shift 

 

A shift is a combination of an installation’s shift type and an agency-defined lunch shift, with 

start and end time periods added. Using a lunch shift is not required; when you create a shift, you 

may indicate that a lunch shift is not required. Shifts are used when creating rotations, which in 

turn are assigned to employees and used when LATS examines employees’ timesheets. 

 

To Create a New Shift: 
 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click SHIFTS tab. 

4  Click the ADD tab. 

5  Agency: Select the 

appropriate agency from the 

dropdown list or leave the 

agency setting to ---ALL---. 

Leaving the agency set to 

ALL will allow the lunch 

shift to be available to all 

agencies. 

6  Short Description: A one- to 

10-character for the shift. 

7  Description: Enter a 

description of the use of the 

shift. 

8  Grouping: This is a free 

form text field that can be 

used for reporting purposes.  

If an agency wishes to group 

all employees in a certain 
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department so they can run a 

report, they would assign all 

rotations to the same 

Grouping. 

9  Shift Type: From the drop-

down list, select which shift 

type this shift is associated 

with. Minimum Allowable 

Start Time: Enter the earliest 

time employees assigned to 

this shift are allowed to 

start work. The use of AM 

and PM is required. (Used 

when tied to Min2Min Flex 

Shift.) 

10  Start Time: Enter the normal 

time employees assigned 

to this shift start work. The 

use of AM and PM is 

required. 

11  Maximum Allowable Start 

Time: Enter the latest 

time employees assigned to 

this shift are allowed to 

start work. The use of AM 

and PM is required. (Used 

when tied to Min2Min Flex 

Shift.) 

12  Minimum Allowable End 

Time: Enter the earliest 

time employees assigned to 

this shift are allowed to 

leave work. The use of AM 

and PM is required. (Used 

when tied to Min2Min Flex 

Shift.) 

13  End Time: Enter the normal 

time employees assigned 

to this shift leave work. The 

use of AM and PM is 

required. 

14  Maximum Allowable End 

Time: Enter the latest time 

employees assigned to this 

shift are allowed to leave 

work. The use of Am and PM 

is required. (Used when 

tied to Min2Min Flex Shift.) 
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15  Auto deduct Lunch: If set to 

Yes you will be required to 

enter a lunch shift. 

16  Minimum Hours Worked: 
enter the number of hours to 

be worked before the lunch is 

auto deducted. 

17  Maximum Allowable End 

Time: Enter the latest time 

employees assigned to this 

shift are allowed to leave 

work. The use of Am and PM 

is required. (Used when 

tied to Min2Min Flex Shift.) 

 

Deleting an Unused Shift 

 

To delete a shift which has not been assigned as part of a defined rotation: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click SHIFTS tab and then 

the search tab. 

4  Click on the Short 

Description of the shift you 

wish to delete. 

5  Click the delete button. 

6  Confirm deletion of shift. 

 

Note:  LATS will not allow you to delete a shift which has been included in the definition of any 

Rotation.  

 

Working with Rotations 
 

This section covers the following rotations procedures: 

 

 “Creating Rotations” explains how to combine the various agency-specific shifts and 

apply them to each day in a pay period. 

 

 “Viewing Details of a Rotation” explains how to examine the shifts assigned to each day 

of a rotation. 

 

 “Deleting an Unused Rotation” explains how to remove a rotation to which no employee 

has been assigned. 

 

 “Assigning Rotations to Employees by Division” explains how to assign a selected 

rotation to all employees within a Division. 
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 “Assigning Rotations to Employees by Bureau” explains how to assign a selected rotation 

to all employees within a Bureau. 

 

 “Assigning Rotations to Employees by Section” explains how to assign a selected 

rotation to all employees within a Section. 

 

 “Assigning Rotations to Employees by Negotiating Unit” explains how to assign a 

selected rotation to all employees represented by a selected negotiating unit. 

 

 “Assigning Rotations to Employees by Supervisor” explains how to assign a selected 

rotation to all employees who are the direct reports to a selected supervisor. 

 

 “Assigning Rotations to Employees Individually” explains how to assign a selected 

rotation to an individual employee. 

 

 “Creating Alternate Rotations by Supervisor” explains how to create a custom rotation 

for selected employees who are direct reports of a selected supervisor and, 

 

 “Creating Alternate Rotations Individually” explains how to create a custom Rotation for 

a selected individual employee. 

 

Viewing Details of a Rotation 

 

To examine a currently defined rotation: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the ROTATIONS tab 

4  Click the Search button to return ALL rotations 

or enter the description or partial description of 

the rotation that you are searching for and click 

the Search button. 

5  Click the Short Description field for the 

rotation you want to review. 

 

Creating Rotations 

 

A rotation allows you to assign shifts to each day in a pay period, as well as to assign Pass days 

within the pay period. You may use a different shift for each day in the pay period, you may use 

the same shift for each day in the pay period, or you may decide to use whatever combination 

allows your agency to function effectively. Rotations are assigned to employees and are used by 

LATS when examining employee timesheets. Rotations also act as a schedule template. 

 

To Create a New Rotation: 

 

Step # Active Window Action 

1 Home Page  
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2 Scheduling  

3 Administration Click the ROTATIONS tab. 

4  Click on the Add tab. 

  Agency: Select the agency from the agency 

dropdown or select –ALL—if the rotation 

should be available to all agencies. 

5  Rotations (Edit) Short Description: Enter a 

one- to 10-character title for the rotation. 

6  Description: Enter a description of the use of 

the rotation. 

7  Rotation Period: From the drop-down list, 

select an indication of the length of time the 

rotation covers. 

Choices are 1-week, 2-week, 4-week and 7-

week. 

 

8  Timesheet Data: You may choose to pre-fill 

employee timesheets based on a Planner or 

Rotation. LATS will default to: DON'T PRE-

FILL TIMESHEET. Pre-fill from Planner will 

complete timesheets for all employees in that 

planner with the hours selected for that planner 

when it is posted. Pre-fill from Rotation will 

complete timesheets for all employees in that 

rotation with the hours selected for that rotation. 

Necessary changes may be made to pre-filled 

timesheets. Example: Employee works overtime 

or charges time to accruals.  

If you choose to pre-fill, click in Radio button 

before Prefill timesheet from Planner or Pre-fill 

timesheet from Rotation. 

9  Rotation Group Code: This field applies to the 

planner. All employees tied to a Rotation Group 

will be grouped together on the planner. LATS 

defaults to NONE. 

10  Enforce Comp Time Edit on Submit: If your 

organization requires time in/time out entries to 

round to or to be entered on the quarter hour, 

this field must be set to Y. Setting this field to 

N will prevent Comp time Error from being 

displayed on timesheets and will allow 

employees to submit their timesheets regardless 

of daily or  timesheet total hours. 

11  Default Shift Type:  This field tells LATS what 

type of rounding to apply to punches if the 

employee is working outside of their shift or on 

a pass day when there is no shift assigned to 

that day. 
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12  For each day in weeks 1: From the drop-down 

list, select the shift employees assigned to this 

rotation will work during week 1.  **Note: 

repeat the same process for weeks 2, 3, 4, 5, 6 

and 7 if applicable. 

13  Click SAVE. 

 

 
7 Week Rotations 

 

The LATS Rotations feature now accommodates a 7 week (49 day) rotation. You can create a 

Rotation by going to Scheduling > Administration, clicking the Rotations tab, and clicking Add. 

 

 
 

 

Deleting an Unused Rotation 

 

LATS will not allow you to delete a rotation to which any employee has been assigned. 

 

To delete an unused rotation: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the ROTATIONS tab. 

4  Locate the rotation you want to delete. 

5  Click the Short Description field for 

that rotation. 

6  Click DELETE. LATS will display an 

alert asking if you want to delete the 

rotation. Click OK to confirm. 
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Assigning Rotations to Employees by Division 

 

This procedure allows you to assign a selected rotation to all employees in a division: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Assign Rotations by: Select DIVISION 

from the dropdown list. 

5  Agency: From the drop-down list, 

select the agency with which you want 

to work. The screen will re-display. 

6  Division: From the drop-down list, 

select the division with which you want 

to work. 

7  Assign to Rotation: From the drop-

down list, select the rotation to which 

you want to assign all employees of 

the selected division. 

8  Click ASSIGN 

 

 

Assigning Rotations to Employees by Bureau 

 

This procedure allows you to assign a selected rotation to all employees in a bureau: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Assign Rotations by: Select BUREAU 

from the dropdown list. 

5  Agency: From the drop-down list, 

select the agency with which you want 

to work. The screen will re-display. 

6  Division: From the drop-down list, 

select the division with which you want 

to work. 

7  Bureau: From the drop-down list, 

select the bureau with which you want 

to work. 

8  Assign to Rotation: From the drop-

down list, select the rotation to which 

you want to assign all employees of 

the selected bureau. 

9  Click ASSIGN. 

 

Assigning Rotations to Employees by Section 
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This procedure allows you to assign a selected rotation to all employees in a bureau: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Assign Rotations by: Select SECTION 

from the dropdown list. 

5  Agency: From the drop-down list, 

select the agency with which you want 

to work. The screen will re-display. 

6  Division: From the drop-down list, 

select the division with which you want 

to work. 

7  Bureau: From the drop-down list, 

select the bureau with which you want 

to work. 

8  Section: From the drop-down list, 

select the bureau with which you want 

to work. 

9  Assign to Rotation: From the drop-

down list, select the rotation to which 

you want to assign all employees of 

the selected bureau. 

10  Click ASSIGN. 

 

Assigning Rotations to Employees by Rotation 

 

This procedure allows you to reassign a selected rotation to another rotation: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Assign Rotations by: Select 

ROTATION from the dropdown list. 

5  To see employees that will be moved 

from one rotation to the other click on 

the View Employees button. 

6  If you choose to assign an employee to 

a different rotation in this window, 

select the appropriate new rotation from 

the Rotation dropdown which will 

automatically check the Assign rotation 

box and click Assign. 

7  If you choose to just reassign all 

employees then just select the new 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 10: Scheduling, 174 of 233 

rotation and click assign on the main 

page. 

 

 

Assigning Rotations to Employees by Supervisor 

 
This procedure allows you to assign a selected rotation to all employees whose timesheet is 

approved by a selected supervisor. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Select SUPERVISOR from the drop-

down list. 

5  Enter the name of the supervisor whose 

employees you want to assign a rotation 

and click search. 

6  From the list, click the name of the 

supervisor whose employees you want 

to assign a rotation. 

7  Assign to Rotation: From the drop-

down list, select the rotation to which 

you want to assign all the listed 

employees. 

8  Click ASSIGN. 

 

 

Assigning Rotations to Employees Individually 

 
On occasion, you will need to change an individual employee’s rotation.  
 

Step # Active Window Action 
1 Home Page  
2 Scheduling  
3 Administration Click the EMP ROTATIONS tab. 
4  Employee name: Enter the last name of 

the employee to whom you want to 

assign a rotation. 
5  On the list of employees whose last 

names match the name you entered, 

locate the employee to whom you want 

to assign a rotation. Click the 

employee’s name. 
6  Assign to Rotation: From the drop-

down list, select the rotation to which 

you want the employee assigned. 
7  Click ASSIGN. 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 10: Scheduling, 175 of 233 

 
 

 

 

Creating Alternate Rotations Individually 

 
To create an alternate rotation for a given pay period for a selected employee, using the employee 

name to locate the employee. This option is disabled if your organization is using Schedule. 
 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click the EMP ROTATIONS tab. 

4  Employee Name: enter the employee 

name you want to make the pay period 

exception rotation for and click Search. 

5  Click on the Employee Name on the 

search results screen. 

6  Click on the Employee Rotation link. 

7  Click on the Create Exception radio 

button. 

8  Fiscal Year: From the drop-down list, 

select the fiscal year in which the 

alternate schedule will be in effect. 

9  Pay Period: From the drop-down list, 

select the pay period in which the 

alternate schedule will be in effect. 

10  Week 1 Shifts: For each day in the first 

week of the pay period, select the 

appropriate rotation from the dropdown 

list. 

11  Week 2 Shifts: For each day in the 

second week of the pay period, select 

the appropriate rotation from the drop-

down list. 

12  Click Create New Schedule. An alert 

box will display, asking you to confirm 

that you want to create an alternate 

schedule for the selected employee for 

the indicated pay period. 

13  Click OK to confirm. 
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Working with Rotation Group 
 

The Rotation Group tab is used to create the options that you see in the Grouping dropdown on 

the Rotation page.  To create a Grouping perform the following steps. 

 

Step # Active Window Action 

 Home Page  

 Scheduling  

 Rotation Group Click the Add tab. 

  Enter a Group Code. 

  Enter a Description 

  Click Add 

 

Working with Schedules 
 

An additional function of the Scheduling Module is the creation of Schedules. This administrative 

tool enables creation and management of employee schedules. 

 

Schedules may be submitted for approval before posting. This step will be controlled by your 

organization's work flow and policies. Schedule’s functionality allows creation of routine 

schedules by Agency/Division/Bureau/Section (Agency/Troop/Zone/Station), but also allows 

supervisors to: 

 

• Make specific changes to schedules to ensure adequate coverage is available for individual 

sections and shifts. 

 

• Manage employee leave and additional time. 
 

Creating a New Schedule 

 

A Schedule is created for an individual section/station. All employees assigned to the 

section/station will appear on the schedule. Schedules may be accessed by other schedule users 

(view only), and by the supervisor and alternate supervisors for that section/station (view and 

edit). 

 

A Payroll Period selector is also available to allow the scheduler to navigate to a specific payroll 

period. Schedules are created in a “worksheet” mode and status will be displays as “worksheet”. 

Organizational work flow may require the creation, approval and posting of a schedule within a 

designated time frame. It may also require that schedules be submitted for approval prior to 

posting. Organizations must enforce their policies through the work flow process. LATS will not 

enforce any time frames and it will allow a schedule to go from Worksheet to Posted in one step. 

LATS will not pre-fill timesheets until the schedule is Posted. 

 

The Schedule Worksheet will allow changes to an employee’s schedule on an as-needed basis. Each 

day of an employee’s 28-day schedule will show two rows. The top row is for a full shift of leave and 

the second row is for the shift the employee is assigned to for that day. Worksheets will be pre-filled 

from the employee’s rotations, but will allow direct changes to the shift or entry of leave without a 

pop-up list. Leave codes are built from miscellaneous leave codes tied to system leave categories. 
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Shifts are built from the shifts defined on the shift tab. LATS will edit leave types and shifts. If an 

invalid leave type or shift is entered, a Select box appears an displays all of the available codes or 

shifts. Codes/shifts are selected by clicking them. Colored error codes display at the bottom of the 

worksheet. If you bypass the Select box, the invalid cell is highlighted, based on the color legend at the 

bottom of the worksheet. You may also right-click the cell to display the list of valid codes and shifts. 

 

The schedule also provides a summary of shift coverage indicating number of available employees for 

each shift and a Schedule Day View that features a graphical view of coverage for all hours scheduled. 

 

To create a New Schedule Worksheet: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Schedule tab. 

4  Click on the Add tab. 

5  Use the <prev and next >  arrows to get to the 

correct pay period. 

6  Agency: Select the required agency from the 

drop-down list. 

7  Division: Select the required division from the 

dropdown list. 

8  Bureau: Select the required bureau from the 

drop-down list. 

9  Section: Select the required section from the 

drop-down list. 

10  If desired, click PREVIEW to view the 

schedule before saving. Note: Changes cannot 

be made to a schedule before it is saved. This is 

a view only screen. Click CLOSE when 

finished previewing. 

11  If the schedule is accurate, click SAVE 

SCHEDULE. The schedule will be given the 

status of “Worksheet”. The schedule screen 

indicates schedule status, User and 

number of days until schedule is in current 

status. 

12  Note: Timesheets that are pre-filled from the 

schedule will not populate until the schedule 

status is "posted". 
 

LATS allows agencies to set up workflow properties that will limit a schedule user to creating 

and editing schedules for the Rotation they are assigned to. 

 

Example 

 

Schedule User 1 is assigned to Division A, Bureau B, Section C. Schedule User 1 will be limited 

to creating schedules for employees that are also assigned to Division A, Bureau B, Section C but 

will have view access to other schedules. 

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 10: Scheduling, 178 of 233 

 

Submitting a Schedule for Required Approval 
 

Based on your organization's work flow you may be required to submit a schedule for approval 

before it is posted. No edit rules are enforced by LATS on how schedules are approved or who is 

authorized to approve a schedule for your organization. 

 

To submit a schedule for approval: 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Schedule tab. 

4  Locate the existing worksheet for the timesheet 

period. 

5  From the drop-down lists, choose 

Agency/Division/Bureau/Section and click 

REFRESH. 

6  A list of schedule periods for that group will 

display. 

7  Determine which Schedule Period you want to 

submit for approval. 

8  Click EDIT on the line for the schedule you 

want to submit. 

9  From the drop-down list, select SUBMITTED. 

10  Click UPDATE STATUS. The schedule will 

remain in “Pending Approval” status until it is 

approved and “Posted”. 

 

Note:  A worksheet may also be submitted when shift and leave edits are completed by clicking 

SUBMIT WORKSHEET on the bottom of the open worksheet. Status will be updated to 

Submitted. 

 

Posting a Schedule After Review is Complete and Approved 

 
Organizational policies or Negotiating Unit contracts may dictate the time line for Posting a Schedule. A 

schedule may be posted immediately if none of these apply. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on Edit on schedule line and 

choose Post. When Schedule is posted, 

timesheet will pre-fill employee 

timesheets if Rotation “Time Sheet 

Data” indicates “prefill from schedule”. 

4  Change the Status dropdown to Posted. 

5  Click Update Schedule. 

6  Click Ok. 
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Reviewing Existing Schedule Periods 

 
Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Scheduling tab. 

4  Locate the existing schedule for the 

timesheet period: From the drop-down 

lists, choose Agency/ Division/ Bureau/ 

Section, and click REFRESH. 

5 Schedule 

Periods 

Click on the dates for the schedule period 

you want to review. 

6 Schedule To review coverage for an individual day, 

click on that date at the top of the 

schedule. 

7 Schedule Day 

View 

You can review all available coverage for 

date selected. 

 

 

Making Shift Changes, Adding Additional Time or Leave, or Creating Special 

Assignments for an Existing Schedule Period 

 
Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Scheduling tab. 

4  Locate schedule. 

5  Click on schedule period that requires 

adjustment. 

6  Click on the shift for the employee 

7  Make any needed changes or corrections 

to the day, date, and current schedule. The 

changes will take effect on the day 

displays. 
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Changing a Shift for an Individual Employee in an Existing Schedule 
 

Example  

 

Employee’s normal schedule is 8:00AM to 4:00PM. Additional coverage is required for 4:00PM 

to 12:00 PM shift due to a special event. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Scheduling tab. 

4  Locate schedule 

5  Click on schedule period that requires 

adjustment. 

6 Schedule Click on the shift for the employee 

7  Make any needed changes or corrections to 

the day, date, and current schedule. The 

changes will take effect on the day displays. 

8  From drop-down list, choose the new Shift 

Assignment. 

9  LATS defaults to CHANGE SCHEDULE 

THIS DATE, but if multiple days are 

required, click CHANGE SCHEDULE BY 

RANGE and, from the drop-down list, select 

the end 

date. Only days that fall within the schedule 

period will be displayed for selection. 

10  LATS defaults to RESPECT PASSDAYS. 

Employee's current Pass days will not be 

changed for the new Shift Assignment. 

11  Click off the check mark in box if change is 

required to current Pass days during the new 

Shift Assignment. 

12  Click UPDATE SCHEDULE. 

 

Note:  Shift changes may also be completed using the Search/Reassign function under 

Scheduling. 

 

Adding Additional Time for an employee 
 

Example  

 

An accident occurs or machinery breaks down and the employee must work past normal shift end. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Click on the Scheduling tab. 

4  Locate schedule 
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5  Click on schedule period that requires  

adjustment. 

6  Click on the shift for the employee 

7  Click the ADDITIONAL TIME tab. 

8  From the drop-down list, choose the Reason for 

additional time. 

 

Click in the Recall box if payment type falls in 

a Recall category. This is an informational 

setting only. This field has no effect on the 

scheduling or editing process but may be 

included in  information for ad hoc reporting. 

 

Enter "Start" time 

 

Enter "End time" or click the radio button 

before Amount (Hrs.) and enter the number of 

hours approved. 

 

Enter information in Narrative if appropriate. 

9  Click SAVE and CLOSE. 

 

Adding Leave for an employee 
 

Example 

 

An employee requests a vacation day using available accruals. 
 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Locate schedule. 

 

Click on schedule period that requires 

adjustment. 

4  Click on the shift for the employee 

5  Click the LEAVE tab. 

6  From the drop-down list, select the 

appropriate miscellaneous leave code. 

7  LATS defaults to ADD LEAVE THIS 

DATE. If multiple days are required, 

click the radio button before add leave 

by range and, from the drop-down list, 

choose the end date. Only days that fall 

within the schedule period will be 

displayed. 

8  LATS defaults to employee’s scheduled 

Start and End times. Click in the field 

and change times as required or enter 
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start time and click the radio button in 

front of Amount (hrs.) and enter 

number of hours requested. 

9  Click SAVE and CLOSE. 

 

 

Multiple entries may be completed for the same day and leave code. Multiple entries to a single 

miscellaneous leave code will be displayed in total for each day on the timesheet. If the employee 

does not have sufficient leave credits for this entry, an edit error will be flagged. 

 

The 28-day time period schedule will now display colored background bars to indicate leave and 

additional time instances for employees. 

 

Note:  Additional Time and Leave may also be added using the Leave/Addtl function in 

Scheduling. Additional Time and Leave instances added on the Schedule will transfer to the 

timesheet. Extra ins and outs will be populated, miscellaneous leave lines will be created on the 

timesheet and number of leave hours will fill in on the day and miscellaneous leave line. 

 

Employees may view their schedule from their timesheets but details are not displayed. It is a 

read-only function. 
 

Designating a Special Shift Assignment for an employee 

 

Example  

 

An employee is assigned for a two week period to represent the agency at a State 

Fair. Employee will be assigned to a different shift for the length of this assignment. 
 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Locate schedule. 

 

Click on schedule period that requires 

adjustment. 

4 Schedule Click on the shift for the employee 

5 Change Shift Click the SPECIAL ASSIGNMENT tab. 

6 Schedule Details Click the drop-down list to find all special 

assignments previously assigned to the 

employee. 

7 Schedule Details To add a new special assignment, click ADD 

NEW at the bottom of the screen. 

8 Schedule Details Enter the information in the Description field. 

9 Schedule Details Start date defaults to date currently selected on 

schedule. If required, change Start date by 

manually entering the date or choosing the date 

from the calendar. 

10  Manually enter or choose End date from the 

calendar. 
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11  Select shift assignment from the drop-down list. 

12  If required, choose TDS category and/or TDS 

Task. 

13  Click SAVE AND CLOSE. SA appears on 

schedule under appropriate employee/day(s). 

 

 

 

Deleting a Special Assignment 

 
Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Locate schedule. 

4  Click on schedule period that requires 

adjustment. 

5 Schedule Click on the shift for the employee 

6 Change Shift Click the SPECIAL ASSIGNMENT tab. 

7 Special 

Assignment 

Click DELETE at the bottom of the page. 

8  Click SAVE AND CLOSE. 
 

Note:  Only changes to scheduled hours may be completed through the Special Assignment tab. 

Changes to Agency/Division/Bureau/Section are completed using the SCHEDULING > 

SEARCH/Reassign function. 

 
 

Reassigning an Employee to a Different Agency/ Division/ Bureau/ Section on a 

Temporary or Permanent Basis 
 

Example  

 

Employee is transferred or promoted to a different unit under a new Supervisor. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Locate schedule. 

4  Click on schedule period that requires 

adjustment. 

5  Click on the shift for the employee 

6  Click SEARCH/REASSIGN. Under search 

function, enter the name of the employee to be 

reassigned. Click SEARCH. Choose employee 

from list by clicking on the name. 

7  LATS defaults to the current date. Click the 

calendar to select a different start date. If the 

assignment is temporary, click the calendar to 

choose Assignment End Date. If assignment 
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is permanent or open-ended, leave the 

Assignment End Date field blank. 

8  From the drop-down list, select the new 

Agency/Division/Bureau/Section. Click 

REASSIGN. The confirmation message “Are 

you sure you want to reassign 

this employee?” will display. 

9  Click OK to complete the re-assignment. 
 

Note:  Agency/Division/Bureau/Section in Admin/Appointments is automatically updated with the 

new assignment information. 

 

Deleting an Unused Schedule 
 

LATS will not let you delete a schedule period if any authorized leave is associated with that 

schedule period. All leave for a schedule period must be deleted before the period can be deleted. 

 

Step # Active Window Action 

1 Home Page  

2 Scheduling  

3 Administration Locate schedule. 

4  Click on schedule period that 

you want to delete. 

5  Click DELETE. An “Are you 

sure you want to delete this 

schedule?” confirmation will 

display. 

6  Click OK. 
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Chapter 11:  Standard Security Roles and Settings 
 

The following Security Roles are supplied with the initial installation of LATS: 

 

Security Role Access 

User Access to their timesheet only, with create and 

submit rights. 

Time Records Full (Read/Change) access to all employees 

balances, attributes and timesheets.  Access to 

the Rules tables.  Access to the accruals 

process and payment interface.  Ability to 

enter new employees directly into LATS.  

Ability to assign timekeepers, supervisors and 

delegates. 

Personnel Read only access to all employee timesheets. 

Maintenance Access (create/change) to the rules and code 

table maintenance pages. 

Security Access to the security page in LATS - ability 

to assign user id's, reset passwords and assign 

security roles. 

Supervisor Read Access to the direct reports and alternate 

reports timesheets for review and approval. 

Schedule Administrator Access (create/change) to the scheduling 

administrative functions 

(Shifts/Rotations/Employee Rotations) 

Schedule Planner Administrator Access (create/change) to the scheduling 

planner module for the appropriate division or 

bureau the employee belongs to.  Access to 

Search/Reassign, Supervisor Schedules. and 

Leave/Addtl Time. 

NOTE: the combination of Planner and Time 

Records allows the user to administer 

(create/delete/modify) schedule planners 

agency wide. 

Cost Query Access to the Cost Query pages contained in 

the Cost Process Module.  Ability to create 

and change queries to the cost data. 

Finance Access to all functions of the Cost Process 

Module.  Ability to create and run a cost 

process and publish the results. 

TDS Unlock If configured, gives the user the ability to 

unlock an employee’s TDS entries after a 

timesheet has been processed, then reset.  This 

requires an extra step to monitor TDS changes 

after timesheets have been processed. 

TDS Master Access (create/change) to the TDS 

category/task/subtask maintenance tables.  

Ability to create and maintain for agency 

wide. 
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TDS Coordinator Access (create/change) to the TDS 

category/task/subtask maintenance tables.  

Ability to create and maintain for specific 

division(s). 

Delegate Allows an employee to review assigned 

employee timesheets on behalf of their 

supervisor.  Does not allow the timesheets to 

be marked approved, just reviewed. 

Timekeeper  

 

Security Roles Menu and Non Menu Pages 

 

Security Role Menu/Non Menu Pages 

User Home, Timesheet, My Timesheet, Admin, 

Change Password, Subtasks, Schedule Search, 

Audit (Timesheet), Employee Notification, 

HRA Timesheet Report, Misc. Leave Balance, 

Misc. Leave Tab, OT Payment Print, Overtime 

Payments, Overtime Payments Audit, 

Print.aspx, Project Search Results, Schedule 

Day View, Schedule Detail, Schedule Roster, 

Schedule Roster Days, Schedule Roster Print, 

Schedule Tour Strength, Soft_Clock.aspx, 

Supervisor View/Select, Timesheet Notes, 

Timesheet Page, Timesheet Payments, 

Timesheet Summary, Timesheet TDS, 

Timesheet TDS – Custom V1, Timesheet TDS – 

Custom V2, View Schedule and Timesheet 

Differences. 

Time Records Timesheet, My Timesheet, Timekeeper, Punch 

Detail, Admin, Users, Roles, Supervisor Assign, 

Accruals Process, Misc. L Mass Assign, 

Delegates, Manage Seasonal Hours, Payment 

Interface, Code Maintenance, Misc. L Codes, 

Categories, Misc. Payment Codes, Payment 

Codes, Earning Codes, Payment Rosters, Cost 

Splits, Edit, Report, PaySR File generation, 

Direct Reports to a Supervisor, Payment Roster 

Details Print, Payment Roster Details 

(Employee), Payment Roster Details (Item), 

Payment Roster Details (Title), Process 

Accruals Exceptions, Segmentation Admin, 

Timesheet Profile. 

Personnel Timesheet, Timesheet Search. 

Maintenance Table Maintenance, Location, Negotiating 

Units, Titles, Cost Centers, Object Codes, Work 

Locations, Tips, Announcements, TimeClock 

Card, Configurable Settings, Organization 

Structure, Code Maintenance, Adjustment 
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Codes, Misc. Leave Codes, Categories, Charge 

Codes, Misc. Payment Codes, Payment Codes, 

Earning Codes, Payment Rosters, Email 

Messages,. 

Security Admin, Users, Roles, Page Security, Security 

Roles, Table Maintenance, Password Rules. 

Supervisor Timesheet, Approval List, Verification List, 

Audit, HRA Timesheet Report. 

Schedule Administrator Scheduling, Administration, Search/Reassign, 

Schedule View Employee. 

Schedule Planner Administrator Scheduling, Administration, Leave/Additional 

Time, Schedule Day View, Schedule Roster, 

Schedule Roster Days, Schedule Roster Print, 

Schedule Temporary Assignment, Schedule 

Tour Strength, Schedule View Employee, 

Schedule Worksheet Print, Schedule Worksheet 

Roster, Schedule Worksheet Roster Days. 

**Restricted by users Troop, Zone, Station. 

Schedule Planner Admin - Unrestricted  Scheduling, Administration, Leave/Additional 

Time, Schedule Day View, Schedule Roster, 

Schedule Roster Days, Schedule Roster Print, 

Schedule Temporary Assignment, Schedule 

Tour Strength, Schedule View Employee, 

Schedule Worksheet Print, Schedule Worksheet 

Roster, Schedule Worksheet Roster Days. 

**NOT restricted by users Troop, Zone, Station. 

Cost Query Cost Splits, Edit, Assign Users, Report, PaySR 

File Generation, Cost Processing, Cost Process 

Exceptions, Cost Process Review, Cost Query, 

FMS Extract Logs. 

Finance Cost Process Exceptions, Cost Process Review, 

FMS Extract Logs, Leave Factor Report, 

Missing/Late Timesheet Report. 

TDS Unlock Admin, TDS Unlock. 

TDS Master TDS Maintenance, TDS Tasks, Subtasks, 

Custom TDS Access, TDS Coordinator Access, 

TDS Task History. 

TDS Coordinator TDS Maintenance, TDS Categories, TDS Tasks, 

Subtasks, Custom TDS Access, TDS 

Coordinator Access, TDS Task History. 

Timekeeper Timesheet, Timekeeper. 

Delegate Timesheet, Assignee List. 

 

 

Customers may create their own security roles to allow access to certain menu and non-menu 

items in LATS. 
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Chapter 12:  Creating and Modifying Roles 
 

The Roles application allows the end user to create new roles above and beyond those that are 

supplied with the application.  In this application the end user can create new roles or modify non 

system supplied roles. 

 

To create a new role: 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Roles Click on the ADD tab. 

4  Enter Role Name: 

5  Enter Role Description: 

6  Access Level:  The lower the 

security access the more 

“authority” it has.  For 

example, if you have 2 roles 

and they have overlapping 

page access the lower level 

security role will “trump” the 

higher level security role. 

7  Active: If set to Yes the role 

will be accessible for use.  If 

set to No the roles will not be 

accessible for use. 

8   
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Chapter 13:  Page Security 
 
LATS has the ability to allow people with the appropriate security access to modify individual 

and role level access to page and non-menu pages.  This feature supports the end user’s ability to 

create unique roles that are different from the supplied roles.  The end user can search by Role or 

by Person and then make modifications on a role level or an individual level.  

 

Page Security by Role 
 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Page Security Click on the Search Role tab. 

4  Enter the role description or 

leave the field blank and click 

the Search button to return all 

roles. 

5  Click on the Role Name. 

6  Make the appropriate changes 

to the role page access. 

7  Click Save. 

 

Note:  End users will not be allowed to modify page security for the supplied roles.  They will 

only be allowed to modify page security for the roles that they create internally. 

 

Page Security by Employee 
 

Employees with the appropriate security privileges will be allowed to modify page security by 

individual if necessary.  Changes on the Page Security application will override the roles 

checked in the employee General page in their employee record. 
 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Page Security Click on the Search People 

tab. 

4  Enter the employee name and 

click the Search button to 

return all roles. 

5  Click on the Employee Name. 

6  Make the appropriate changes 

to the role page access. 

7  Click Save. 
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Chapter 14:  Additional LATS Admin Functions 
 
Topics Discussed In This Chapter: 

 

 Change Password 

 Supervisor Assignment 

 Misc. Leave Mass Assign 

 Timekeeper Assignment and Procedures 

 Working with Delegates 

 Manage Swaps – SISU Interface 

 Leave Donation 

 Manage Office Locations 

 

Change Password 
 

LATS offer the ability for employee to change their password.   

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Change Password Enter the current password. 

4  Enter new password. 

5  Confirm new password. 

6  Click Submit. 

 

Note:  Password characteristic requirements will be displayed on the screen.  If the end user 

creates a password that does not meet the requirements, the password will not be changed and the 

system will notify the employee that the password was not changed. 

 

Security Roles Assignment 
 

The Security Roles Assignment application under the Admin menu is another way to access and 

modify security  

 

Supervisor Assignment 
 

LATS offers multiple ways to manage Supervisor Assignments in LATS.  In the Supervisor 

Assignments page, end users can manage supervisors by Employee, Supervisor or Section. 

 

Choosing to manage supervisor by Employee allows the end user to assign a new supervisor to an 

employee or manage the Alternate Supervisors attached to a supervisor. 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assignments In the Search By field select 

Employee. 
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4  Enter the Employee name and 

click the Search button. 

5  To change the employee’s 

supervisor click on the 

employee name. 

6  Select the appropriate 

supervisor from the drop 

down box. 

7  Click Save. 

8  To change the alternates for 

the supervisor attached to 

that employee click on the 

supervisor name. 

9  Click on the Edit Supervisor 

button. 

10  Select the appropriate 

alternate supervisor(s) from 

the drop down list. 

11  Click Save. 

12  End user will receive a 

message to confirm that All 

Employee’s with that 

supervisor will be updated 

with those alternates. 

13  Click Ok to confirm. 

 

Assigning an Employee as a Supervisor via Supervisor Assignment Page 

 

You can make an employee a Supervisor by checking the Supervisor Role check box.  The steps 

below outline how to access the employee record. 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assignments In the Search By field select 

Employee. 

4  Enter the Employee name and 

click the Search button. 

5  Click on the employee’s 

name. 

6  Check the Supervisor Role 

box. 

7  Click Save. 
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Choosing to manage supervisors by the Supervisor drop down allows the end user to assign a new 

supervisor to an employee or manage the Alternate Supervisors attached to a supervisor. 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assignments In the Search By field select 

Supervisor. 

4  Enter the Supervisor name and 

click the Search button. 

5  To change the employee’s 

supervisor click on the 

employee name. 

6  Select the appropriate 

supervisor from the drop down 

box. 

7  Click Save. 

8  To change the alternates for 

the supervisor attached to 

that employee click on the 

supervisor name. 

9  Click on the Edit Supervisor 

button. 

10  Select the appropriate alternate 

supervisor(s) from the drop 

down list. 

11  Click Save. 

12  End user will receive a 

message to confirm that All 

Employee’s with that 

supervisor will be updated 

with those alternates. 

13  Click Ok to confirm. 

 

Assigning and Modifying Supervisor Assignments by Section 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Supervisor Assignments In the Search By field select 

Section. 

4  Select the appropriate Agency 

from the drop down list. 

5  Select the appropriate 

Division from the drop down 

list. 

6  Select the appropriate Bureau 

from the drop down list. 
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7  Select the appropriate Section 

from the drop down list. 

8  Click the Search button. 

9  To change the employee’s 

supervisor click on the 

employee name. 

10  Select the appropriate 

supervisor from the drop 

down box. 

11  Click Save. 

12  To change the alternates for 

the supervisor attached to 

that employee click on the 

supervisor name. 

13  Click on the Edit Supervisor 

button. 

14  Select the appropriate 

alternate supervisor(s) from 

the drop down list. 

15  Click Save. 

16  End user will receive a 

message to confirm that All 

Employee’s with that 

supervisor will be updated 

with those alternates. 

17  Click OK to confirm. 

 

Misc. Leave Mass Assign 

 

This function gives administrators the ability to create a miscellaneous leave balance set up by 

employee, negotiating unit, title or for all employees. Miscellaneous leave balances will be 

displayed on the front of the timesheet and a running balance will be kept and displayed. 

 

Note:  Miscellaneous leave balances completed under Mass Assign will affect current active 

employees. New employees will not automatically receive a balance previously assigned to other 

employees. Administrators will have to complete a Mass Assign to the individual employee as 

needed. 

 

Step # Active Window Action 

1 LATS Admin  

2 Misc. L Mass Assign Assign by: Choose 

EMPLOYEE, ALL 

EMPLOYEES, 

TITLE, or NEGOTIATING 

UNIT from the drop-down 

list. 

The screen will display the 

Misc. Leave Mass 
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Assignments page. 

3  Leave Category: Choose the 

category from the dropdown 

list. 

4  Adjustment Amount: Enter 

the number of hours for this 

adjustment. 

5  Adjustment type: Click the 

radio button to choose either 

INITIAL BALANCE or 

ADJUSTMENT. If this is the 

first time this category has 

been assigned, choose 

INITIAL BALANCE. Any 

additional adjustments to the 

category should be completed 

under ADJUSTMENTS. 

If you wish to reset the 

balance to a specified value 

and pay period, choose 

INITIAL BALANCE. 

6  Pay Cycle: Choose either 

ADMINISTRATION or 

INSTITUTION from the 

drop-down list. 

7  Pay Period Year: Choose the 

year from the drop-down list. 

8  Pay Period: Choose the pay 

period in which you wish to 

add the balance form the 

drop-down list. 

 

9  Click SUBMIT. 

 

10  The Status screen will display 

and indicate if the process was 

successful. Click the Status 

message to display the details 

of the process. 

 

 

 

Timekeeper Assignment and Procedures 
 

On occasion, it will be necessary to assign a specific individual to complete a timesheet for 

another employee. This employee is designated as a timekeeper. Timekeepers will perform the 

same function as the employee and actually act on the employee’s behalf. 

They may enter charges to accruals, as directed by the employee, and they may complete a 

timesheet with appropriate miscellaneous leave charges. They will also submit the timesheet for 
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the employee. A timekeeper must be designated by a LATS administrator following the 

procedures in this section and the employee must be assigned to the timekeeper. 

 

Example 1  

 

An employee is out sick for an extended period of time and cannot enter charges or submit a 

timesheet to the supervisor for approval. 

 

Example 2 

 

Employees work at remote locations with limited computer access. A timekeeper may be 

designated to enter timesheets for these employees. 

 

When an employee is designated as a timekeeper, the timesheet will display a 

Timekeeper tab. Clicking that tab will display a screen very similar to the Home Page. 

Also displayed will be EDIT TIMESHEETS and a calendar to allow the timekeeper to choose the 

correct day/timesheet for entry. Individual timesheets will not display the 

PREV/NEXT and GO fields, so a timekeeper will only be able to navigate between timesheets 

with the Calendar. The name(s) of the employee(s) assigned to the timekeeper will also be 

displayed followed by Day In/Lunch Out/Lunch In/Day Out fields. The timekeeper may fill in 

these fields directly on this screen on a daily basis, or may click on the name of the employee and 

open the timesheet for completion. Entries will be completed using the same steps as the 

timekeeper follows to complete his/her own timesheet. This section of the manual covers 

authorizing a timekeeper, removing a timekeeper’s authorization, creating and maintaining 

employee-timekeeper associations. 
 

Creating a Timekeeper and Deleting a Timekeeper 

 
When a timekeeper is authorized to complete timesheets for a specific employee or employees 

and a change in circumstances makes that timekeeper/employee association unnecessary, the 

timekeeper authorization should be deleted. 

 

Note:  A timekeeper cannot be deleted if any employees are assigned to the timekeeper, but an 

individual employee may be removed from a timekeeper. 

 
Viewing Timekeeper Associations 

 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Timekeeper Assign To view a list of All Timekeepers leave the 

Search By drop down set to All 

Timekeepers. 

4  Click the Search button. 

5  To see all the assignees for a Timekeeper 

click on the Timekeeper name. 
 

Deleting Employee - Timekeeper Associations 
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Step # Active Window Action 

1 Home Page  

2 Admin  

3 Timekeeper Assign To view a list of All Timekeepers leave the 

Search By drop down set to All 

Timekeepers. 

4  Click the Search button. 

5  To see all the assignees for a Timekeeper 

click on the Timekeeper name. 

6  To remove an employee from a Timekeeper 

click on the Remove link to the right of the 

employee title on the employee row. 

7  The end user will be prompted to confirm 

the removal of the assignee from the 

Timekeeper. 

8  Click Ok to confirm and remove. 
 

Adding an Employee to a Timekeeper 
 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Timekeeper Assign Change the drop down option to 

Employee and enter the name of the 

Timekeeper that you wish to add 

employee’s to. 

4  Click the Search button. 

5  Click on the Timekeeper name in the 

returned rows 

6  On the next screen enter the name of the 

employee that you want to add to the 

Timekeeper. 

7  Click Search. 

8  Once you have identified the correct 

employee click the Assign link on the 

employee record row on the left hand side 

of the screen. 

9  Notice that after the Assign button is 

clicked the status changes to Assigned 

and the employee is displayed in the 

Assigned Employee’s list. 
 

Reassigning all Employees from one Timekeeper to another Timekeeper 
 

There may be a circumstance that will require all employees assigned to one Timekeeper to be 

reassigned to another Timekeeper.  This can be done by a mass reassignment of employees from 

one Timekeeper to another Timekeeper in the Timekeeper Assign application. 

 

Step # Active Window Action 
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1 Home Page  

2 Admin  

3 Timekeeper Assign Locate the Timekeeper that you wish to 

reassign employees FROM and click on 

the row. 

4  Select the new Timekeeper from the 

Timekeeper drop down list on the right 

hand panel. 

5  Click the Reassign All button. 

 

Timekeeper Automated Facility Change Configuration Setting 
 
LATS now allows an employee to be automatically assigned to a Timekeeper when they change 

facilities (‘Agencies’ in LATS). This automatic assignment is triggered by the detection of 

agency code changes in the weekly NYSTEP refresh. 

 

In order to allow access to timesheets for employees who move to a new facility, the Time 

Records user at the losing facility will be given temporary access to transitioning employees by 

being assigned as a LATS Timekeeper for a limited period of time.  The amount of time that 

losing facilities will have to access transitioning employees is configurable by accessing the 

configuration setting “NYSTEP Auto Timekeeper Periods”, located under the Data Refresh 

section of the LATS Configuration Settings. 

 

  
 
When a change of facility (agency code) is detected for an employee in the NYSTEP interface, 

the following will occur:  

 ‘Time Records’ users from the losing facility will be assigned as Timekeepers for the 

employee with an expiration date based on the above configuration setting. 

 The Timekeeper assignment will not function after the expiration date. 

 

If the Time Records user at the losing facility needs more time (than the number of pay periods 

listed in the “NYSTEP Auto Timekeeper Periods” configuration setting) to access an employee’s 

data in LATS, then you can extend the length of time manually.  This is accomplished by going to 

Admin > Timekeeper Assign. 
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Working with Delegates 
 

Delegates are individuals authorized to review timesheets, either from a supervisor’s direct 

reports or for individually specified employees. Delegates may not approve or un submit 

employee timesheets. Their access is limited to viewing the timesheets, so that they can advise 

the supervisor of any possible problems or errors. 

 

Note:  A delegate can review a timesheet by opening their own timesheet and clicking on the 

assignee list tab. A list of timesheets that are pending review will be displayed. The timesheet may 

be opened by clicking on the employee’s name. A delegate may indicate that the timesheet is 

satisfactory by clicking REVIEW on the submitted timesheet. A message will be displayed to 

ensure the timesheet should be marked as reviewed. Click OK. This action will mark the 

timesheet as reviewed (under Status on the timesheet) and the supervisor may then proceed with 

approval. 

 

Viewing Delegates and Assignees 

 

Step # Active Window Action 

 Home Page  

 Admin  

 Delegates To view a list of All Delegates leave the 

Search By drop down set to All 

Delegates. 

  Click the Search button. 

  To see all the assignees for a Delegate 

click on the Delegate name. 

 

 

Deleting Employee - Delegate Associations 
 

Step # Active Window Action 

1 Home Page  

2 Admin  
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3 Delegates To view a list of All Delegates leave the 

Search By drop down set to All 

Delegates. 

4  Click the Search button. 

5  To see all the assignees for a Delegate 

click on the Delegate name. 

6  To remove an employee from a Delegate 

click on the Remove link to the right of 

the employee title on the employee row. 

7  The end user will be prompted to confirm 

the removal of the assignee from the 

Delegate. 

8  Click Ok to confirm and remove. 

 

 

Adding an Employee to a Delegate 
 

Step # Active Window Action 

1 Home Page  

2 Admin  

3 Delegates Change the drop down option to 

Employee and enter the name of the 

Delegate that you wish to add employee’s 

to. 

4  Click the Search button. 

5  Click on the Delegate name in the 

returned rows 

6  On the next screen enter the name of the 

employee that you want to add to the 

Delegate. 

7  Click Search. 

8  Once you have identified the correct 

employee click the Assign link on the 

employee record row on the left hand side 

of the screen. 

9  Notice that after the Assign button is 

clicked the status changes to Assigned 

and the employee is displayed in the 

Assigned Employee’s list. 

 

 

Reassigning all Employees from one Delegate to another Delegate 

 

There may be a circumstance that will require all employees assigned to one Delegate to be 

reassigned to another Delegate.  This can be done by a mass reassignment of employees from one 

Delegate to another Delegate r in the Delegate application under the Admin menu option 

 

Step # Active Window Action 

1 Home Page  
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2 Admin  

3 Delegates Locate the Delegate that you wish to 

reassign employees FROM and click on 

the row. 

4  Select the new Delegate from the 

Delegate drop down list on the right hand 

panel. 

5  Click the Reassign All button. 

 

Manage Swaps – SISU Interface 
 

This file contains swap information between two or more i.e. Corrections Officers.  Swaps are fed 

into LATS from SISU via the swap file.  The swap user interface, illustrated below, tracks swaps 

that are imported from the SISU file and allows direct entry of swaps for non-SISU employees.  

The user interface also accommodates edits to swap records.  These changes do NOT feed back 

into the SISU system. 

 

When a CO is working a swap, the background color for the “swap on” day is green. When the 

CO is off on a swap, the background color for the “swap off” day is gold. A ‘swap on” and “swap 

off” on the same day the background color is purple. In addition to the color changes, a small 

diamond shaped icon containing two arrows will be displayed next to the day of the week on each 

swap day. Hovering the mouse over the icon will display a tool tip with information about the 

swap. Clicking on the icon will navigate to the associated swap detail record. 
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Leave Donation 
 

A new user interface has been created to manage leave donations and recipient information. 

LATS administrators can setup an employee as a recipient and then enter donated leave from any 

number of donors. The donated leave is automatically added to the recipient’s accruals and 

debited form the donor’s accruals at the time the donations is entered. In addition, LATS ensures 

that: 

 Donors have a minimum of 10 days of vacation after making a donation. 

 Donated leave will be used in the order it was donated. 

 Unused donated leave is returned to donors. 
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Manage Office Locations 
 

Office Locations allow LATS to store employee office address information.  For initial data 

loads, an import function will be required to import the Office address information into LATS 

from an external file (excel spreadsheet).  In addition, Agency code is included with the office 

information table.  This will filter the office location s for selection based on the employee’s 

current agency code.  If enabled, the employees can select the office location from the contact 

link on their timesheet. 

Importing Office Locations 

 

ADMIN > MANAGE OFFICE LOCATIONS 

 

Step #       Active Window Actions 

1 Home Page  

2 Admin  

3 Manage Office Locations Click UPLOAD 

4  Click BROWSE 

  Navigate to the location of 

the CMA formatted 

spreadsheet 
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  Click UPLOAD 

 

Viewing Office Locations 

 

ADMIN > MANAGE OFFICE LOCATIONS 

 

Step #       Active Window Actions 

1 Home Page  

2 Admin  

3 Manage Office Locations Enter search criteria 

(Employee Name, Office 

Address, Office Building, 

City, State, and Agency), 

select the Search button.  

LATS will search all of the 

Office Location fields for a 

match on the entered criteria. 

4  Search results are displayed.  

Click on the appropriate row 

to display Office Locations 

Details. 

 

Creating Office Locations – Employee Assigned 

 

ADMIN > MANAGE OFFICE LOCATIONS 

 

Step # Active Window Actions 

1 Home Page  

2 Admin  

3 Manage Office Locations Click ADD tab. 

4  Enter the following 

information. 

5  Employee Name 

6  Location if desired (i.e. Main) 

7  Phone 

8  Address 1 

9  Address 2 (not required) 

10  City 

11  State 

12  Zip Code 

13  Building (not required) 

14  Agency Source = Employee 

Agency 

15  Click ADD 
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Creating Office Locations – Agency Assigned 

 

ADMIN > MANAGE OFFICE LOCATIONS 

 

Step # Active Window Actions 

1 Home Page  

2 Admin  

3 Manage Office Locations Click ADD tab. 

4  Enter the following 

information. 

5  Phone (not required) 

6  Address 1 

7  Address 2 (not required) 

8  City 

9  State 

10  Zip Code 

11  Building (not required) 

12  Agency Source = User 

Specified 

13  Select All or Specific Agency 

from the drop down 

14  Click ADD 

 

Assigning Office Locations  

 

ADMIN > MANAGE OFFICE LOCATIONS 

 

Step # Active Window Actions 

1 Home Page  

2 Admin  

3 Manage Office Locations Click ADD tab. 

4  Enter the following 

information. 

5  Employee Name 

6  Location if desired (i.e. Main) 

7  Phone 

8  Select an Existing Location 

9  Click OK to use location 

10  Click ADD 
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Chapter 15:  FMLA  
 

Topics Discussed in This Chapter: 

 

         How to Configure Settings for FMLA   

         How to Authorize User Access to the FMLA Qualification Page 

         Adding Misc. Leave Categories, Creating FMLA Codes and Using the ‘FMLA Usage’ Link 

         How the FMLA Rules are Implemented in LATS 

         How to Determine if Employees are Eligible to Use FMLA, and How to Add FMLA Cases 

         FMLA Related Reports 

 

 

How to Configure Settings for FMLA 
 

Configurable Settings 

 

You can change how FMLA functions in LATS by accessing the ‘Configurable Settings’.  This 

should only be changed by a LATS Administrator, since this is a system wide setting. 

 

To access the relevant settings, go to Table Maintenance > Configurable Settings > Timesheet.  

There are four FMLA-related Configurable Settings: 

 

       ‘EnhancedFMLA’:  This setting enables the enhanced edits for using FMLA.  If 

‘EnhancedFMLA’ is set to ‘YES’, then administrators will be able to use the ‘FMLA 

Qualification’ page (Admin > FMLA Qualification) to create new FMLA cases.  If 

‘EnhancedFMLA’ is set to ‘NO’, then administrators will not be able to add new FMLA 

cases.  They will only be able to use the ‘FMLA Qualification’ page to determine 

whether or not an employee is eligible to charge to FMLA.   

 

       ‘FMLAHoursWorked’:  The number of hours an employee must have worked in the past 

year to qualify to use FMLA.  The default value is 1,250 hours.  To change the number of 

hours, enter a new number in the ‘Value’ field and click the ‘Save’ button.  

 

       ‘MaxFMLACaseDays’:  The number of days an FMLA case is active (the maximum is 

365 days).  The default value is 30 days.  To change the number of days, enter a new 

number in the ‘Value’ field and click the ‘Save’ button. 

 

       ‘MaxFMLACharged’:  The maximum number of days an employee can charge to FMLA 

in a calendar year.   The default value is 60 days.  To change the number of days, enter a 

new number in the ‘Value’ field and click the ‘Save’ button. 

 

How to Authorize User Access to the FMLA Qualification Page 
 

‘Time Records’ User Role:  Administrators need to have the ‘Time Records’ User Role to be 

able to access the ‘FMLA Qualification’ page (Admin > FMLA Qualification).   

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 15: FMLA, 206 of 233 

By default, users can access the ‘FMLA Qualification’ page if they are authorized with the ‘Time 

Records’ User Role.  However, custom roles can be set up to allow others to access the page.  For 

more information on creating custom roles, see Chapter 12, titled “Creating and Modifying 

Roles”. 

 

Adding Misc. Leave Categories, Creating FMLA Codes and 
Using the ‘FMLA Usage’ Link 
 

Adding Misc. Leave Categories  

 

If you need to create a new Misc. Leave Category to support your agency’s specific FMLA 

policies, you can create a ‘Misc. Leave Category’ by going to Code Maintenance > Misc. Leave 

Codes > Categories, and clicking on the ‘Add’ button.  For further information on Misc. Leave 

Categories, see the instructions located in Chapter 2 in the section titled “Miscellaneous Leave 

Codes and Categories”. 

 

Creating FMLA Codes  
 

To create (or see the settings for existing) FMLA Codes, go to Code Maintenance > Misc. Leave 

Codes > Charge Codes.  For further information on Misc. Leave Codes and Categories, see the 

instructions in the section in Chapter 2 titled “Miscellaneous Leave Codes and Categories”.   

 

Using the ‘FMLA Usage’ Link 
 

If you want employees to be able to see their FMLA usage when they click the ‘FMLA Usage’ 

link (located at the bottom of their timesheets), then the Misc. Leave Charge Codes MUST have 

the ‘Enhanced FMLA’ box checked on the Misc. Leave Charge Code. 

 

Note:  Employees will not see updated FMLA usage data on their timesheets for the same Pay 

Period that they entered the FMLA time.  To see the updated FMLA usage, they will need to go to 

the next Pay Period and click the ‘FMLA Usage’ link. 

 

 The ‘FMLA Usage’ link displays three pieces of information:  

 

 ‘Max Allowed’:  The maximum number of hours of FMLA the employee is allowed to 

use, starting on January 1st of the calendar year 

 

 ‘Used’:  The number of hours of FMLA time the employee has used from January 1st 

through the end of the previous timesheet  

 

 ‘Remaining’:  The remaining balance (in hours) that the employee can use (based on the 

end of the employee’s previous timesheet) 

 

 

How the FMLA Rules are Implemented in LATS 
 

Below are the FMLA rules implemented in LATS: 
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1. Employees need to have worked 1250 hours in the 12 months prior to the start date of the 

FMLA period in order to qualify to charge to FMLA codes.  The number ‘1250’ is the default, 

but the ‘Value’ is configurable.  This should only be done by the LATS Administrator since this 

is a system wide setting.  To access the setting, go to Table Maintenance > Configurable Settings, 

click on ‘Timesheet’, then click on ‘FMLAHoursWorked’.  Enter the number of hours an 

employee must have worked in the past year to qualify to use FMLA in the ‘Value’ field.   

 

2. Qualified Work time does not include any leave charges. 

 

3. For a Present/Absent employee, the system will assume the default hours per day minus leave 

as the work hours. 

 

4. In addition to the 1250 hours, employees must be employed for at least 12 cumulative months 

on the date FMLA leave is to begin. 

 

a. This can be determined in LATS based on existing timesheets, or the vacation leave 

date if the employee moved from a different agency. 

 

b. Time Records users and FMLA administrators can override the 1,250 hour 

requirement. 

 

c. This assumes the user determined that the employee met this requirement with time 

worked at another agency. 

 

5. Once eligible, a fulltime employee can charge up to 480 hours (for an 8.00 hour per day 

employee) or 450 hours (for a 7.50 hours per day employee) of FMLA leave each calendar 

year.  This balance is reset on January 1st.  

 

6. Any Misc. Leave Code identified as FMLA counts toward the 450/480 hours, even if it comes 

out of another leave category (vacation, sick etc., workers comp). This is determined by the new 

leave code attribute ‘Enhanced FMLA Functionality’. 

 

7. The FMLA start date can be any day within a pay period. 

 

8. Multiple blocks can be set up at once.  A block (for the length of time an FMLA case is active) 

defaults to 30 days, but the ‘Value’ is configurable up to 365 days per case.  To do this, go to 

Table Maintenance  >  Configurable Settings, click on the word ‘Timesheet’ and then click on 

‘MaxFMLACaseDays’.  Enter a number in the ‘Value’ field for the amount of days FMLA cases 

will be active.  This should only be done by the LATS Administrator since this is a system wide 

setting. 

 

9. A case can be extended by another 30 days within 7 days of expiration. 

 

10. Part time employees’ FMLA time is prorated based on their working percentage (employee 

percent). This includes work time and max hours charged per year (rounded to a qtr. hour).  For 

example: Employee percent = 75, then Hours Worked = .75 * 1250 = 937.5 hours; and Max 

charge = .75 * 480 = 360 hours. 

 

11. Hourly employees are not prorated even if they do not work full time schedules. 
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12. LATS will cap the calendar year FMLA usage at 450/480 hours (or the prorated amount). 

This value is a configurable setting in case it ever changes. 

 

 

How to determine if Employees are Eligible to Use FMLA, and 
How to Add FMLA Cases 
 

You can use the ‘FMLA Qualification’ page to accomplish two tasks:   

1) To determine if an employee has worked the minimum required hours to qualify for 

FMLA and 2) to add FMLA cases.  

 

1.    Go to Admin > FMLA Qualification.  Note: if you do not see ‘FMLA Qualification’ in the 

‘Admin’ drop down list, then review the information in this chapter titled “How to Authorize 

User Access to the ‘FMLA Qualification’ Page”.   

 

2.    Type the employee’s name in the Search field, click the ‘Search’ button, and then select 

the employee’s name in the search results.  If you receive the message ‘No results found 

matching your search’, review the information in this chapter titled “How to Authorize User 

Access to the ‘FMLA Qualification’ Page” (above).   

 

In the ‘FMLA Used To Date’ field, you will see the total number of hours of FMLA that the 

employee has used.  Note: The ‘FMLA Used to Date’ field will show updated FMLA usage 

provided that the employee charged to Misc. Leave Codes that have the Enhanced FMLA 

check box checked off on the Misc. Leave Code page when the Enhanced FMLA system 

config setting is enabled.  

 

The employee’s prior FMLA cases, if any, will be listed at the bottom of the page in the 

‘FMLA Authorization’ section.  Note: If you do not have a section titled ‘FMLA 

Authorization’ on your ‘FMLA Qualification’ page, then review the information on 

‘EnhancedFMLA’ in the section in this chapter titled “How to Configure Settings for 

FMLA”.   

 

3.    In the ‘Qualification Date’ field, enter the date that the employee is seeking to begin 

using FMLA (or click the calendar to the right of the ‘Qualification Date’ field).  Then, 

click the ‘Go’ button.   

 

You will now see two useful items: 

 

a)   You will see the ‘Total Hours’ the employee has worked in the previous 12 months 

from the selected start date, along with a breakdown of how many hours were worked 

per Pay Period.   

 

b)   In the ‘FMLA Authorization’ section, you will see a message that will tell you 

whether or not the employee has worked the minimum required hours to qualify for 

FMLA.  Note: Even if the employee has not worked the minimum required hours to 

qualify, LATS will still let you add an FMLA case. 
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4.   To create an FMLA case, enter the Start and End dates in the ‘FMLA Authorization’ 

section (or click the calendars and select the Start and End Dates).  The ‘Reason’ field is 

optional.  Then, click the ‘Add & Save’ button.   

 

 

FMLA Related Reports 
 

There are two ‘Standard Reports’ that you can access to gain FMLA-related data: the ‘FMLA 

Usage Report’ and the ‘FMLA Qualification Report’.   

 

The ‘FMLA Usage Report’ is used to identify Users who have charged to FMLA leave codes in 

the given Calendar year (i.e., any Misc. Leave Code that contains the word “FMLA” in its ‘Code 

Description’).  The report groups FMLA charges according to employee.  It also gives FMLA 

charge totals for each employee, and a grand total for the year. The report is located at Reports > 

Charge/Usage Reports > FMLA Usage Report.  Note: Remember, if you want to track FMLA 

usage using the ‘FMLA Usage Report’, then make certain that all of your FMLA codes contain 

“FMLA” in the ‘Code Description’ field.  If needed, review the section in this chapter titled 

“Creating FMLA Codes”. 

 

The ‘FMLA Qualification Report’ can be used to determine whether an employee meets the 

FMLA qualification according to the number of hours worked.  The report lists the number of 

hours worked by the employee per Pay Period; the ‘Total Hours’ for the fiscal year that you 

selected; and the ‘Grand Total’ number of hours that the employee has worked in the past. 
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Chapter 16:  Workers Compensation  
 

Topics Discussed in This Chapter: 

 

 Configuring Workers Compensation 

 Miscellaneous (Misc.) Leave Categories and Codes 

 How to Create a Workers Compensation Case 

 Removing a Workers Compensation Case 

 How to Restore Balances 

 Workers Compensation Allows Negative Adjustments 

 Completing a Timesheet with Time Charged to Workers Compensation 

 Workers Compensation Related Reports 
 
 

Configuring Workers Compensation 
 

‘Time Records’ User Role 

 

Administrators need to have the ‘Time Records’ User Role to be able to access the Workers 

Compensation page (Admin > Workers Compensation).   

 

Configurable Settings 

 

Workers Compensation needs to be enabled through the Configurable Settings.  This should only be 

changed by a LATS Administrator, since this is a system wide setting.   

 

To access the Workers Comp-related setting, go to Table Maintenance > Configurable Settings > 

Timesheet  > WorkersCompTab.  To enable the Workers Comp tab so that it will appear on 

employees’ timesheets, set the Value to “Yes”.  To disable the tab, set the Value to “No”. 

 

Miscellaneous (Misc.) Leave Categories and Codes 
 

Misc. Leave Categories  

 

If you need to create a new Misc. Leave Category to support your agency’s specific Workers Comp 

policies, you can create a Workers Comp category by going to Code Maintenance > Misc. Leave 

Codes  >  Categories, and clicking on the ‘Add’ button.  For further information on Misc. Leave 

Codes and Categories, see the section in Chapter 2 titled “Miscellaneous Leave Codes and 

Categories”.  

 

Workers Comp Codes 

 

LATS enforces Workers Comp using Miscellaneous Leave codes.  Workers Comp codes can be 

created by going to Code Maintenance > Misc. Leave Codes > Charge Codes, and clicking on the 

‘Add’ button.  In order for a Miscellaneous Leave code to be counted as a Workers Comp charge 

when the Workers Comp functionality is enabled in the Configurable Settings, the box titled 

‘Enhanced Workers Comp Functionality’ must be checked on the charge code.  For further 

information on Misc. Leave Codes and Categories, see the section in Chapter 2 titled “Miscellaneous 

Leave Codes and Categories”.   
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How to Create a Workers Comp Case 
 

The Workers Compensation page provides authorization and tracking for workers compensation 

cases.   

 

1.  To add a Workers Comp case, go to Admin > Workers Compensation.  In the ‘Search’ field, 

type the name of the employee, click the ‘Search’ button and select the employee’s name from the 

search results.  You’re now on the Workers Compensation page. 

 

 
 
2A. In the Manage Cases section, enter a ‘Start’ date and ‘Case Name’.  Then, click the ‘Add & 

Save’ button.   

 

You can enter a ‘Start’ date by clicking on the calendar icon or typing the date in the format 

xx/xx/xxxx.   
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2B. The case will now appear at the bottom of the Manage Cases section.  Also, you’ll notice that in the 

‘Restore Balances’ section, the ‘Start’ date and ‘Case Name’ you entered now appear in the Case 

dropdown. 

 

 
 

Removing a Workers Comp Case 
 

You can remove a Workers Comp case, provided that the employee has not charged time to it.  To 

remove a case, click the gray ‘Remove’ button to the right of the case.  Then, click the ‘Save’ button.   
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How to Restore Balances 
 

The ‘Restore Balances’ section of the Workers Comp page is used to reimburse an employee’s time 

that was used for Workers Comp.   

 

1.  To restore time, go to the ‘Workers Compensation’ page at Admin > Workers 

Compensation.  In the ‘Search’ field, type the name of the employee, click the ‘Search’ button and 

select the employee’s name from the search results.  You’re now on the ‘Workers Compensation’ 

page. 

 

 
 

 
2A.  In the ‘Restore Balances’ section, select ‘Pay Cycle’, ‘Year’, ‘Pay Period’ and ‘Case’.  

Then, click the ‘Show Pay Period’ button. 
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2B.  You’ll see that there are five rows (i.e., Brought Forward, Time Restored, Restore Time, Time 

Used, To Be Liquidated) with six Leave category columns (i.e., Vacation, Sick, Personal, Overtime, 

VRWS, Holiday).   

 

 
  

 
3A.  Enter the number of hours you would like to restore in one or more leave category 

columns, and click the ‘Restore Hours’ button. 
 

In the example below, the employee is getting time restored from Pay Period 6.  The employee 

normally works 8 hours per day / 5 days per week.  All 10 days of the Pay Period are being restored, 

for a total of 80 hours. 
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3B. Now that you have restored the time, it will appear in the Time Restored row. 

 

 
 

 
3C. If the employee used leave time which is NOT associated with the Workers Comp case, it will 

appear in the Time Used row. 
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3D. If you go to the employee’s next Pay Period (in this example, the next Pay Period is 7), you will 

see the amount of time brought forward in the Brought Forward row. 

 

 
 

 
3E. In the To Be Liquidated row, you’ll see the amount of time that was restored for the employee. 

 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015  Chapter 16: Workers Compensation, 217 of 233 

 
 
 

Workers Compensation Allows Negative Adjustments 
 

The workers compensation page has been enhanced to allow negative adjustments to a category if an 

administrator incorrectly credits time to an employee. 

 

 
 

 
After you click the ‘Restore Hours’ button, the ‘Time Restored’ and ‘To Be Liquidated’ rows are 

updated: 
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Completing a Timesheet with Time Charged to Workers Comp 
 

1. Go to the timesheet for the Pay Period that you’ll be entering Workers Comp leave.  Then, 

click the ‘Save’ button to get the ‘Leave’ drop down to appear. 
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2. Click on the ‘Leave’ drop down and select the appropriate Workers Comp code.  Click the 

‘Add Leave Category’ button.  If there are additional Workers Comp codes that you will be using, 

then repeat this step as needed.   

 

 
 

 

3. Enter the appropriate number of hours in the misc. leave row(s).  Then, click the ‘Save’ 

button.   
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4. LATS will now display a red “Workers Comp Mismatched” error on the timesheet (The pop up 

message that explains the error will only appear if you click on one of the yellow triangles).  Next, 

you’ll go to the ‘Workers Comp’ tab and distribute the time charged to the Workers Comp case.   

 

Click on the ‘Workers Comp’ tab.   
 

 
 

 

5. Select the Case and Leave Code by clicking on the drop down menus next to ‘Select Case’ 

and ‘Select Leave Code’.  Then, click the ‘Add Case’ button.  If there are additional Leave Codes 

that you will be using, then repeat this step as needed. 
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6. Enter your Workers Comp time.  Click the ‘Save’ button.  If there are additional Workers 

Comp cases for the same Pay Period, then repeat steps 5 and 6 as needed.  Once you are done, you 

can return to your timesheet by clicking on the ‘Timesheet’ tab. 

 

 
 

 

 

7. Once you have entered all of your time for the Pay Period, click the ‘Submit’ button. 
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Workers Comp-Related Reports 
 

Miscellaneous Leave reports can be run to gain information on employee Leave that was charged to 

Workers Comp.  There are two ‘Standard Reports’ that can be used to access Workers Comp-related 

data: ‘Misc. Charged Hours Report’ and ‘Misc. Charged Hours – Exceptions Report’. 

 

‘Misc. Charged Hours Report’ is used to identify Time and Attendance Eligible Employees (i.e., 

employees who accrue leave) who have charged to Miscellaneous Leave codes (including Workers 

Comp).  The report also provides a total for each miscellaneous charge.  The ‘Misc. Charged Hours 

Report’ is located at Reports > Charge/Usage Reports > ‘Misc. Charged Hours Report’.  All fields 

except ‘Misc. Codes Charged’ are required.   

 

‘Misc. Charged Hours – Exceptions Report’ is used to identify Time and Attendance Ineligible 

Employees (i.e., employees who do not accrue leave) who have charged to Miscellaneous Leave 

codes (including Workers Comp).  The report is located at Reports > Charge/Usage Reports > ‘Misc. 

Charged Hours - Exceptions Report’.  To run the report, enter in the Pay Period range. 
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Chapter 17:  Enhanced Overtime Rules 
 

LATS manages enhanced overtime requirements when an employee has overtime and unscheduled 

sick leave in the same week.  If an employee works voluntary overtime and has unscheduled sick 

leave or LWOP in the same week, the overtime is converted to straight time up to the number of 

unscheduled sick leave hours. If an employee works mandatory overtime and has unscheduled sick 

leave or LWOP in the same week, the overtime is NOT converted to straight time and the employee is 

paid overtime at the overtime rate.  The following configurations are required for the enhanced 

overtime logic to be in effect: 

 

 The Negotiating Unit must have the Use Enhanced OT Rules dropdown set to Yes. 

 
 The associated misc. leave codes must have the Enhanced OT check box checked. 

 
 
When these settings are configured the timesheet and associated payments process as displayed 

below. 

 

In the example below the employee has 7.00 hours OT (2.50 ENC and 4.50 Pd OT). 

 

 
 



              Leave & Accrual Tracking System (LATSnet) 

 
Administrative Manual 

November 2015                                                                                    Chapter 17: Enhanced Overtime Rules, 224 of 

233 

The overtime was reported as voluntary on the Overtime Details confirmation page. 

 

 
 

The end result will be for the overtime payment to be for 7.00 straight hours with zero earned non 

comp earned and 0 hours OT pay.  The payment record will reflect 7.00 at straight time. 
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Chapter 18:  Employee Driven Timesheet Schedules, AWS and 
Compressed Work Week 
 
Topics Discussed in This Chapter: 

 

 Employee Driven Timesheet Schedules 

 Alternate Work Schedules (AWS) 

 Compressed Work Schedules 

 

 

Employee Driven Timesheet Schedules 
 
 

Some agencies allow employees the flexibility of setting up their own schedules, within certain 

agency established guidelines, which allows for flexibility as long as the employee is working within 

their expected hours per week/pay period.  LATS allows several options to meet this requirement. 

Note: It is assumed that the employee has already obtained supervisor approval before defining their 

own schedule. 

 

Expected Hours per Day 

 

If configured, LATS allows employees to set their expected hours per day for a work week. If 

overtime eligible, employees expected hours for the week must still equal the expected 35/37.50/40 

hours per week but LATS will allow for the employee to identify how many hours per day LATS 

should look for on each day for purposes of calculating OT and other timesheet edits. 

 

Below is an example of what the timesheet would look like for an OT ineligible employee and an OT 

eligible employee. 

 

Overtime Ineligible employee timesheet 

 
 

Overtime Eligible employee timesheet 
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Agencies must turn on the following configuration settings if they would like to offer this type of self- 

service scheduling to their employees: General>Alternate Normal Hours = Y and 

timesheetscheduleEdit = Y.  In addition, the Timesheet Validation on the employees Accrual tab of 

their employee admin record MUST be set to Schedules. 

 

If these configurations are set up the employee will have the ability to update the expected hours on 

their timesheet by performing the following steps: 

 

1. The employee would click on the Schedule link row on the timesheet. 
 

 

 
 

2. Clicking the link displays an Edit Schedule row where the employee can modify their expected 

hours per day. The employee must click the Save button on the right hand side of the Edit 

Schedule row to save the modified expected hours per day schedule. 

 

 
 
Notice that the hours for Week 1 on the static employee page on the timesheet are now reflecting 35 

and Week 2 are reflecting 40. This still meets the required 75 hours per pay period for the employee 

so this schedule is allowed. 
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Further notice that the Profile and main Admin User page still shows Week 1= 37.50 hours and Week 

2 = 37.50 hours. 

 

Employee Daily Shift Selection 

 

LATS has the ability to allow employees to select their daily shift schedule from a pre-defined list of 

available shifts for selection. There are two settings that need to be enabled for this functionality to 

work correctly: Timesheet>EnableEditSchedule and Timesheet>ShiftType. 

 

When these configuration settings are configured properly the employee will see an additional link on 

the blue menu ribbon on their timesheet. 

 

 
 

Clicking the Edit Schedule Link will bring up a pop up window that allows the employee to select 

daily shifts. Note, it is assumed that employees have prior approval from their supervisor. 
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An email is sent to the supervisor after the employee makes the appropriate schedule changes and 

clicks the save button. 

 

 
 

Alternate Work Schedules (AWS) 
 

LATS allows employees to manage alternate schedules.  AWS is an employee attribute that is set on 

the employee’s admin record Accruals tab. AWS allows employees to work long days and short days 

as long as they work the required number of hours expected per week, if overtime eligible. 

 

LATS also allows AWS schedule flexibility for overtime ineligible employees. For these employees 

the following settings must be configured on the employee’s admin Accruals tab. 

 

 Overtime Eligible – unchecked 

 AWS - checked 

 Bi-weekly total - checked 

 

Compressed Work Schedules 
 

The compressed work schedule will enforce daily totals and with the exception of holidays, ignore the 

hours per day selected on the employee profile. There is much more flexibility with utilizing this 

functionality but it also requires strict and timely maintenance.  When the timesheet validation is set 

to Schedules you can no longer modify pass days on the employee main record or the timesheet 

profile.  You must maintain these changes via that Emp Rotation page on the employee record or 

through the Emp Rotation tab in the Scheduling module. 
 

As stated, with the Timesheet validation dropdown set to Schedules, the Week 1 and Week 2 Pass day 

check boxes are hidden.  This is because the timesheet is driven by the rotation schedule and the pass 

days observed in the timesheet are reflected in the rotation assigned to the employee. 
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Chapter 19:  8.5.8 Enhancements 
 

Below are the enhancements that are now available in the 8.5.8 Release: 

 

1. LATS Schedule Module now includes the ability to assign agencies to Lunch Shifts, Shifts and 

Rotations. 

 

 
 

2. LATS now allows the Zero Hour hourly timesheets to be processed and sent over to HCM.  This 

will help with the reconciliation on the HCM side and clean up the Hourly Transmit page in LATS so 

the zero hour timesheets no longer sit in the que without any way to clean them out. 

 
3. LATS now allows use of non-comp time the day after it was earned.   CMA added a new config 

setting ‘EnableEarnedNCNextDayUse’  to accommodate this request.  

 

4. LATS now has a canned report scheduler available to allow agencies to schedule canned reports 

to run based on business need. 

 

5. LATS now has the ability for employees to set and change their scheduled hours (start and end 

times) Employees will select the schedule shift (including lunch length, if applicable) from a pre-

defined list of shifts. When the schedule is saved, an email will be sent to the supervisor notifying 

them of the shift change. As part of the business process, the employee should have received approval 

to make the schedule change in advance from their supervisor.  

 

Employees can change the schedule for one or more future days in the current two week pay 

period.  Those changes will roll over into the next pay period and can also be changed in that pay 

period. 

 

A schedule rotation is two weeks in LATS; changing the scheduled times is limited to the two week 

rotation.  The new rotation becomes the employee’s template for the next pay period and all future 

pay periods until it is changed again. Employees will not be able to change the scheduled hours for a 

day that has past. 

 
 

This config. setting identifies the shift types that will appear in the dropdown on the employee’s 

timesheet. For example, Default, 7/8, Qtr. Round, etc. Only one shift type is allowed in this config. 

setting.    
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Turning this configuration setting ON (Yes), will display the edit schedule link on the employee 

timesheet (blue menu ribbon). 

 

6. CMA Payment Interface - HCM - configurable to not decrement the employee priority for file 

generated for HCM (OT #969) 

This enhancement affects customers that utilize the LATS to HCM payment interface, not the LATS 

to HRIS payment interface.  CMA modified the payment interfaces to only decrement the priority if 

the (IncrementImportPriority) configuration setting exists and is set to 'Y'. Customers who need the 

priority incremented on import and decremented when creating payment files will need to have the 

setting changed from the default of 'N'.   
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7.  Include Holiday Expiration in Notifications 

 

Holiday time that is about to expire will now appear in the notification banner on the timesheet. 

 

 
 

8. LATS now has a configuration setting, (SupervisorAccessEmpContactInfo) that when enabled 

allows supervisors and alternates to access the Emergency Contact Information via the Contact Info 

link on the timesheet. Supervisors and alternates have read-only access to the Primary Emergency 

Contact, Secondary Emergency Contact and Office Location information.  
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